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Introduction 1

1 Introduction

Thank you for purchasing this machine.

The d-Color MF550/MF450 is equipped with an integrated printer controller that allows you to print directly 
from Windows-compatible computers or Macintosh computers.

This user manual describes the printing functions, operations, usage, and safety precautions of the printer 
controller. In order to ensure that this machine is used efficiently, carefully read this manual before using the 
machine.

In order to ensure that this machine is used safely, carefully read "Installation and operation precautions" of 
the User manual – Copy Operations before using the machine.

The illustrations used in this user manual may differ from the actual model.

Trademarks and copyright
- Netscape is a registered trademark of Netscape Communications Corporation in the United States and 

other countries.
- Mozilla and Firefox are trademarks of the Mozilla Foundation.
- Novell and Novell NetWare are registered trademarks of Novell, Inc. in the United States and other 

countries.
- Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
- PowerPC is a trademark of IBM Corporation in the United States, or other countries, or both.
- In regard to the Citrix access Partner Network Premier

Olivetti S.p.A. is a member of the Citrix access Partner Network.
The Citrix access Partner Network is a program that, in combination with a solution of Citrix, promotes 
and develops solutions to provide the customers with better solutions.

- Apple, Macintosh and Mac OS are registered trademarks of Apple Computer, Inc. Safari is a trademark 
of Apple Computer, Inc.

- Adobe, the Adobe logo, Acrobat and PostScript are either registered trademarks or trademarks of 
Adobe Systems Incorporated in the United States and/or other countries.

- Ethernet is a registered trademark of Xerox Corporation.
- PCL is a registered trademark of Hewlett-Packard Company Limited.
- CUPS and CUPS logo are registered trademark of Easy Software Products.
- All other product and brand names are trademarks or registered trademarks of their respective 

companies or organizations.
- This machine and Box Operator are based in part on the work of the Independent JPEG Group.
- Compact-VJE

Copyright 1986-2003 VACS Corp.
- RC4® is a registered trademark or trademark of RSA Security Inc. in the United States and/or other 

countries.
- RSA® is a registered trademark or trademark of RSA Security Inc. RSA BSAFE® is a registered 

trademark or trademark of RSA Security Inc. in the United States and/or other countries.



1 Introduction

1-4 d-Color MF550/MF450

License information

This product includes RSA BSAFE Cryptographic software from 
RSA Security Inc.

OpenSSL Statement

OpenSSL License

Copyright © 1998-2000 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following 

acknowledgment:
"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. 
(http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their 
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL 
PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@crypt-Soft.com). This product 
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared 
to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, Ihash, DES, etc., 
code; not just the SSL code.
The SSL documentation included with this distribution is covered by the same copyright terms except that 
the holder is Tim Hudson (tjh@cryptsoft.com).
Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed. If this 
package is used in a product, Eric Young should be given attribution as the author of the parts of the library 
used. This can be in the form of a textual message at program startup or in documentation (online or textual) 
provided with the package.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following 

disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following 

acknowledgement:
"This product includes cryptographic software written by Eric Young (eay@crypt-soft.com)"
The word ‘cryptographic’ can be left out if the rouines from the library being used are not cryptographic 
related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application 
code) you must include an acknowledgement:
"This product includes software written by Tin Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be 
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the 
GNU Public Licence.]

NetSNMP License

Part 1: CMU/UCD copyright notice: (BSD like)

Copyright 1989, 1991, 1992 by Carnegie Mellon University Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and 
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both 
that copyright notice and this permission notice appear in supporting documentation, and that the name of 
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to 
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALLWARRANTIES WITH 
REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIEDWARRANTIES OF MERCHANTABILITY AND 
FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE 
FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE.

Part 2: Networks Associates Technology, Inc copyright notice (BSD)

Copyright © 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific prior written 
permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Part 3: Cambridge Broadband Ltd. copyright notice (BSD)

Portions of this code are copyright © 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution.
- The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from 

this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANYEXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THEIMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.IN NO EVENT SHALL THE COPYRIGHT 
HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Part 4: Sun Microsystems, Inc. copyright notice (BSD)

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All 
rights reserved.

Use is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to 

endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Part 5: Sparta, Inc copyright notice (BSD)

Copyright © 2003-2004, Sparta, Inc All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote 

products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Part 6: Cisco/BUPTNIC copyright notice (BSD)

Copyright © 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and 
Telecommunications. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of 

their contributors may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright

© 2007 Olivetti S.p.A. All Rights Reserved.

Note
- This user manual may not be reproduced in part or in full without permission.
- Olivetti S.p.A. will not be held liable for any incidents caused by using this printing system or user 

manual. 
- Information included in this user manual is subject to change without notice.
- Olivetti S.p.A. maintains the copyright of the printer drivers.
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1.1 Software licence agreement
This package contains the following materials provided by Olivetti S.p.A.: software included as part of the 
printing system, the digitally-encoded machine-readable outline data encoded in the special format and in 
the encrypted form ("Font Programs"), other software which runs on a computer system for use in 
conjunction with the Printing Software ("Host Software"), and related explanatory written materials 
("Documentation"). The term "Software" shall be used to describe Printing Software, Font Programs and/or 
Host Software and also include any upgrades, modified versions, additions, and copies of the Software.

The Software is being licensed to you under the terms of this Agreement.

Olivetti S.p.A. grants to you a non-exclusive sublicense to use the Software and Documentation, provided 
that you agree to the following:
1. You may use the Printing Software and accompanying Font Programs for imaging to the licensed 

output de-vice(s), solely for your own internal business purposes.
2. In addition to the license for Font Programs set forth in Section 1 ("Printing Software") above, you may 

use Roman Font Programs to reproduce weights, styles, and versions of letters, numerals, characters 
and symbols ("Typefaces") on the display or monitor for your own internal business purposes.

3. You may make one backup copy of the Host Software, provided your backup copy is not installed or 
used on any computer. Notwithstanding the above restrictions, you may install the on any number of 
computers solely for use with one or more printing systems running the Printing Software.

4. You may assign its rights under this Agreement to an assignee of all of Licensee’s right and interest to 
such Software and Documentation ("Assignee") provided you transfer to Assignee all copies of such 
Software and Documentation Assignee agrees to be bound by all of the terms and conditions of this 
Agreement.

5. You agree not to modify, adapt or translate the Software and Documentation.
6. You agree that you will not attempt to alter, disassemble, decrypt, reverse engineer or decompile the 

Software.
7. Title to and ownership of the Software and Documentation and any reproductions thereof shall remain 

with Olivetti S.p.A. and its licensor.
8. Trademarks shall be used in accordance with accepted trademark practice, including identification of 

the trademark owner’s name. Trademarks can only be used to identify printed output produced by the 
Software. Such use of any trademark does not give you any rights of ownership in that trademark.

9. You may not rent, lease, sublicense, lend or transfer versions or copies of the Software Licensee does 
not use, or Software contained on any unused media, except as part of the permanent transfer of all 
Software and Documentation as described above.

10. IN NO EVENT WILL OLIVETTI S.P.A. OR ITS LICENSOR BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, INCIDENTAL INDIRECT, PUNITIVE OR SPECIAL DAMAGES, INCLUDING ANY 
LOST PROFITS OR LOST SAVING, EVEN IF OLIVETTI S.P.A. HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. OLIVETTI S.P.A. OR 
ITS LICENSOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THE SOFTWARE, EXPRESS OR 
IMPLIED, INCLUDING, WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT OF THIRD PARTY 
RIGHTS. SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
INCIDENTIAL, CONSEQUENTIAL OR SPECIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT 
APPLY TO YOU.

11. Notice to Government End Users: The Software is a "commercial item," as that term is defined at 48 
C.F.R.2.101, consisting of "commercial computer software" and "commercial computer software 
documentation," as such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R. 12.212 and 48 
C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government End Users acquire the Software with only 
those rights set forth herein.

12. You agree that you will not export the Software in any form in violation of any applicable laws and 
regulations regarding export control of any countries.
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1.2 User manuals
This machine is provided with printed manuals and PDF manuals on the user manual CD.

User manual

This manual contains operating procedures and descriptions of the most frequently used functions.

Copy Operations

This manual contains descriptions of the Copy mode operations and machine maintenance. Refer to this 
manual for details on the paper and documents, copy procedures using convenient Application functions, 
replacing consumables, and troubleshooting operations such as clearing paper misfeeds.

Print Operations (this manual)

This manual contains details of the printing functions that can be specified with the standard built-in printer 
controller. Refer to this manual for operating procedures on using the printing functions.

Box Operations

This manual contains operating procedures for using the user boxes on the hard disk. Refer to this manual 
for details on saving data in user boxes, retrieving data from user boxes and transferring data.

Network Scanner Operations

This manual contains descriptions on specifying network settings for standard equipment and operating 
procedures for scanning functions. Refer to this user manual for details on using network functions and the 
Scan to E-Mail, Scan to FTP and Scan to SMB operations.

Web Connection Operations

This manual contains descriptions on the machine settings that can be specified remotely with Web 
Connection from a Web browser on a computer. Refer to this manual for details on operating procedures for 
using Web Connection.

Fax Operations (Option)

This manual contains descriptions of the G3 fax operations. Refer to this manual for details on using the G3 
fax operations when the optional fax kit is installed.

In order to use the fax functions, the optional fax kit must be purchased separately.

Network Fax Operations (Option)

This manual contains details on the network fax functions. Refer to this manual for operating procedures on 
Internet faxing and IP address faxing.

About this user manual

This user manual contains information for using the printing functions of the Olivetti printer controller. For 
details on the copy functions, scanning functions, box functions, and fax functions, refer to the respective 
user manual.

This user manual is aimed at users who already have a basic knowledge of computer and copier operations. 
For Windows or Macintosh operating system and application operations, refer to the operation manual of the 
respective product.
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Notations

Screen images in this user manual

Unless stated otherwise, the printer driver functions are described using the printer driver for Windows XP.

2
Note 
The machine illustrations shown in this manual can vary and depend on the machine configuration.

Product name Item

d-Color MF550/MF450
This machine

This machine, copier, or printer

Integrated network controller Network controller

Printer controller, including this machine, 
and printing system

Printing system

Microsoft Windows Windows
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1.3 Explanation of manual conventions
The marks and text formats used in this manual are described below.

Safety advices

6 DANGER
Failure to observe instructions highlighted in this manner may result in fatal or critical injuries in fact 
of electrical power.
% Observe all dangers in order to prevent injuries.

7 WARNING
Failure to observe instructions highlighted in this manner may result in serious injuries or property 
damage.
% Observe all warnings in order to prevent injuries and to ensure safe use of the machine.

7 CAUTION 
Failure to observe instructions highlighted in this manner may result in slight injuries or property 
damage.
% Observe all cautions in order to prevent injuries and to ensure safe use of the machine.

Sequence of action

1 The number 1 as formatted here indicates the first step of a 
sequence of actions. 

2 Subsequent numbers as formatted here indicate subsequent 
steps of a sequence of actions.

? Text formatted in this style provides additional assistance.
% Text formatted in this style describes the action that will 

ensure the desired results are achieved. 

Tips

2
Note 
Text highlighted in this manner contains useful information and tips to ensure safe use of the machine.

2
Reminder 
Text highlighted in this manner contains information that should be reminded.

!
Detail 
Text highlighted in this manner contains references for more detailed information.

Special text markings

[Stop] key
The names of keys on the control panel are written as shown above.

MACHINE SETTING
Display texts are written as shown above.

An illustration inserted 
here shows what operations 

must be performed.
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2 Overview

2.1 Printer controller
The printer controller is a device for performing printing functions and network printing functions with this 
machine.

Role of the printer controller

The printer controller is built into the machine.

You can print from applications on the computer connected to the printing system. When using this machine 
as a network printer, you can print from applications on the computer.

Available printer controller functions

The printer controller provides the following functions.
- Printing from a computer (using the PCL printer driver or PS printer driver)
- Support of network protocols including TCP/IP (IPv4/IPv6), NetBEUI, IPX/SPX, and AppleTalk
- Direct printing over a network using SMB (Windows), LPR, and IPP printing
- Access to settings for this machine and the printer controller from a client computer over the network 

(using a Web browser)
- Control of the number of pages printed ("User Authentication" and "Account Track" functions)
- Fax operations using a computer (fax transmission)

2
Note 
To perform fax operations, optional fax kit FK-502 is required.

Printing system

Printer
controller

ComputerMachine
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Machine modes

The printer driver settings are mainly set using a computer, however, the font list can be printed, and the 
printer controller settings and default print settings can be set using the control panel of this machine. In 
addition, fax and scanning operations can be used by switching the mode.

To switch between modes, press the mode keys on the control panel.

[Copy]

This machine can be used as a copier.

[Fax/Scan]

This machine can be used as a fax or as a scanner.

[User Box]

This machine can be used to store jobs and as a document folder for forwarding data to a computer over the 
network. 

2
Note 
You can use this machine as a printer in all modes.

Change the default print settings in the Utility mode.
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Printing flow

When using this printing system as a printer, the flow of the main process is described below.

Print commands transmitted from the application are received by the printer driver.

Data is transmitted to this machine over a USB interface when this machine is used as a USB printer, or over 
an Ethernet interface (TCP/IP, IPX/SPX, AppleTalk) when this machine is used as a network printer. The data 
is then delivered from this machine to the printer controller, which performs image rasterization (development 
of output characters and images to bitmap data). Finally, this data is printed from this machine.

Original documents can be scanned in the copy function or network scan function while this machine is 
operating as a printer.
To use this machine as a copier, press the [Copy] key on the control panel.

When a print job is received during copying, the data is stored in the memory of this machine. When copying 
is complete, the print job is automatically printed.

Printer controller

PS/PCL processing (rasterizing)

Computer

Used as a
network printer

Application Application

USB printer
Used as a

Printer driver Printer driver

USB Ethernet (TCP/IP, 
IPX/SPX, or AppleTalk)

Print

Machine
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Flow of the PC-FAX operation

Conventionally, faxes are sent by loading an original into a fax machine and sending it.

With computer faxing, you can send a fax directly from your computer without using any paper.

Transmission commands sent from the application are received by the printer driver.

Data is transmitted to this machine over a USB interface when this machine is used as a USB printer, or over 
an Ethernet interface (TCP/IP, IPX/SPX, AppleTalk) when this machine is used as a network printer. The data 
is then delivered from this machine to the printer controller, which performs image rasterization (development 
of output characters and images to bitmap data). Finally, this data is stored in the memory of this machine 
and transmitted like a conventional fax job.

Printer controller

PS/PCL processing (rasterizing)

Computer

Used as a
network printer

Application Application

USB printer
Used as a

Printer driver Printer driver

USB Ethernet (TCP/IP, 
IPX/SPX, or AppleTalk)

Fax

Machine
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2.2 Operating environment
The system requirements for using this printing system and the interfaces used for connection are explained 
below.

Compatible computers and operating systems

Check that the computer being connected meets the following conditions.

Windows

Macintosh

Item Operating environment

Operating System Windows NT 4.0 (Service Pack 6a or later), Windows 2000 Professional 
(Service Pack 4 or later), Windows XP Home Edition/Windows XP Profes-
sional (Service Pack 2 or later), Windows XP Professional x64 edition, Win-
dows Server 2003 or Windows Server 2003 x64 edition

Processor Pentium or higher

Memory Capacity recommended for the operating system
With sufficient memory resources in the operating system and application 
being used

Drive CD-ROM

Web Browser (when using Web Con-
nection)

Microsoft Internet Explorer 6 or later recommended (JavaScript enabled, 
Cookies enabled)
Microsoft XML Parser MSXML3.X must be installed when using Internet Ex-
plorer 5.5.
Netscape Navigator 7.02 or later (JavaScript enabled, Cookies enabled)
Mozilla Firefox 1.0 or later (JavaScript enabled, Cookies enabled)
Adobe® Flash® (If "Flash" is selected in View Mode, version 7.0 or later 
plugin is required.)

Item Operating environment

Operating System Mac OS 9.2, Mac OS X 10.2, Mac OS X 10.3, or Mac OS X 10.4

Processor PowerPC, Intel Processor

Memory Capacity recommended for the operating system

Drive CD-ROM

Web Browser (when using Web Con-
nection)

Netscape Navigator 7.02 or later (JavaScript enabled, Cookies enabled)
Mozilla Firefox 1.0 or later (JavaScript enabled, Cookies enabled)
Adobe® Flash® (If "Flash" is selected in View Mode, version 7.0 or later 
plugin is required.)
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Compatible interfaces

The various interfaces that can be used to connect this printing system to a computer are described below.

Ethernet interface

Connect when using this printing system as a network printer.

Supports 10Base-T, 100Base-TX and 1000Base-T (d-Color MF450) standards. In addition, the Ethernet 
interface supports the TCP/IP (LDP/LPR, peer-to-peer), IPX/SPX (NetWare), and AppleTalk (EtherTalk).

USB interface

Connect when using this printing system as a network printer.

The USB interface can be connected to a computer running Windows. A USB cable is required for 
connection. Use a type A (4 pin, male) or type B (4 pin, male) USB cable. A USB cable measuring 3 meters 
or less is recommended.

Connection diagram

The printer cables can be connected to each port at the back of this machine.

Machine (rear view)

USB 
cable

USB port

Ethernet 
(10Base-T/
100Base-TX/
1000Base-T (d-Color MF450))
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2.3 Setting up the system
In order to use this printing system, it must first be set up.

Setup consists of connecting this machine to a computer and installing the printer driver onto the computer 
being used.

To set up the printing system

Setup of the printing system as described below.

1 Connect this machine to a computer. (Refer to "Compatible interfaces" on page 2-8.)

2 When using a network connection, set up the network. (Refer to "Setting up network printing" on 
page 4-3.)

3 Install the printer driver. (Refer to "Installing the printer driver" on page 3-3.)

4 Check the setup by printing a test page. (Refer to "Test printing" on page 5-4.)

5 Install the screen fonts.

– The CD-ROM contain the Latin TrueType fonts as screen fonts.
– Install the screen fonts after adding the operating system standard fonts.
– For details, refer to Help of the operating system.
– The CD-ROM "ScreenFont" or "Screen Fonts" folder contains the screen fonts.
– The Macintosh fonts are compressed. Install the fonts after decompressing them.

Installation of the printer driver may differ depending on the connection method used with this machine in 
addition to the operating system of the computer and the type of printer driver being used.

!
Detail 
For details on connecting this machine to a computer, refer to "Compatible interfaces" on page 2-8.

2
Note 
To update an existing printer driver, delete the existing printer driver first.

As necessary, set the interface timeout settings in the Utility mode on the control panel. For details, refer 
to "Print settings in administrator mode" on page 11-28.
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3 Installing the printer driver

3.1 Printer drivers and supported operating systems
In order to use this printing system, the printer driver must be installed. The printer driver is a program that 
controls the processing of data for output. Install the printer driver onto the computer from the provided CD-
ROM.

The printer drivers included on the CD and the supported computer operating systems are listed below. 
Install the required printer driver.

Printer driver Page description lan-
guage

Supported operating systems

PCL Driver
(PCL driver)

PCL6 Windows NT 4.0 (Service Pack 6a),
Windows 2000 Professional (Service Pack 4 or later),
Windows XP Home Edition/Professional (Service Pack 2 
or later),
Windows XP Professional x64,
Windows Server 2003, and 
Windows Server 2003 x64

PostScript Driver
(PS driver)

PostScript3
Emulation

Windows 2000 Professional (Service Pack 4 or later),
Windows XP Home Edition/Professional (Service Pack 2 
or later),
Windows XP Professional x64,
Windows Server 2003, and 
Windows Server 2003 x64

PostScript PPD driver
(PS-PPD)

Mac OS 9.2 or later
Mac OS X 10.2, Mac OS X 10.3, and Mac OS X 10.4

PC-FAX driver Windows NT 4.0 (Service Pack 6a),
Windows 2000 Professional (Service Pack 4 or later),
Windows XP Home Edition
/Professional (Service Pack 2 or later),
Windows XP Professional x64,
Windows Server 2003, and 
Windows Server 2003 x64
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3.2 When used with Windows
The installation procedure for the Windows printer driver differs depending on how this machine is connected 
to the computer and depending on which printer driver is used. The installation method also differs 
depending on the version of Windows that you are using. Refer to the table below for the appropriate 
procedure for installing the printer driver on your computer.

2
Note 
For details on installing the printer driver in a network environment, refer to "Setting up network printing" 
on page 4-3. Because it is necessary to specify other network settings in advance when installing the 
printer driver using a network connection, install it using a local connection at this time.

To install the printer driver under Windows XP, Windows Server 2003, Windows 2000, or Windows NT 
4.0, log on using a user name that is authorized by the administrator.

Installing the printer driver using the Add Printer Wizard

For details on installing the printer driver in a network environment, refer to "Setting up network printing" on 
page 4-3. Because it is necessary to specify other network settings in advance when installing the printer 
driver using a network connection, install it using a local connection at this time.

For Windows XP/Server 2003

1 Insert the printer driver CD-ROM into the computer’s CD-ROM drive.

2 Click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

3 For Windows XP, click "Add a printer" on the "Printer Tasks" menu.
For Windows Server 2003, double-click the "Add Printer" icon.

The Add Printer Wizard starts up.

4 Click the [Next] button.

5 Select "Local printer attached to this computer", and then click the [Next] button.

– Clear the "Automatically detect and install my Plug and Play printer" check box.

6 The Select a Printer Port dialog box appears. Select "LPT1" here, and then click the [Next] button.

7 Click the [Have Disk] button.

8 Click the [Browse] button.

9 Specify the desired folder on the CD-ROM that contains the printer driver, and then click the [OK] 
button.

– Select the specified folder according to the printer driver to be used, the operating system, and the 
language.

– Printer drivers that can be selected:
Windows XP/Server 2003: PCL driver, PS driver, PC-FAX driver

10 Click the [OK] button.

The "Printers" list appears.

Printer driver Connection 
method

Refer to

PCL Driver
PostScript Driver
PostScript PPD
PC-FAX driver

Network con-
nection

"Installing the printer driver using the Add Printer Wizard" on page 3-4
"For Windows 2000/NT 4.0" on page 3-5
"For Windows XP/Server 2003" on page 3-4

USB connection "Installing the printer driver using Plug and Play" on page 3-6
"For Windows 2000" on page 3-6
"For Windows XP/Server 2003" on page 3-7
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11 Click the [Next] button.

12 Follow the on-screen instructions.

– When the Digital Signature dialog box appears, click the [Continue Anyway] button.
– When using a network connection, perform a test print after the network settings have been 

specified.

13 When installation is complete, make sure that the icon of the installed printer appears in the Printers 
and Faxes window.

14 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.

For Windows 2000/NT 4.0

1 Insert the printer driver CD-ROM into the computer’s CD-ROM drive.

2 Click the [Start] button, point to "Settings", and then click "Printers".

The Printers window appears.

3 Double-click the "Add Printer" icon.

The Add Printer Wizard starts up.

4 Follow the on-screen instructions.

5 In the screen for selecting the printer connection, select "Local Printer".

6 Click the [Next] button.

– If the screen for specifying the port appears, select "LPT1" here.

7 Click the [Have Disk] button.

8 Click the [Browse] button.

9 Specify the desired folder on the CD-ROM that contains the printer driver, and then click the [OK] 
button.

– Select the specified folder according to the printer driver to be used, the operating system, and the 
language.

– Printer drivers that can be selected: 
Windows 2000: PCL driver, PS driver, PC-FAX driver
Windows NT 4.0: PCL driver, PC-FAX driver

10 Click the [OK] button.

The "Printers" list appears.

11 Click the [Next] button.

12 If the screen for specifying the port appears, select "LPT1" here.

13 Follow the on-screen instructions.

– When the Digital Signature dialog box appears, click the [Yes] button.
– When using a network connection, perform a test print after the network settings have been 

specified.

14 When installation is complete, make sure that the icon of the installed printer appears in the Printers 
window.

15 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.
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Installing the printer driver using Plug and Play

For Windows 2000

1 After using a USB cable to connect this machine to a computer, turn on the computer.

– Do not disconnect or connect the cable while the computer is starting up.

2 Insert the printer driver CD-ROM into the computer’s CD-ROM drive.

3 Turn the main power of this machine on.

The Found New Hardware Wizard starts up.

4 Select "Search for a suitable driver for my device (recommended)", and then click the [Next] button.

5 Select "Specify location", and then click the [Next] button.

6 Specify the desired folder on the CD-ROM that contains the printer driver, and then click the [OK] 
button.

– Select the specified folder according to the printer driver to be used, the operating system, and the 
language.

– Printer drivers that can be selected: Windows 2000: PCL driver, PS driver, PC-FAX driver

7 Click the [OK] button, and then follow the on-screen instructions.

8 Click the [Finish] button.

9 When installation is complete, make sure that the icon of the installed printer appears in the Printers 
window.

10 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.



d-Color MF550/MF450 3-7

Installing the printer driver 3
For Windows XP/Server 2003

1 After using a USB cable to connect this machine to a computer, turn the computer on.

– Do not disconnect or connect the cable while the computer is starting up.

2 Insert the printer driver CD-ROM into the computer’s CD-ROM drive.

3 Turn the main power of this machine on.

– If the Add New Hardware Wizard does not start up, turn the main power off, then on again.
– When turning the power off, then on again, wait at least 10 seconds before turning the power on 

again; otherwise, this machine may not function properly. 
The Found New Hardware Wizard dialog box appears.

4 Select "Install from a list or specific location (Advanced)", and then click the [Next] button.

– If the Windows connect to Windows Update dialog box appears, select "NO".

5 From "Search for the best driver in these locations", select "Include this location in the search", and 
then click the [Browse] button.

6 Specify the desired folder on the CD-ROM that contains the printer driver, and then click the [OK] 
button.

– Select the specified folder according to the printer driver to be used, the operating system, and the 
language.

– PCL Driver: Windows XP/Server 2003: PCL driver, PS driver, PC-FAX driver

7 Click the [Next] button, and then follow the on-screen instructions.

– When the Digital Signature dialog box appears, click the [Continue] button.

8 Click the [Finish] button.

9 When installation is complete, make sure that the icon of the installed printer appears in the Printers 
and Faxes window.

10 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.
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3.3 When used with Macintosh
The installation procedure for the Macintosh printer driver differs depending on the Mac OS version and 
printer driver being used. Refer to the table below for the appropriate procedure for installing the printer driver 
on your Macintosh computer.

Installing the printer driver

For Mac OS X

1 Turn the Macintosh computer on.

2 Insert the printer driver CD-ROM into the computer’s CD-ROM drive.

– Quit all running applications that may have started when the Macintosh computer was turned on.

3 Open the desired folder on the CD-ROM that contains the printer driver.
Select the specified folder according to the printer driver to be used, the operating system, and the 
language.

4 Select the Mac OS version being used, and then copy the drive file onto the desktop.

d-Color MF550:
Mac OS X 10.2: GENERIC_45C-1_102.pkg 
Mac OS X 10.3: GENERIC_45C-1_103.pkg
Mac OS X 10.4: GENERIC_45C-1_103.pkg

d-Color MF450:
Mac OS X 10.2: GENERIC_45C-2_102.pkg 
Mac OS X 10.3: GENERIC_45C-2_103.pkg
Mac OS X 10.4: GENERIC_45C-2_103.pkg

5 Double-click the file copied onto the desktop.

– Enter the requested administrator’s name and password.
– For the administrator’s name and password, ask your network administrator.
– To quit the installation, click the [Cancel] button.

6 Click the [Continue] button and follow the on-screen instructions until the Easy Install dialog box 
appears.

7 In the Easy Install dialog box, click the [Install] button.

– From the second time the printer driver is installed and thereafter, the [Install] button may appear as 
the [Upgrade] button.

The printer driver is installed onto the Macintosh computer. When installation is complete, a message 
appears.

8 Click the [Close] button.

This completes the printer driver installation.
Next, select a printer.

Mac OS Printer driver Refer to

Mac OS X 10.2, Mac OS 
X 10.3, and Mac OS X 
10.4

PostScript PPD "Installing the printer driver" on page 3-8

Mac OS 9.2 or later PostScript PPD "Selecting a printer" on page 3-9
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Selecting a printer

For Mac OS X

After connecting this machine to a Macintosh computer, it can be used as a printer by selecting it in Print 
Center or Printer Setup Utility as the printer to be used.

1 Open Print Center or Printer Setup Utility, located in "Applications" – "Utilities" of "Hard Disk".

2 When the Add Printer dialog box appears, click the [Add] button. When the printer list appears, click 
the [Add] button.

– For Mac OS X 10.4, continue with step 3.
– For Mac OS X 10.2 and Mac OS X 10.3, skip to step 4.
– If usable printers have already been set up, the Add Printer dialog box does not appear.

3 If this machine appears as a printer with a Bonjour connection, select "GENERIC" from the "Print Using" 
drop-down list, select "GENERIC_45C-1 PS" ("GENERIC_45C-2 PS" on d-Color MF450) in the model 
list, and then click the [Add] button.

– If the selected printer is registered in the printer list, this completes the setting procedure.
– When connecting with AppleTalk and this machine does not appear as a printer, click the [More 

Printers] button, and then continue with step 4.
– If connecting using Bonjour with Mac OS X 10.4, the Bonjour settings must be specified on this 

machine. For specifying the Bonjour settings, refer to "Printing with Macintosh" on page 4-29.

4 Select the applicable connection method and printer name.

– To specify an AppleTalk zone for an AppleTalk connection, select "Local AppleTalk Zone".
– If connecting using AppleTalk, the AppleTalk settings on this machine must be specified. For 

specifying the AppleTalk settings, refer to "Printing with Macintosh" on page 4-29.
– If connecting using Rendezvous, the Bonjour settings on this machine must be specified. For 

specifying the Bonjour settings, refer to "Printing with Macintosh" on page 4-29.
– When "IPP" is selected as the protocol in IP Printer, the text box for entering the queue name 

appears. For Mac OS 10.3, leave the queue name text box empty. For Mac OS 10.4, enter "ipp" in 
the queue name text box.

5 Select "GENERIC" from the "Printer Model" drop-down list.

6 Select "GENERIC_45C-1 PS" ("GENERIC_45C-2 PS" on d-Color MF450), and then click the [Add] 
button.

The selected printer is registered in the printer list.

For Mac OS 9.2

After connecting this machine, it can be used as a printer by selecting "PostScript printer" under "Chooser" 
and by specifying the printer description (PPD) File.

First, copy the printer description (PPD) file onto the Macintosh computer.

1 Insert the printer driver CD-ROM into the computer’s CD-ROM drive.

2 Open the desired folder on the CD-ROM that contains the printer driver. Select the specified folder 
according to the printer driver to be used, the operating system, and the language.

3 Select PPD file "GENERIC_45C-1UVxxx.ppd" ("GENERIC45C-1UVxxx.ppd" on d-Color MF450), and 
then copy it into the "Printer Descriptions" folder in "System Folder" – "Extensions" of "Hard Disk".

Next, select a printer.
The printer driver can use a standard Macintosh LaserWriter.

4 On the Apple menu, click "Chooser".

5 Make sure that "AppleTalk" is set to "Active", and then click the [LaserWriter] icon. 
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6 From the "Select a PostScript Printer" list, click the applicable printer for the printing system, and then 
click the [Create] button.

– If a different PPD file has already been selected, click the [Setup] button in step 6, and then click the 
[Select PPD] button from the screen that is already displayed.

The PostScript printer description (PPD) file selection screen appears.

7 Select the applicable PPD file, and then click the [Select] button or [Open] button.

The setting screen for adding options appears.

8 Select the options that are installed on this machine.

9 Click the [OK] button.

The Chooser window appears again.

10 Close the Chooser window.

Uninstalling the printer driver

If it becomes necessary to delete the printer driver, for example, when you want to reinstall the printer driver, 
follow the procedure below to delete the driver.

2
Note 
Quit all running applications that may have started when the Macintosh computer was turned on.

For Mac OS X

1 Open the Printer Setup Utility or Print Center, located in "Applications" – "Utilities" of "Hard Disk".

2 Select the name of the printer to be deleted, and then click the [Delete] button.

The selected printer is deleted.

3 Close the printer list.

4 Drag the following file, which is located in "Library" – "Printers" – "PPDs" – "Contents" – "Resources" 
– "en.lproj" of "Hard Disk", to the "Trash" icon.

– "GENERIC_45C-1.gz" ("GENERIC 45C-1.gz" on d-Color MF450)

5 Delete the unnecessary files from "Library"–"Printers".

Drag the "45C-1" ("45C-2" on d-Color MF450) folder, which is located in "Library" – "Printers" – 
"GENERIC", to the "Trash" icon.
For Mac OS 10.2, drag all the "GENERIC 45C-1" ("GENERIC 45C-2" on d-Color MF450) folders, which 
are located in "Library" – "Printers" – "PPD Plugins", to the "Trash" icon.

6 Restart the computer.

This completes the printer driver uninstallation procedure.

For Mac OS 9.2

1 Drag PPD file "GENERIC45C-1UVxxx.ppd" ("GENERIC_45C-2UVxxx.ppd" on d-Color MF450), which 
is located in "System Folder" – "Extensions" – "Printer Descriptions" of "Hard Disk", to the "Trash" icon.

The related printer driver files are deleted.

2 Restart the computer.

This completes the printer driver uninstallation procedure.
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4 Setting up network printing

4.1 Overview of network functions

Network functions

By connecting this machine to a network through the Ethernet port, this printing system can be used as a 
network printer.

This printing system supports 10Base-T, 100Base-TX and 1000Base-T (d-Color MF450) standards. In 
addition, the Ethernet interface supports the TCP/IP (LDP/LPR, IPP, SMB), NetBEUI (SMB), IPX/SPX 
(NetWare), and AppleTalk (EtherTalk) protocols.

2
Note 
When setting up the network, the administrator password is required to enter Administrator mode.

Ask the administrator of this machine for the administrator password.

Features of the network functions

This printing system is equipped with the following network functions to flexibly support various network 
environments.
- Automatic selection of 10Base-T, 100Base-TX and 1000Base-T (d-Color MF450) (Fast Ethernet)
- Obtains the IP address automatically from DHCP or BOOTP
- Printing with SMB printing (Windows 2000/XP/Server 2003)

You can print with SMB in Windows 2000, Windows XP, or Windows Server 2003.
- Printing with LPR printing (Windows NT 4.0/2000/XP/Server 2003)

You can print with LPD/LPR in Windows NT 4.0, Windows 2000, Windows XP, or Windows Server 2003.
LPR (Line Printer Request): This print request system can be used under Windows NT 4.0, Windows 
2000, Windows XP, or Windows Server 2003. Enter the queue name as "Print".

- Printing with Port 9100 (Windows 2000/XP/Server 2003)
You can print with Port 9100 in Windows 2000, Windows XP, or Windows Server 2003.

- Supports Novell NetWare PServer and Rprinter (Nprinter)
- Supports the Novell NetWare print server functions and supports both bindery mode and Novell 

Directory Service (NDS)

Printing system

This machine
Ethernet

Network

Hub
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With NetWare

The Novell NetWare 4.x–6 print server functions are supported.

You can connect this printing system to a network using Novell NetWare 4.x–6 as the network operating 
system and send print jobs from the client to the print server (network controller). The three modes supported 
are as follows:
- Nprinter
- PServer
- NDS/NDPS

2
Note 
For details on the NetWare functions, refer to the NetWare operation manual.

With Macintosh

You can print from your Macintosh computer using LPR, AppleTalk, or Bonjour/Rendezvous.

You can also connect this printing system to a print server in an AppleTalk or a Bonjour/Rendezvous 
environment and send print jobs from the Macintosh computer to this machine.

Network connection methods that can be selected in each Windows operating system

This chapter describes the settings that must be specified for network printing.

Setting procedures differ depending on the method of networking printing used (SMB, LPR, or IPP printing). 
Select the best method of network printing for your Windows environment.

Network printing from a Windows operating system

2
Reminder 
Before setting up network printing, install the printer driver. For details on installing the printer driver, 
refer to "Installing the printer driver" on page 3-3.

To perform network printing, change the printer port for the installed printer driver to one for a network 
connection, and then change the settings on this machine as necessary.
For an IPP connection, it is necessary to install the printer driver first.

Network printing in a NetWare environment

Protocol
used

Windows 2000 Windows XP Windows NT 
4.0

Windows Serv-
er 2003

SMB printing TCP/IP, Net-
BEUI

o o o

LPR printing TCP/IP o o o o

IPP printing TCP/IP o o o

Port 9100 print-
ing

TCP/IP o o o

NetWare version Protocol used Emulation Service mode

NetWare 4.x IPX NDS/Bindery PServer/Nprinter

NetWare 5.x/6 IPX NDS PServer

TCP/IP NDPS (lpr)
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4.2 Setting the IP address for this machine
Use this machine’s control panel to assign an IP address to this machine.

2
Reminder 
When specifying network settings, follow the instructions of the network administrator.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [TCP/IP Settings].

3 Touch [ON].

4 Touch [IP Settings].

5 Touch [Manual Input] under "IP Application Method".

6 Specify settings for the following:

– IP Address: Specify the IP address of this machine.
– Subnet Mask: Specify the subnet mask for the network to which you are connecting.
– Default Gateway: Specify the default gateway address for the network to which you are connecting.

7 Touch [OK].

8 To apply the settings, restart this machine (turn the main power off, then on again).

Turn this machine back on to apply the IP address.
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2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 

!
Detail 
Although the method for entering a static IP address without using the DHCP server is described in the 
procedure here, it is also possible to automatically assign the IP address from the DHCP server. When 
"IP Application Method" is specified as "Auto Input" and "DHCP Settings" is set to "ON" in the setting 
screen that is displayed, the IP address, subnet mask, and gateway address settings are automatically 
assigned from the DHCP server on the network, so it is not necessary to assign them manually. 
However, note the following when setting "DHCP Settings" to "ON".

Check with the network administrator that the DHCP server exists. If the DHCP server does not exist, 
be sure to specify settings for "IP Address", "Subnet Mask", and "Default Gateway".

If the settings for the IP address and other items have been assigned using the DHCP server, there is 
a possibility that they may be automatically changed. When the settings for the IP address and other 
items are changed, if the IP address has been used to specify a printer on the network for printing, there 
is a possibility that printing may not be possible because this machine cannot communicate with the 
network. If "DHCP Settings" has been set to "ON", it is recommended that the IP address assigned to 
this machine be fixed in the DHCP server settings.
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4.3 Accessing Web Connection
Setting the IP address for this machine enables you to access Web Connection.

With Web Connection, you can change the network settings of this machine from a computer.

Use your Web browser to directly access Web Connection.

1 Start up the Web browser.

2 In the "Address" bar, enter the IP address for this machine as shown below, and then press the [Enter] 
key.

– http://<IP_address_for_this_machine>/
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/

– If IPv6 is enabled and a Web browser other than Internet Explorer is used, enter the IPv6 address 
enclosed in brackets to access Web Connection. 
http://[IPv6_address_for_this_machine]/
Example: If the IPv6 address for this machine is fe80::220:6bff:fe10:2f16 
http://[fe80::220:6bff:fe10:2f16]/

– If IPv6 is enabled and Internet Explorer is used, edit the hosts file to note 
"fe80::220:6bff:fe10:2f16IPv6 IPv6_MFP_1" and specify the URL according to the domain name.

The initial page of Web Connection appears.

For further details on Web Connection, refer to the User manual – Page Scope Web Connection Operations.

2
Note 
If the user authentication function is enabled, you must enter a user name and password.
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4.4 SMB printing
You can use SMB printing (Windows printing) to print directly over the Microsoft network from computers 
running Windows.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to "Setting the IP address for this 
machine" on page 4-5.

Next, specify the SMB print settings for this machine as described below.

2
Note 
The settings can also be specified from Web Connection.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], [SMB Settings], then [Print Settings].

3 Touch [ON].

4 Specify settings for the following. After specifying the settings, touch [OK].

– NetBIOS Name: Specify the NetBIOS name (up to 15 characters).
– Print Service Name: Specify the printing service name (up to 12 characters).
– Workgroup: Specify the work group name (up to 15 characters).

5 To apply the settings, restart this machine (turn the main power off, then on again).

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 



d-Color MF550/MF450 4-9

Setting up network printing 4
Printer driver settings

1 For Windows 2000, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the [Add Port] button on the Ports tab, double-click "Local Port" or select "Local Port" and click 
the [New Port] button, and then enter "\\<NetBIOS_name>\<printing_service_name>".

– Enter the same NetBIOS name and print service name that you entered for the SMB print settings 
for this machine. For the setting procedure, refer to "Operations on this machine" on page 4-8.

4 Click the [Close] button to apply the setting.
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4.5 LPR printing
The LPR print service is supported as standard in Windows 2000, Windows XP, Windows NT 4.0, and 
Windows Server 2003. TCP/IP is used as the network protocol.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to "Setting the IP address for this 
machine" on page 4-5.

Printer driver settings

For Windows 2000/XP/Server 2003

1 For Windows 2000, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 On the Ports tab, click the [Add Port] button.

4 In the "Available Printer Ports" list, select "Standard TCP/IP Port", and then click the [New Port] button.

5 When the Add Standard TCP/IP Printer Port Wizard starts up, click the [Next] button.

6 In the "Name of printer or IP address" box, enter the IP address for this machine, and then click the 
[Next] button.

7 Select "Custom", and then click the [Settings] button.

8 Select "LPR", enter "Print" in the "Queue Name" box, and then click the [OK] button.
The uppercase letters and lowercase letters must be entered correctly.

9 Click the [Next] button, and then click the [Finish] button to apply the setting.

For Windows NT 4.0

1 Click the [Start] button, point to "Settings", and then click "Printers".

2 Right-click the icon of the installed printer, and then click "Properties".

3 On the Ports tab, click the [Add Port] button.

4 In the "Available Printer Ports" list, select "LPR Port", and then click the [New Port] button.

– If "LPR Port" is not in the list, click the [Start] button, point to "Control Panel", and then click 
"Network". Then, on the Service tab, click the [Add] button and install the Microsoft TCP/IP Printing 
Services.

5 In the "Name or address of server providing lpd" box on the Add LPR Compatible Printer dialog box, 
enter the IP address for this machine.

6 In the "Name of printer or print queue on that server" box, enter "Print".
The uppercase letters and lowercase letters must be entered correctly.

7 Click the [OK] button to apply the setting.
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4.6 Port 9100 printing (Windows 2000/XP/Server 2003)
The Port 9100 print service is supported as standard in Windows 2000, Windows XP, and Windows Server 
2003. TCP/IP is used as the network protocol.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to "Setting the IP address for this 
machine" on page 4-5.

Printer driver settings (Windows 2000/XP/Server 2003)

When using Port 9100 to print, change the printer driver port to the Port 9100 port.

1 For Windows 2000, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 On the Ports tab, click the [Add Port] button.

4 In the "Available Printer Ports" list, select "Standard TCP/IP Port", and then click the [New Port] button.

5 When the Add Standard TCP/IP Printer Port Wizard starts up, click the [Next] button.

6 In the "Name of printer or IP address" box, enter the IP address for this machine, and then click the 
[Next] button.

7 Select "Custom", and then click the [Settings] button.

8 Select "RAW", and then enter the RAW port number (the default setting is "9100") in the "Port Number" 
box.

9 Click the [Next] button, and then click the [Finish] button to apply the setting.

2
Note 
If the RAW port is not specified to be used in the TCP/IP setting, printing cannot be performed.
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4.7 IPP printing (Windows 2000/XP/Server 2003)
The IPP (Internet Printing Protocol) print service is supported as standard in Windows 2000, Windows XP, 
and Windows Server 2003. TCP/IP is used as the network protocol.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to "Setting the IP address for this 
machine" on page 4-5.

Next, specify the IPP settings for this machine as described below.

2
Note 
The settings can also be specified from Web Connection.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [HTTP Server Settings].

3 Touch [ON]. After specifying the settings, touch [Forward].

4 Touch [ON] under "IPP Settings" and "Accept IPP Jobs".
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5 Touch [Printer Information], and then specify settings for the following. After specifying the settings, 

touch [Close].

– Printer Name: Specify the printer name (up to 127 characters).
– Printer Location: Specify the printer location (up to 127 characters).
– Printer Information: Specify the printer manufacturer details (up to 127 characters).

6 Touch [Support Information], and then specify the print operations supported by IPP. After specifying 
the settings, touch [OK].

7 Touch [Forward].

8 Specify settings for the following. After specifying the settings, touch [Forward].

– IPP Authentication Settings: Select [ON].
– Authentication Method: Select the IPP authentication method.
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9 Specify the user name and password. After specifying the settings, touch [OK].

10 To apply the settings, restart this machine (turn the main power off, then on again).

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 

Installing the printer driver

For IPP printing, reinstall the printer driver.

1 Insert the printer driver CD-ROM into the computer’s CD-ROM drive.

2 For Windows 2000, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

3 For Windows 2000/Server 2003, double-click the "Add Printer" icon.
For Windows XP, click "Add a printer" on the "Printer Tasks" menu.

The Add Printer Wizard starts up.

4 Click the [Next] button.

5 In the Local or Network Printer dialog box, select "Network printer", and then click the [Next] button.

6 In the Locate Your Printer dialog box, select "Connect to a printer on the Internet or on your intranet".

7 In the "URL" field, enter the URL for this machine in the following format, and then click the [Next] 
button.

– http://<IP_address_for_this_machine>/ipp
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/ipp

8 When the confirmation dialog box appears, click the [OK] button.

9 Click the [Have Disk] button.

10 Specify the desired folder on the CD-ROM that contains the printer driver, and then click the [OK] 
button. Select the specified folder according to the printer driver to be used, the operating system, and 
the language.

Printer drivers that can be selected:
Windows XP/Server 2003: PCL driver, PS driver
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11 Check that the printer name is displayed in the "Printers" list, and then click the [Next] button.

12 Select whether to set the printer as the default printer, and then click the [Next] button.

13 Click the [Finish] button to exit the Add Printer Wizard.

Once the settings for the printer have been specified, you can use the printer in the same way as a default 
local printer. Also, if you set up the printer for sharing in Windows, it can be used as a network printer by other 
Windows computers over the network.
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4.8 Printing with NetWare
The printer controller supports the following environments.

Network printing in a NetWare environment

For Remote Printer mode with NetWare 4.x bindery emulation

2
Note 
Before using bindery emulation, check that bindery emulation is compatible with the NetWare server.

1 From a client computer, log on with Supervisor permissions to access the NetWare server where the 
PServer is registered.

2 Start up Pconsole.

3 From the "Available Options" list, select "Quick Setup", and then click the [Enter] button.

4 Enter the appropriate names in the "Printer Server Name", "Printer Name", "Print Queue Name", and 
"Print Queue Volume" fields, select "Other/Unknown" from the "Printer type" field, and then save the 
specified settings.

5 Click the [Esc] button to quit Pconsole.

6 Use the NetWare server console to load PSERVER.NLM.

!
Detail 
For queue user privileges, printer notification options, assignment of multiple queues, and passwords, 
refer to the NetWare documentation, and specify the settings as necessary.

Next, specify the NetWare settings for this machine as described below.

2
Note 
The settings can also be specified from Web Connection.

NetWare version Protocol used Emulation Service mode

NetWare 4.x IPX NDS/Bindery PServer/Nprinter

NetWare 5.x/6 IPX NDS PServer

TCP/IP NDPS (lpr)
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1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 

enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [NetWare Settings].

3 Touch [IPX Settings], and then specify settings for the following. After specifying the settings, touch 
[Close].

– IPX Setting: Select [ON].
– Ethernet Frame Type: Select "Auto Detect". (Select the frame type according to the network 

environment.)

4 In the NetWare Settings screen, touch [NetWare Print Settings], and then specify settings for the 
following. 

– NetWare Print Settings: Select [ON].
– NetWare Print Mode: Select [Nprinter/Rprinter].
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5 Specify settings for the following. After specifying the settings, touch [Close].

– Print Server Name: Specify the Print Server Name.
– Printer Number: Specify the printer number (0 to 254), or select [Auto].

6 Touch [Close].

7 In the NetWare Settings screen, touch [User Authentication Setting (NDS)], and then specify settings for 
the following. After specifying the settings, touch [Close].

– User Authentication Setting (NDS): Select [ON]. (Depending on the network environment, select 
[OFF].)

8 In the NetWare Settings screen, touch [Close].

9 Restart this machine (turn the main power off, then on again).

10 Use the NetWare server console to display the print server screen, and then check that the created 
printer is shown as "Waiting for Job" for the connected printer (0).

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 
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For Print Server mode with NetWare 4.x bindery emulation

2
Note 
Before using bindery emulation, check that bindery emulation is compatible with the NetWare server.

1 From a client computer, log on with Supervisor permissions to access the NetWare server where the 
PServer is registered.

2 Start up Pconsole.

3 From the "Available Options" list, select "Quick Setup", and then click the [Enter] button.

4 Enter the appropriate names in the "Printer Server Name", "Printer Name", "Print Queue Name", and 
"Print Queue Volume" fields, select "Other/Unknown" from the "Printer type" field, and then save the 
specified settings.

5 Click the [Esc] button to quit Pconsole.

Next, specify the NetWare settings for this machine as described below.

2
Note 
The settings can also be specified from Web Connection.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [NetWare Settings].



4 Setting up network printing

4-20 d-Color MF550/MF450

3 Touch [IPX Settings], and then specify settings for the following. After specifying the settings, touch 
[Close].

– IPX Setting: Select [ON].
– Ethernet Frame Type: Select "Auto Detect". (Select the frame type according to the network 

environment.)

4 In the NetWare Settings screen, touch [NetWare Print Settings], and then specify settings for the 
following. After the NetWare print mode is selected, the screen switches automatically.

– NetWare Print Settings: Select [ON].
– NetWare Print Mode: Select [PServer].

5 Specify settings for the following. After specifying the settings, touch [Forward].

– Print Server Name: Specify the print server name created with Pconsole.
– Print Server Password: Specify only when setting from the NetWare server.
– Polling Interval: Specify 1. (Change as necessary.)
– NDS/Bindery Setting: Select [NDS & Bindery].
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6 Specify settings for the following. After specifying the settings, touch [Close].

– File Server Name: Specify the name of the file server that connects to the PServer.
– NDS Context Name: Specify the name of the context that connects to the PServer.
– NDS Tree Name: Specify the name of the tree that PServer logs on to.

7 Touch [Close].

8 In the NetWare Settings screen, touch [User Authentication Setting (NDS)], and then specify settings for 
the following. After specifying the settings, touch [Close].

– User Authentication Setting (NDS): Select [ON]. (Depending on the network environment, select 
[OFF].)

9 In the NetWare Settings screen, touch [Close].

10 Restart this machine (turn the main power off, then on again).

11 Use the NetWare server console to load MONITOR.NLM.

12 Select the connection information and, in the active connection column, check that the created PServer 
is connected.

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 
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For NetWare 4.x Remote Printer mode (NDS)

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Select either the organization or organizational unit container that offers the print service, and then click 
"Print Services Quick Setup" on the "Tools" menu.

4 Enter the appropriate names in the "Printer Server Name", "Printer Name", "Print Queue Name", and 
"Print Queue Volume" fields, select "Other/Unknown" from the "Printer type" field, and then save the 
specified settings.

!
Detail 
For queue user privileges, printer notification options, assignment of multiple queues, and passwords, 
refer to the NetWare documentation, and specify the settings as necessary.

Next, specify the NetWare settings for this machine as described below.

2
Note 
The settings can also be specified from Web Connection.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [NetWare Settings].
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3 Touch [IPX Settings], and then specify settings for the following. After specifying the settings, touch 

[Close].

– IPX Setting: Select [ON].
– Ethernet Frame Type: Select "Auto Detect". (Select the frame type according to the network 

environment.)

4 In the NetWare Settings screen, touch [NetWare Print Settings], and then specify settings for the 
following. After the NetWare print mode is selected, the screen switches automatically.

– NetWare Print Settings: Select [ON].
– NetWare Print Mode: Select [Nprinter/Rprinter].

5 Specify settings for the following. After specifying the settings, touch [Close].

– Print Server Name: Specify the Print Server Name.
– Printer Number: Specify the printer number (0 to 254), or select [Auto].
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6 Touch [Close].

7 In the NetWare Settings screen, touch [User Authentication Setting (NDS)], and then specify settings for 
the following. After specifying the settings, touch [Close].

– User Authentication Setting (NDS): Select [ON]. (Depending on the network environment, select 
[OFF].)

8 In the NetWare Settings screen, touch [Close].

9 Restart this machine (turn the main power off, then on again).

10 Use the NetWare server console to load PSERVER.NLM.

11 Use the NetWare server console to display the print server screen, and then check that "45C-1"/"45C-
2" (created printer) is shown as "Waiting for Job" for the connected printer (0).

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 

For NetWare 4.x/5.x/6 Print Server mode (NDS)

2
Note 
To use the Print Server mode, the IPX protocol must be loaded on the NetWare server.

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Select either the organization or organizational unit container that offers the print service, and then click 
"Print Services Quick Setup (non-NDPS)" on the "Tools" menu.

4 Enter the appropriate names in the "Printer Server Name", "Printer Name", "Print Queue Name", and 
"Print Queue Volume" fields, select "Other/Unknown" from the "Printer Type" field, and then click the 
[Create] button.

!
Detail 
For queue user privileges, printer notification options, assignment of multiple queues, and passwords, 
refer to the NetWare documentation, and specify the settings as necessary.
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Next, specify the NetWare settings for this machine as described below.

2
Note 
The settings can also be specified from Web Connection.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [NetWare Settings].

3 Touch [IPX Settings], and then specify settings for the following. After specifying the settings, touch 
[Close].

– IPX Setting: Select [ON].
– Ethernet Frame Type: Select "Auto Detect". (Select the frame type according to the network 

environment.)



4 Setting up network printing

4-26 d-Color MF550/MF450

4 In the NetWare Settings screen, touch [NetWare Print Settings], and then specify settings for the 
following. After the NetWare print mode is selected, the screen switches automatically.

– NetWare Print Settings: Select [ON].
– NetWare Print Mode: Select [PServer].

5 Specify settings for the following. After specifying the settings, touch [Close].

– Print Server Name: Specify the print server name created in NWadmin.
– Print Server Password: Specify only when setting from the NetWare server.
– Polling Interval: Specify 1. (Change as necessary.)
– NDS/Bindery Setting: Select [NDS].

6 Specify settings for the following. After specifying the settings, touch [Close].

– File Server Name: Specify the name of the file server that connects to the PServer.
– NDS Context Name: Specify the name of the context that connects to the PServer.
– NDS Tree Name: Specify the name of the tree that PServer logs on to.

7 Touch [Close].
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8 In the NetWare Settings screen, touch [User Authentication Setting (NDS)], and then specify settings for 

the following. After specifying the settings, touch [Close].

– User Authentication Setting (NDS): Select [ON]. (Depending on the network environment, select 
[OFF].)

9 In the NetWare Settings screen, touch [Close].

10 Restart this machine (turn the main power off, then on again).

11 Use the NetWare server console to load MONITOR.NLM.

12 Select the connection information and, in the active connection column, check that the created PServer 
is connected.

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 

For NetWare 5.x/6 Novell Distributed Print Service (NDPS)

2
Note 
Before specifying settings for NDPS, check that the NDPS broker and NDPS manager have been 
created and loaded.

Also, before performing the following procedure, check that the TCP/IP protocol has been set in the 
NetWare server, and check that the IP address has been set for this machine and that this machine is 
on.

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Right-click the organization or organizational unit container where you will create the printer agent, and 
then click "NDPS Printer" on the "Create" sub-menu.

4 In the "NDPS Printer Name" box, enter the printer name.

5 In the "Printer Agent Source" column, select "Create a New Printer Agent", and then click the [Create] 
button.

6 Check the printer agent name, and then in the "NDPS Manager Name" box, browse through the NDPS 
manager names, and register one.

7 In "Gateway Types", select "Novell Printer Gateway", and then register it.

8 In the Configure Novell PDS for Printer Agent window, select "(None)" for the printer type and "Novell 
Port Handler" for the port handler type, and then register the settings.
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9 In "Connection type", select "Remote (LPR on IP)", and then register it.

10 Enter the IP address set for this machine as the host address, enter "Print" as the printer name, and 
then click the [Finish] button to register the settings.

11 The printer driver registration screen appears. Select "None" for each operating system to complete the 
registration.

!
Detail 
For printer user rights, printer notification options, and assignment of queues, refer to the NetWare 
documentation, and specify the settings as necessary.

Specifying client (Windows) settings when using the NetWare server

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 For Windows 2000/NT 4.0/Server 2003, double-click the "Add Printer" icon.
For Windows XP, click "Add a printer" on the "Printer Tasks" menu.

The Add Printer Wizard starts up.

3 In the port settings, browse the network, and specify the name of the created queue (or NDPS printer 
name).

4 From the printer model list, specify the desired folder on the CD-ROM that contains the printer driver.

– Select the specified folder according to the printer driver to be used, the operating system, and the 
language.

– Printer drivers that can be selected:
Windows 2000/XP/Server 2003: PCL driver, PS driver
Windows NT 4.0: PCL driver

5 Follow the on-screen instructions to complete the installation.
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4.9 Printing with Macintosh
This section describes this machine’s settings and the Macintosh network settings.

Specify the printer network port settings after installing the printer driver and when selecting a printer. To 
select a printer, refer to "Selecting a printer" on page 3-9.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to "Setting the IP address for this 
machine" on page 4-5.

Next, specify the AppleTalk or Bonjour settings for this machine as described below.

2
Note 
The settings can also be specified from Web Connection.

Specifying the AppleTalk settings

When connecting this machine to a Macintosh computer using AppleTalk, the AppleTalk settings must be 
specified.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [AppleTalk Settings].

3 Specify settings for the following. After specifying the settings, touch [OK].

– AppleTalk Setting: Select [ON].
– Printer Name: Specify the printer name (up to 31 characters).
– Zone Name: Specify the zone being connected to (up to 31 characters).

4 To apply the settings, restart this machine (turn the main power off, then on again).

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 
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Specifying the Bonjour settings

When connecting this machine to a Macintosh computer using Bonjour/Rendezvous, the Bonjour settings 
must be specified.

2
Note 
The Bonjour connection is a Mac OS X 10.4 function, it is the same function as the Rendezvous 
connection in Mac OS 10.3 or earlier.

1 Press the [Utility/Counter] key in this machine’s control panel, touch [Administrator Settings], and then 
enter the administrator password.

– The administrator password is required to enter Administrator mode. Ask the administrator of this 
machine for the administrator password.

2 Touch [Network Settings], then [Bonjour Setting].

3 Specify settings for the following. After specifying the settings, touch [OK].

– Bonjour Setting: Select [ON].
– Bonjour Name: Specify the Bonjour name that is to appear as the connected device name (up to 63 

characters).

4 To apply the settings, restart this machine (turn the main power off, then on again).

2
Reminder 
When turning the power off, then on again, wait at least 10 seconds before turning the power on again; 
otherwise, this machine may not function properly. 
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Setting the Macintosh computer

Use the Macintosh computer that is connected to specify the TCP/IP and AppleTalk settings.

2
Note 
For network settings, consult the network administrator.

For the printer driver installation procedure, refer to "Installing the printer driver" on page 3-3.

Since Bonjour (a Mac OS X 10.4 function) is always enabled, it is not required to change the settings.
Bonjour/Rendezvous is a Mac OS X function. For Mac OS 9.2, connect using AppleTalk.

For Mac OS X

1 On the Apple menu, select "System Preferences".

2 Click the "Network" icon.

3 From "Show", select "Built-in Ethernet".

4 Click the TCP/IP tab.

5 Select the items from "Configure" that correspond to the network settings for the Macintosh computer 
that is connected to the network, and then set the IP address and subnet mask.

6 If using an AppleTalk connection, click the AppleTalk tab, and then check that the "Make AppleTalk 
Active" check box is selected.

7 Click the close button at the top left of the dialog box.

The "Apply configuration changes?" message appears.

8 Click the [Apply] button.

The changed setting are saved.

For Mac OS 9.2

1 On the Apple menu, point to "Control Panel", and then click "AppleTalk".

2 From the "Connect via" drop-down list, select "Ethernet".

3 On the Apple menu, point to "Control Panel", and then click "TCP/IP".

4 From the "Connect via" drop-down list, select "Ethernet".

5 Select the items from "Configure" that correspond to the network settings for the Macintosh computer 
that is connected to the network, and then set the IP address and subnet mask.

6 Click the close button at the top left of the dialog box.

The "Save changes to the current configuration?" message appears.

7 Click the [Save] button.
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5 Various printing methods

5.1 Printing operations

For Windows

Print jobs are specified from the application software.

1 Open the data in the application, click [File], and then click [Print].

2 Check that the printer name has been selected in "Printer Name" or "Select Printer". If the printer is not 
selected, click to select the printer.

– The Print dialog box differs depending on the application.

3 Specify the print range and the number of copies to print.

4 Click the [Properties] button or the [Preferences] button to change the printer driver settings as 
necessary.

– By clicking the [Preferences] button or the [Properties] button in the Print dialog box, you can specify 
the settings of each model in the printer driver dialog box that appears. For details, refer to "Setting 
up the PCL driver (Windows)" on page 6-3, or "Setting up the PostScript driver (Windows)" on 
page 7-3.

– If the changed settings are not saved in the Print dialog box, the original settings are restored when 
the application is quit.

5 Click the [Print] button.

The Data indicator of this machine flashes.
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Test printing

Printing is possible when the printer driver is installed and the network settings have been specified. To check 
that the connection has been made properly, you can print the standard Windows test page.

Print a test page from the printer driver Properties dialog box.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the General tab, and then click the [Print Test Page] button or the [Print Test] button.

The test page is printed and the confirmation dialog box appears.

4 Check the printout, and then click the [OK] button or the [Yes] button.

2
Note 
If the test page is not printed properly, check that the printer driver has been installed properly and that 
the network settings are complete.

For Macintosh

Printing is possible when the printer driver is installed and the network settings have been specified. Print 
jobs are specified from the application software.

For Mac OS X

1 Open the data in the application, click [File], and then click "Print".

2 Check that the printer name has been selected.

3 Specify the print range and the number of copies to print, and then click the [Print] button.

– If the printer name does not appear in the list, select the printer in Print Center or Print Setup Utility. 
For details, refer to "Selecting a printer" on page 3-9.

– The Print dialog box differs depending on the application.
The Data indicator of this machine flashes.
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For Mac OS 9.2

1 Open the data in the application, click [File], and then click "Print".

2 Check that the printer name has been selected.

3 Select "General".

4 Specify the print range and the number of copies to print, and then click the [Print] button.

The Data indicator of this machine flashes.

2
Note 
If the printer name does not appear in the list, select the printer from the Chooser window. For details, 
refer to "Selecting a printer" on page 3-9.

The Print dialog box differs depending on the application.

The settings can be saved by clicking the [Save Settings] button.
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5.2 Setting the printing functions
The functions of this machine such as sorting and folding can be set when printing from a computer. 
Depending on the operating system running on the connected computer, the setting procedure of this 
machine’s functions may differ.

Function list

The function list contains a summary of the main settings related to printing and printer driver support.

2
Note 
The function names in this list are based on those displayed by the PCL printer driver in Windows XP. 
In addition, the items and setting values displayed may differ depending on whether the options are 
installed or the settings are available.

Function Overview Printer driver

PCL Post
Script

Mac OS X Mac OS 9

Original Orienta-
tion

Specifies the orientation of the original 
document.

o o o o

Original Size Specifies the size of the original docu-
ment.

o o o o

Paper Size Specifies the output paper size. o o o

Zoom Specifies the enlargement and reduction 
ratio.

o o o o

Paper Tray Selects the paper tray for printing. o o o o

Paper Type Selects the paper type for printing. o o o o

Output Method 
(job management)

For non-conventional printing, selects 
special output methods such as "Secure 
Print" or "Save in User Box".

o o o +
(Proof 
Print only)

User Authentica-
tion

Specifies the user name and password for 
user authentication.

o o o

Account Track Specifies the department name and pass-
word for account track authentication.

o o o

Copies Specifies the number of copies to print. o o o o

Collate Specifies whether to print multiple copies 
in sets.

o o o o

Offset When printing multiple copies, shifts the 
output position of each set.

o o o o

Combina-
tion/Poster Mode

Specifies whether to print multiple pages 
of text on one page with N in 1 printing, or 
print one sheet of an original document 
divided on multiple pages with Poster 
Mode printing.

o +
(N in 1 
printing 
only)

o +
(Poster 
Mode on-
ly)

Skip Blank Pages Does not print blank pages in the data. o

Chapter Specifies the page to be printed on the 
front side.

o o o

Print Type Specifies duplex printing and booklet 
printing.

o o o o

Binding Direction Specifies the binding position. o o o o

Binding Margin Specifies the binding margin. o o

Image Shift Prints by shifting the entire print image. o o o

Staple Specifies stapling. o o o o

Punch Specifies hole punching. o o o o

Fold Specifies folding. o o o o

Saddle Stitch Specifies to saddle stitch a printed docu-
ment.

o o o o
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Output Tray Specifies the tray where to output the 
printed pages.

o o o o

Paper Arrange-
ment

Specifies the method for adjusting the 
binding position.

o o o

Front Cover Attaches a front cover page. o o o o

Back Cover Attaches a back cover page. o o o o

Per Page Setting Inserts paper between pages and switch-
es the paper and tray for each page.

o o o

Transparency In-
terleave

Outputs and inserts interleaves when 
printing overhead projector transparen-
cies.

o o o o

Watermark Prints a watermark (text stamp) on the 
page being printed.

o o

Create Overlay File Prints an original document on top of an 
overlay that was created separately.

o o

Copy Protect Prints a special pattern to prevent copy-
ing.

o o o

Date/Time Prints the date and time. o o o

Page Number Prints the page number. o o o

Select Color Selects color printing and monochrome 
printing.

o +
(No two 
color se-
lection)

+
(No two 
color se-
lection)

+
(No two 
color se-
lection)

Quality Adjust-
ment

Adjusts the image quality. o o o o

Color Settings Prints with a quality suitable for the se-
lected original document.

o o o o

Pattern Specifies the graphic pattern details. o

Image Compres-
sion

Specifies the compression ratio for a 
graphic image.

o

Glossy Mode Prints using a gloss finish. o o o o

Use Printer Fonts Specifies the replacement of TrueType 
fonts with printer fonts.

o o

Function Overview Printer driver

PCL Post
Script

Mac OS X Mac OS 9
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Function overview

An overview of each function is summarized in this section.

Original orientation

You can specify "Portrait" or "Landscape" as the orientation of the page being printed.

Original size and paper size

You can specify the original document size and the output paper size. By specifying each size, you can 
specify the enlargement and reduction ratio.

2
Note 
Only the output paper sizes can be specified with the PostScript PPD driver for the Macintosh.

Portrait Landscape

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Page attributes (basic settings)" on page 9-7

Mac OS 9.2 "Page attributes (basic settings)" on page 8-6

Original size Output size

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Page attributes (basic settings)" on page 9-7

Mac OS 9.2 "Page attributes (basic settings)" on page 8-6
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Zoom (enlargement and reduction)

You can specify the enlargement or reduction ratio using numeric values.

Paper tray (paper source)

You can select the paper tray for printing from the "Paper Tray" drop-down list. When changing the paper 
type, you can select a paper tray according to the desired paper type.

Paper type

You can specify the paper type to be printed.

Reduced

Original
Enlarged

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Page attributes (basic settings)" on page 9-7

Mac OS 9.2 "Page attributes (basic settings)" on page 8-6

Tray

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Paper tray/Output tray" on page 9-20

Mac OS 9.2 "General (basic settings)" on page 8-8

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Paper tray/Output tray" on page 9-20
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Output method (job management)

You can select output methods such as "Secure Print", which requires a password to print, or "Save in User 
Box", which saves documents in a document folder.

User authentication

When the authentication settings have been applied on this machine, you must enter the required user name 
and password.

Account track

You can specify this setting when this machine is operating in Account Track.

Collate and offset

You can print the complete document sets the specified number of times or each page the specified number 
of times.

By specifying offset, the output position can be shifted and output to the front and back for each copy. 
(Multiple paper sources are used when a shifting finisher is installed and when no finisher is installed.)

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Output method" on page 9-10

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Output method" on page 9-10

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Output method" on page 9-10

Collate Offset

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the basic tab settings" on page 6-7

Generic PostScript "Specifying the basic tab settings" on page 7-8

Mac OS X PostScript PPD "Output method" on page 9-10

Mac OS 9.2 "General (basic settings)" on page 8-8, and "Printer 
specific options (Finishing options 1 to 4)" on 
page 8-9
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Combination/Poster mode

You can specify whether to print multiple pages of text on one page with N in 1 printing, or print one sheet 
of an original document divided on multiple pages with Poster Mode printing.

N in 1 printing comes in handy when you want to reduce the number of output pages.

Poster Mode printing allows you want to enlarge the print size when large paper sizes are not available (PCL 
printer driver and Mac OS X printer driver only).

Skip blank pages (saving paper)

You can specify not to print blank pages in the data.

2in1

4in1 6in1

9in1 16in1

2 e 2 3 e 3 4 e 4

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the layout tab settings" on page 6-14

Generic PostScript "Specifying the layout tab settings" on page 7-15

Mac OS X PostScript PPD "Print dialog box" on page 9-4
"Layout/Finish" on page 9-16

Mac OS 9.2 "Layout (printing multiple pages on one page)" on 
page 8-9

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the layout tab settings" on page 6-14
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Chapter

You can specify the page you want to print on the front side when duplex printing or booklet printing.

Even if a specified page comes up to be printed on the back side in duplex printing or booklet printing, the 
specified page is moved and printed on the front side.

Print type (duplex printing/booklet printing)

You can print onto both sides of a page or in a booklet format (two facing pages or center binding). This 
comes in handy when you want to bind multiple-page documents.

The binding area can be specified by specifying the binding position.

Duplex printing

Booklet printing

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the layout tab settings" on page 6-14

Generic PostScript "Specifying the layout tab settings" on page 7-15

Mac OS X PostScript PPD "Layout/Finish" on page 9-16

Print data Printout Print data Printout

Left binding Top binding

Print data Printout

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the layout tab settings" on page 6-14

Generic PostScript "Specifying the layout tab settings" on page 7-15

Mac OS X PostScript PPD "Layout/Finish" on page 9-16

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9
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Image shift

You can specify whether to shift the entire print image according to the binding margins, then print. You can 
specify the shift direction and set the values for the print position. For duplex printing, the front side and back 
side of a page can be specified separately.

Stapling and hole punching

Documents can be stapled together or holes can be punched into the document.

By specifying the binding margin, you can specify the margin for stapling or hole punching.

2
Reminder 
The staple function is available only when the optional finisher is installed.

The hole punch function is available only when the punch kit is installed on the optional finisher.

Up shift

Right shiftLeft shift

Down shift

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the layout tab settings" on page 6-14

Generic PostScript "Specifying the layout tab settings" on page 7-15

Mac OS X PostScript PPD "Layout/Finish" on page 9-16

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9

Stapling Hole punching

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the finish tab settings" on page 6-17

Generic PostScript "Specifying the finish tab settings" on page 7-18

Mac OS X PostScript PPD "Layout/Finish" on page 9-16

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9
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Saddle stitch and fold

d-Color MF550:
You can specify whether to fold a printed document in half or in three, or to fold a printed document in half 
and to saddle stitch it with staples.

2
Reminder 
The saddle stitch function and fold function are available only when optional finisher FS-608 is installed.

d-Color MF450:
You can specify whether to fold a printed document in half, or to fold a printed document in half and to saddle 
stitch it with staples.

2
Reminder 
The saddle stitch function and fold function are available only when optional saddle stitcher is installed.

d-Color MF550/MF450:

Half-fold Tri-fold Saddle stitch

Half-fold Saddle stitch

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the finish tab settings" on page 6-17

Generic PostScript "Specifying the finish tab settings" on page 7-18

Mac OS X PostScript PPD "Layout/Finish" on page 9-16

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9
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Paper arrangement

When printing a document with duplex printing, you can specify whether to adjust the binding position with 
"Prioritize Arranging Papers", which prints after all the print data is received, or with "Prioritize Productivity", 
which prints the data simultaneously as it is received.

Cover mode and transparency interleave

A front cover and back cover can be added and interleaves can be inserted between overhead projector 
transparencies.

Per page setting

You can specify to have paper inserted between pages, and specify the simplex or duplex print type and the 
paper to be printed for each page.

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the finish tab settings" on page 6-17

Generic PostScript "Specifying the finish tab settings" on page 7-18

Mac OS X PostScript PPD "Layout/Finish" on page 9-16

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9

Front cover Back cover

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the cover mode tab settings" on 
page 6-19

Generic PostScript "Specifying the cover mode tab settings" on 
page 7-20

Mac OS X PostScript PPD "Cover mode/Transparency interleave" on page 9-22

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the cover mode tab settings" on 
page 6-19

Generic PostScript "Specifying the cover mode tab settings" on 
page 7-20

Mac OS X PostScript PPD "Per page setting" on page 9-23
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Watermark

You can print a watermark (text stamp) on the page being printed.

Watermark

Overlay

You can print an original document on top of overlay data that was created separately.

Overlay

Copy protect

You can print a special pattern on an entire page while printing.

When the pattern on the printed page is copied, the characters embedded in the pattern appear to prevent 
an illegal copy.

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the stamp/composition tab settings" on 
page 6-21

Generic PostScript "Specifying the stamp/composition tab settings" on 
page 7-22

Created dataForm data

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the stamp/composition tab settings" on 
page 6-21

Generic PostScript "Specifying the stamp/composition tab settings" on 
page 7-22

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the stamp/composition tab settings" on 
page 6-21

Generic PostScript "Specifying the stamp/composition tab settings" on 
page 7-22

Mac OS X PostScript PPD "Stamp/Composition" on page 9-25
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Date/Time and page number

You can print the date, time, or page numbers on a document.

Quality adjustment

You can adjust the image quality.

Use printer fonts (substitute fonts)

You can specify whether to replace the TrueType fonts with printer fonts.

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the stamp/composition tab settings" on 
page 6-21

Generic PostScript "Specifying the stamp/composition tab settings" on 
page 7-22

Mac OS X PostScript PPD "Stamp/Composition" on page 9-25

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the quality tab settings" on page 6-29

Generic PostScript "Specifying the quality tab settings" on page 7-30

Mac OS X PostScript PPD "Quality" on page 9-30

Mac OS 9.2 "Printer specific options (Finishing options 1 to 4)" on 
page 8-9

Operating system Printer driver Refer to

Windows Generic PCL "Specifying the quality tab settings" on page 6-29

Generic PostScript "Specifying the quality tab settings" on page 7-30

Mac OS 9.2 PostScript PPD "PostScript options" on page 8-7
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5.3 Specifying the printer driver basic settings
The settings specified for the functions of this machine when printing can only be applied while using the 
application. When the application is quit, the settings return to their default settings.

When registering the settings, change the printer driver basic settings (default settings) or use the function 
for saving settings.

For Windows

The functions of this machine that can be used when printing can be specified in the printer driver setup 
dialog box, which can be displayed from the Printers window (for Windows XP/Server 2003, Printers and 
Faxes window).

Settings specified in the printer driver setup dialog box displayed using the procedure described below will 
be applied when printing from any application.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 For Windows 2000/XP/Server 2003, right-click the icon of the installed printer, and then click "Printing 
Preferences".
For Windows 4.0, right-click the icon of the installed printer, and then click "Document Defaults".

The following printer driver setting dialog box appears.

PCL driver
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PostScript driver

2
Note 
For the settings that can be specified with each printer driver, refer to the following:
Generic PCL Driver: "Setting up the PCL driver (Windows)" on page 6-3
Generic PostScript Driver: "Setting up the PostScript driver (Windows)" on page 7-3

Use each tab in the dialog box to set up the printer driver.

To specify custom settings, click Print in the application, and then click the [Properties] or the 
[Preferences] button in the Print dialog box. The settings specified in the Print dialog box apply only to 
the current file.

For the function for saving settings, refer to the follow:
Generic PCL Driver: "Saving the driver settings" on page 6-36
Generic PostScript Driver: "Saving the driver settings" on page 7-37
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For Macintosh

The functions of this machine that can be used when printing can be specified in the Print dialog box or the 
Page Setup dialog box.

The settings can only be applied while using the application. When the application is quit, the settings return 
to their default settings.

To specify the settings, save the settings in the printer driver dialog box.

For Mac OS X

In the Print dialog box, save the settings from the "Presets" function.

For saving the settings, refer to "Saving the driver settings" on page 9-32.

In the Page Setup dialog box, save the settings by selecting "Save as Default" from "Settings".

2
Note 
For details on the settings that can be specified in the printer driver, refer to "Setting up the PPD driver 
(Mac OS X)" on page 9-3.
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For Mac OS 9.x

In the Print dialog box, save the settings by clicking the [Save Settings] button.

2
Note 
The settings cannot be saved from the Page Setup dialog box.

"General" cannot be saved from the Print dialog box.

For details on the settings that can be specified in the printer driver, refer to "Setting up the PPD driver 
(Mac OS 9.2)" on page 8-3.
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6 Setting up the PCL driver 
(Windows)
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6 Setting up the PCL driver (Windows)

6.1 Settings

Common settings

The following describes the common settings and buttons that are displayed on all tabs.

2
Note 
To enable any installed options, you must specify the Device Option settings. For details, refer to 
"Specifying the configure tab settings" on page 6-32.

Button Function

OK Click this button to close the dialog box and apply any settings that have been 
changed.

Cancel Click this button to cancel any settings that have been changed and close the dia-
log box.

Help Click this button to display the help for each item on the currently displayed dialog 
box.

Add (Favorite Setting) Click this button to save the current settings and to view them at a later time.

Edit (Favorite Setting) Click this button to change the saved settings.

Default Click this button to return the settings to their defaults, which were selected when 
the driver was installed.

View When the [Paper View] button is clicked, a preview of the page layout as specified 
in the current settings is displayed and a preview image of the print job can be 
checked.
When the [Printer View] button is clicked, a printer figure is displayed showing any 
options, such as the paper tray, that are installed on this machine.

Paper Printer
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Basic tab

Layout tab

Finish tab

Item Function

Original Orientation Specifies the orientation of the original document.

Original Size Specifies the size of the original document.

Paper Size Specifies the output paper size. Automatically enlarges or reduces when the Orig-
inal Size setting is changed.

Zoom Specifies the enlargement and reduction ratio.

Paper Tray Selects the paper tray for printing.

Paper Type Selects the paper type for printing.

Output Method For non-conventional printing, selects special output methods such as "Secure 
Print" or "Save in User Box".

[User Settings] Specifies the ID and password, or the file name and box number when performing 
"Secure Print" or "Save in User Box".

[Authentication/Account Track] Specifies the user name and password when performing user authentication, and 
the department name and password when performing account track on this ma-
chine.

Copies Specifies the number of copies to print.

Collate Specifies whether to print multiple copies in sets.

Offset When printing multiple copies, shifts the output position of each set.

Paper Settings for Each Tray Specifies the paper type for each paper tray.

Item Function

Combination Prints multiple pages on one page, or prints one sheet of an original document di-
vided on multiple pages. Details can be specified by clicking the [Combination De-
tails] button.

Rotate 180 Prints the image rotated 180°.

Skip Blank Pages Does not print blank pages in the data.

Chapter Specifies the page to be printed on the front side.

Print Type Specifies duplex printing and booklet printing.

Binding Direction Specifies the binding position.

Binding Margin Specifies the binding margin. Click the [Binding Margin Settings] button to specify 
the margin values.

Image Shift Prints by shifting the entire print image. Click the [Image Shift Settings] button to 
specify the image shift values.

Item Function

Staple Specifies stapling.

Saddle Stitch Specifies to saddle stitch a printed document.

Punch Specifies hole punching.

Fold Specifies folding.

Output Tray Specifies the tray where to output the printed pages.

Paper Arrangement Specifies the method for adjusting the binding position.
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Cover mode tab

Stamp/Composition tab

Quality tab

Other tab (d-Color MF450)

Item Function

Front Cover Attaches a front cover page.

Front Cover Tray Selects the paper tray for the front cover.

Back Cover Attaches a back cover page.

Back Cover Tray Selects the paper tray for the back cover.

Per Page Setting Inserts paper between pages and switches the paper and tray for each page.

Transparency Interleave Outputs and inserts interleaves when printing overhead projector transparencies.

Interleave Tray Selects the input tray for the transparency interleaves.

Item Function

Watermark Prints a watermark (text stamp) on the page being printed. Watermarks can be 
added, changed, or deleted by clicking the [Edit] button.

Create Overlay File Prints an original document on top of an overlay that was created separately.

Copy Protect Prints a special pattern to prevent copying.

Date/Time Prints the date and time.

Page Number Prints the page number.

Item Function

Select Color Specifies the color for printing.

Quality Adjustment Adjusts the image quality. You can select "Simple" to adjust entire documents or 
"Detail" to adjust the text, photos, figures, tables, and graphs in the document.

Color Settings Prints with a quality suitable for the selected original document.

Pattern Specifies the graphic pattern details.

Image Compression Specifies the compression ratio for a graphic image.

Glossy Mode Prints with a gloss.

Font Set-
tings

Download Font 
Format

Selects whether the fonts are downloaded to the printer as bitmap or outline.

Use Printer Fonts Selects whether to use TrueType fonts or the printer fonts when printing.

Item Function

Excel Job Control Controls jobs so that they are not separated when printing in Microsoft Excel.

Remove White Back-ground Removes the white background when creating an overlay file with Microsoft
PowerPoint. If this check box is cleared, the background is not removed and the 
overlay file is created according to the orig-inal document data.

Driver Version Info Displays the version information of the printer driver.
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Configure tab

2
Note 
To display the Configure tab in Windows 2000/XP/NT 4.0/Server 2003, right-click the icon of the 
installed printer, and then click "Properties".

You cannot use the "Acquire Device Information" function if you are not connected to or able to 
communicate with this machine.

Settings tab

2
Note 
To display the Settings tab in Windows 2000/XP/NT 4.0/Server 2003, right-click the icon of the installed 
printer, and then click "Properties".

Item Function

Device Option Specifies the status of the options that are installed on this machine and the status 
of the user authentication and account track functions. Specify the status of each 
item from the "Setting" drop-down list.

Paper Tray Information Shows the paper type specified for each tray. Click the [Paper Tray Settings] but-
ton to specify the settings for each paper tray.

Acquire Device Information Communicates with this machine to read the status of the installed options.

Acquire Settings Specifies the status of the connection that executes getting the option informa-
tion.

Software Tools Starts up software tools such as Web Connection.

Item Function

d-Color MF450: EMF Spool When using an original system environment, select this check box if a metafile 
(EMF) spool is required.

Display Constraint Message Displays a message when functions that cannot be specified at the same time 
were enabled from the printer driver.

Display paper set in Print Server 
Properties.

Uses the paper that was added in [Server Properties] of the printer folder.

Verify Authentication settings 
before printing

Verifies the authentication settings for this machine before printing and displays a 
message if the settings are not compatible.

Popup Authentication Dialog 
when printing

Displays the User Authentication/Account Track dialog box when a print job is 
specified to enter the user name and department name.

Save Custom Size Saves the custom paper sizes.
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6.2 Specifying the basic tab settings

Printing to suit the paper size

You can enlarge or reduce documents created when printing to match the output paper size.

1 Click the Basic tab.

2 From the "Original Size" and "Paper Size" drop-down lists, select the desired settings.

– You can also specify any enlargement or reduction ratio in the "Zoom" box.

2
Note 
To print on paper sizes other than the standard sizes, be sure to set the custom paper sizes in Custom 
Size Settings first.
When "W" is selected for each standard paper size from the printer driver, the data can be centered 
and printed.
For example, if A4 size data is created and you want to center and print on A3 size paper, select "A4W" 
as the paper size and "Tray 1" or "Bypass Tray" as the paper tray from the printer driver.
To print, load A3 size paper in the tray ("Tray 1" or "Bypass Tray") of this machine that was specified 
from the printer driver, and then specify the settings described below from [Basic (Paper)] – [Change 
Tray Settings] – [Wide Paper] in the control panel. 
Select "A4W".
Enter the A3 paper size (420.0 e 297.0) in [Change Size].
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Specifying a custom size

When printing on paper of a custom size, you can select a preregistered custom paper size or specify a paper 
size value as described below.

1 From the "Original Size" or the "Paper Size" drop-down list, select "Custom Size".

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

– Width: Specifies the width of the custom paper size according to the selected measurement unit.
– Length: Specifies the length of the custom paper size accordi
– ng to the selected measurement unit.
– Unit: Selects the measurement unit that specifies the size.

3 Click the [OK] button.

2
Note 
For custom sizes that are used often, it comes in handy if you add them to the paper size list. Add a 
custom paper size from the Settings tab. For details, refer to "Specifying the settings tab settings" on 
page 6-34.

d-Color MF450: If using banner paper, specify the size of the banner paper in Custom Size. For details, 
refer to "Printing on banner paper (d-Color MF450)" on page 11-50.

Selecting the paper tray

You can specify the paper you want to use for printing by selecting the paper tray that contains the loaded 
paper.

1 Click the Basic tab.

2 From the "Paper Tray" drop-down list, select the desired paper tray.

2
Note 
If "Auto" is specified as the paper tray, you can select the paper type. If the paper tray setting is 
changed to a setting other than "Auto", the paper type is fixed to its preregistered setting. Specify a 
paper type by clicking the [Paper Settings for Each Tray] button. For details, refer to "Specifying the 
paper type for a paper tray" on page 6-9.
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Specifying the paper type for a paper tray

You can specify the paper type for a paper tray.

1 Click the Basic tab.

2 Click the [Paper Settings for Each Tray] button.

The Paper Settings for Each Tray dialog box appears.

3 From "Paper Type Settings", select the desired paper tray, and then select the paper type to be 
specified from the "Paper Type" drop-down list.

4 Click the [OK] button.

2
Note 
The current specified settings can be checked in "Device Status".

Click the [Restore Device Status] button to communicate with this machine and read the status of the 
settings specified on this machine. You cannot use this function if you are not connected to or able to 
communicate with this machine.

The paper type for a paper tray can also be specified from the Configure tab, and the paper size and 
paper orientation can be specified as well. For details, refer to "Specifying the configure tab settings" 
on page 6-32.

Specify "Duplex Side 2" to print on the back side of a page.
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Selecting the output method

Not only can you print directly, but you can select "Secure Print", which requires a password to print, or "Save 
in User Box", which saves data in the boxes that were created on the HDD.

1 Click the Basic tab.

2 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Saves the document to be printed in "Secure Print User Box" of this machine. When 

printing, you are required to enter the ID and password in this machine’s control panel. Select when 
printing highly confidential documents.

– Save in User Box: Saves the document to be printed in a box on this machine.
– Save in User Box and Print: Saves the document in a box and prints at the same time.
– Proof Print: After a part of the document has been printed, this machine stops printing temporarily. 

Select to avoid misprinting a large volume of print jobs.

Secure Print

If "Secure Print" was selected, enter the ID and password in the dialog box that appeared.

2
Note 
The ID and password that are required for "Secure Print" can be preregistered by clicking the [User 
Settings] button under "Output Method". If the ID and password are already registered, the dialog box 
to enter the ID and password does not appear when "Secure Print" is selected.

To print, specify "Secure Print Document Box" from the Box mode in this machine’s control panel, and 
then enter the ID and password. For details, refer to "Print job management" on page 11-36. For details 
on the box functions of this machine, refer to the User manual – Box Operations.

When password rules are enabled on this machine, the passwords that can be used for secured printing 
are limited and the jobs are deleted when a password that does not comply with the password rule is 
entered. For the password rules, refer to the User manual – Copy Operations.
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Save in User Box

When "Save in User Box" or "Save in User Box and Print" is selected, specify the file name to be saved and 
the box number for the save location in the dialog box that appears for entering the file name and box number.

2
Note 
The file name and box number that are required for "Save in User Box" can be preregistered by clicking 
the [User Settings] button under "Output Method". If the file name and box number are already 
registered, the dialog box to enter the file name and box number does not appear when "Save in User 
Box" is selected.

Be sure to create the box of the save location in advance with the box function of this machine. For 
details on the box functions of this machine, refer to the User manual – Box Operations.

When password rules are enabled on this machine, specify the box that was created on this machine.

Proof Print

When a print job is sent, this machine stops printing temporarily after part of the document has been printed. 
The remaining print job is stored in this machine as a print job. When printing multiple copies, you can print 
the remaining part of the print job after checking the print results.

2
Note 
To print the document, release the held document from the Job mode in this machine’s control panel. 
For details, refer to "Print job management" on page 11-36.
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Specifying the user authentication settings

If the user authentication settings have been specified on this machine, you must enter a user name and 
password.

2
Note 
If a job is printed using a user name or password that is not a registered account on this machine, or if 
a job is printed without selecting a user under "User Authentication", the operation is not authenticated 
by this machine and the job is canceled.

If the user authentication settings are specified on this machine and the authentication operation 
restriction function is in mode 2, the applicable user is locked and cannot be accessed if the 
authentication information is not entered correctly.

If the user authentication settings are not specified on the Configure tab, user authentication cannot be 
performed. If using the user authentication function, be sure to specify the settings on the Configure 
tab. For details, refer to "Specifying the configure tab settings" on page 6-32.

1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Select "Recipient User", and then enter the user name and password.

4 Click the [OK] button.

2
Note 
If this machine has been set to permit public users, the machine can be used without a user name and 
password.

If performing user authentication on a server, the server settings must be specified. Click the [Server 
Setting] button to select the server.

Click the [Verify] button to communicate with this machine and to check whether authentication can be 
performed with the user that was entered. You cannot use this function if you are not connected to or 
able to communicate with this machine.

If printing is not allowed, printing cannot be performed even when used by a registered user. For details 
on the user authentication function, consult the administrator of this machine.

If performing user authentication with an optional authentication unit (biometric type), enter the user 
name and password in step 3. For details, refer to the operation manual of the authentication unit 
(biometric type).
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Specifying the account track settings

If the account track settings have been specified on this machine, you must enter a department name and 
password.

2
Note 
If a job is printed using a department name or password that is not a registered account on this 
machine, or if a job is printed without "Account Track" selected, the operation is not authenticated by 
this machine and the job is canceled.

When the account track settings are specified on this machine, the authentication operation restriction 
function is in mode 2, and the authentication information is not entered correctly, the applicable 
account is locked and cannot be accessed.

If the account track settings are not specified on the Configure tab, account track cannot be performed. 
If using the account track function, be sure to specify the settings on the Configure tab. For details, refer 
to "Specifying the configure tab settings" on page 6-32.

1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Enter the department name and password.

4 Click the [OK] button.

2
Note 
Click the [Verify] button to communicate with this machine and to check whether authentication can be 
performed with the user that was entered. You cannot use this function if you are not connected to or 
able to communicate with this machine.

If printing is not allowed, printing cannot be performed even when used by a registered account. For 
details on the account track function, consult the administrator of this machine.
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6.3 Specifying the layout tab settings

Printing multiple pages on one page (N in 1, poster mode)

You can specify whether to print multiple pages of text on one page with N in 1 printing, or print one sheet 
of an original document divided on multiple pages with Poster Mode printing.

1 Click the Layout tab.

2 Select the "Combination" check box, and then specify the setting from the drop-down list.

– To change the "Border" and "Overlap width line" settings, click the [Combination Details] button, 
and then change the settings in the dialog box that appears.

2
Reminder 
When printing a job that contains pages of different sizes and orientations, images may be missing or 
overlapping when the document is printed.



d-Color MF550/MF450 6-15

Setting up the PCL driver (Windows) 6
Chapter

You can specify the page you want to print on the front side when duplex printing or booklet printing.

Even if a specified page comes up to be printed on the back side in duplex printing or booklet printing, the 
specified page is moved and printed on the front side.

1 Click the Layout tab.

2 Select the "Chapter" check box.

3 Enter the page number of the page you want to print on the front side.

2
Note 
When entering multiple page numbers, separate the page numbers with commas such as "2, 4, 6" or 
enter a page range using a hyphen such as "6-10".

The "Chapter" check box can only be selected when the duplex printing or the booklet printing setting 
is enabled.

Specifying duplex/booklet printing

You can print a document onto both sides of a page or in a booklet format (two facing pages). This comes in 
handy when you want to bind multiple-page documents.

1 Click the Layout tab.

2 From the "Print Type" drop-down list, select "2-Sided" or "Booklet".

2
Note 
The binding position can be specified from the "Binding Direction" drop-down list.

Setting the binding margin

Binding margins are added to the document before it is printed.

1 Click the Layout tab.

2 From the "Binding Direction" drop-down list, select the binding position.

3 Select the "Binding Margin" check box.
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4 To set the width of the binding margin, click the [Binding Margin Settings] button, and then specify the 
desired settings in the Binding Margin Settings dialog box that appears.

– Shift Mode: To add a binding margin, select how the image is to be shifted.
– Front Side/Back Side: Sets the binding margin values. By clearing the "Same value for front and 

back sides" check box, you can specify separate values for the front and back sides.
– Unit: Selects the measurement unit that specifies the size.

Shifting images

The entire print image of a document is shifted and then printed. You can use this function when you want to 
adjust the print position.

1 Click the Layout tab.

2 Select the "Image Shift" check box.

3 To set the image shift settings, click the [Image Shift Settings] button, and then specify the desired 
settings in the Image Shift Settings dialog box that appears.

– Unit: Selects the measurement unit that specifies the size.
– Front Side/Back Side: Specifies the shift direction and sets the values. By clearing the "Same value 

for Front and Back sides" check box, you can set separate values for the front and back sides.
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6.4 Specifying the finish tab settings

Stapling

Multiple-page documents can be stapled.

2
Reminder 
The staple function is available only when the optional finisher is installed.

1 Click the Finish tab.

2 Select the "Staple" check box.

3 From the drop-down list, specify the number of staples and the stapling position.

2
Note 
d-Color MF550: Specify the staple position noting the binding position specified in "Binding Direction".

d-Color MF450: The saddle stitch function is available only when optional saddle stitcher is installed.

Specifying the saddle stitch setting

You can specify to saddle stitch a printed document. By specifying the saddle stitch setting, printed 
documents can be folded in half and stapled.

2
Reminder 
d-Color MF550: The saddle stitch function is available only when optional finisher FS-608 is installed.
d-Color MF450: The saddle stitch function is available only when optional saddle stitcher is installed.

1 Click the Finish tab.

2 Select the "Saddle Stitch" check box.

2
Note 
The saddle stitch function cannot be specified when the staple, punch, or fold function is specified.
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Hole punching

Holes can be punched into the printed document.

2
Reminder 
The hole punch function is available only when the punch kit is installed on the optional finisher.

1 Click the Finish tab.

2 Select the "Punch" check box.

3 From the drop-down list, specify the number of punched holes.

2
Note 
The hole-punch position changes according to the binding position specified from "Binding Direction".

Folding

You can specify to fold a printed document.

2
Reminder 
d-Color MF550: The fold function is available only when optional finisher FS-608 is installed.

d-Color MF450: The fold function is available only when optional saddle stitcher is installed.

1 Click the Finish tab.

2 Select the "Fold" check box.

3 From the drop-down list, specify the folding condition.

2
Note 
The fold function cannot be specified when the staple, punch, or saddle stitch function is specified.

Specifying the output tray

You can specify the tray to which the printed document is output.

1 Click the Finish tab.

2 From the "Output Tray" drop-down list, specify the output tray.

Specifying the procedure for adjusting the binding position

You can specify the procedure for adjusting the binding position for duplex printing.

If "Prioritize Arranging Papers" is selected, all pages can be processed to a suitable quality by this machine 
because the binding position is adjusted after all the print data is received. If "Prioritize Productivity" is 
selected, the printing process is performed efficiently because the binding position is adjusted while the data 
is printed simultaneously as it is being received.

If you want to increase the print efficiency, select "Prioritize Productivity". If the desired binding position and 
width cannot be achieved, select "Prioritize Arranging Papers".

1 Click the Finish tab.

2 From the "Paper Arrangement" drop-down list, specify the processing method.
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6.5 Specifying the cover mode tab settings

Printing documents with a front cover/back cover

1 Click the Cover Mode tab.

2 Select the "Front Cover" and "Back Cover" check boxes.

3 From the "Front Cover" and "Back Cover" drop-down lists, select the desired print settings.
To print on the front cover and back cover, select "Print". To only add a blank page, select "Blank".

4 Select the paper tray that contains the loaded paper for the front cover and back cover.

Printing multiple pages

You can specify the print type and paper tray for each page. This comes in handy when you want to change 
the paper tray during a print job when printing multiple pages.

1 Click the Cover Mode tab.

2 Select the "Per Page Setting" check box.

3 From the "Per Page Setting" drop-down list, select the desired list name.

4 Click the [Edit List] button.

The Per Page Settings – Edit List dialog box for specifying the print settings appears.
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5 Click the [Add] button.

A new row for specifying the print settings is added to "Settings List".

6 Select the row that was added to the list, and then specify the print settings in "Add/Edit".

– Page Number: Enters the page number. When entering multiple page numbers, separate the page 
numbers with commas such as "2, 4, 6" or enter a page range using a hyphen such as "6-10".

– Print Type: Specifies Print Insert, Insert Blank Sheet, Print (1-Sided), and Print (2-Sided).
– Paper Tray: Specifies the paper tray.
– Staple: Specifies the number of staples and the stapling position.

7 Click the [OK] button.

2
Note 
To change existing print settings, select the desired row and change the settings. To delete existing 
print settings, select the desired row, and then click the [Delete] button.

Click the [Up] or the [Down] button to change the page number starting with the smallest page number.

The list name can be changed by clicking the [Edit List Name] button.

Printing with transparency interleaves

If "Transparency" is selected as the paper type, you can select the "Transparency Interleave" check box to 
enable the transparency interleave setting. By selecting the "Transparency Interleave" check box, overhead 
projector transparencies can be inserted between the printed pages.

1 Click the Cover Mode tab.

2 Select the "Transparency Interleave" check box.

3 From the "Transparency Interleave" drop-down list, specify the printing conditions.

4 From the "Transparency Interleave" drop-down list, select the paper tray that contains the paper to be 
used.
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6.6 Specifying the stamp/composition tab settings

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 From the list, select the watermark that you want to print.

Editing a watermark

You can change the fonts and position of the watermark and you can register a new one.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 Click the [Edit] button under "Watermark".

The Edit Watermark dialog box appears.

4 To create a watermark, click the [Add] button.
To change a watermark, select the watermark from the "Current Watermark" list.

5 Specify settings for the following:
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– Watermark Name: Enters the name of the watermark.
– Watermark Text: Enters the text to be printed as a watermark.
– [Add]: Click to create a new watermark.
– [Delete]: Click to delete the selected watermark.
– Position: Specifies the vertical and horizontal positions. The watermark position can also be 

specified by using the horizontal and vertical sliders in the dialog box.
– Text Angle: Specifies the watermark print angle.
– Font Name: Specifies the font.
– Size: Specifies the size.
– Style: Specifies the font style.
– Frame: Specifies the frame style.
– Text Color: Specifies the watermark text color.
– Sharing: Specifies whether to register the watermark as public or private.
– Transparent: Prints the watermark as a transparent image.
– 1st Page Only: Prints the watermark on the first page only.
– Repeat: Prints several watermarks on a single page.

6 Click the [OK] button.

2
Note 
Up to 30 watermarks can be registered with the shared setting, and up to 20 watermarks can be 
registered with the private setting.

Only the administrator can select a setting under "Sharing".

Printing different original documents together (overlay)

An original document can be printed on top of the overlay data that was created separately. This function 
comes in handy when creating fax cover letters or form letters.

2
Note 
You must create and preregister the overlay file to be printed. For details, refer to "Editing an overlay 
file" on page 6-23.

1 Create the print data using any application.

2 From the [File] menu, select "Print".

3 Select this machine in "Printer Name", and then click the [Properties] button or the [Preferences] button.

4 Click the Stamp/Composition tab.

5 Select the "Print in Overlay" check box.
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6 From the list, select the overlay that you want to print.

7 Click the [Edit] button under "Print in Overlay".

The Edit Print In Overlay dialog box appears.

8 Specify the overlay printing method.

– Pages to Print: Specifies the pages to print.
– Overwrite: Specifies the sequence for printing the overlay on top of the original document.

9 Click the [OK] button.

The Stamp/Composition tab appears again.

10 Click the [OK] button.

The Print dialog box appears again.

11 Click the [Print] button.

The printing of the overlay is performed.

Editing an overlay file

To use an overlay, an overlay file must be created and added to the overlay file list. You can create and save 
a new overlay file by selecting the "Create Overlay File" check box, specifying the document that you want 
to create as an overlay file, then clicking the [Print] button on the Print dialog box. To add an existing overlay 
file that was created to the list, specify the file.
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Creating an overlay file

1 Create the overlay file data using any application.

2 From the [File] menu, select "Print".

3 Select this machine in "Printer Name", and then click the [Properties] button or the [Preferences] button.

4 Click the Stamp/Composition tab.

5 Select the "Create Overlay File" check box.

6 Click the [OK] button.

The Print dialog box appears again.

7 Click the [Print] button.

The dialog box to save the overlay file appears.

8 Specify the storage location for the overlay file, enter the file name in the "File Name" box, and then 
enter the overlay name or a comment in the "Overlay Name" text box.

9 Click the [Save] button.

Instead of executing a print, the overlay file is saved and is added to the list to be used for the next 
operation. The file extension is ".KFO".
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Registering an overlay file

1 Click the Stamp/Composition tab.

2 Click the [Edit] button under "Print in Overlay".

The Edit Print In Overlay dialog box appears.

3 Click the [Browse Files] button to open the overlay file.

The overlay file is added to the "Select Overlay File" list.

2
Note 
By clicking the [Delete] button in the Edit Print In Overlay dialog box, the selected overlay file can be 
deleted from the overlay file list. The file itself is not deleted.
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Printing with copy protection

You can print a special pattern on an entire page while printing.

When copying a printed page, the characters embedded in the pattern appear to prevent an illegal copy.

1 Click the Stamp/Composition tab.

2 Select the "Copy Protect" check box.

3 Click the [Edit] button under "Copy Protect".

The Edit Copy Protect dialog box appears.

4 Specify the copy protection type and the position.
Multiple print items can be specified.

– Characters: Embeds the selected character string in a pattern. A preregistered character string 
(common stamp) or a character string registered on this machine (registered stamp) can be 
specified.

– Date/Time: Embeds the selected date and time in a pattern. By clicking the [Edit] button under 
"Format", you can specify the display type or the time format.

– Serial Number: Embeds the serial number of this machine in a pattern.
– Distribution Control Number: Embeds the number of copies in a pattern when printing multiple 

copies. By clicking the [Edit] button under "Start Number", you can specify the start number or the 
display type.

– Job Number: Embeds the print job number in a pattern for documents that are automatically 
paginated.

– Text Size: Specifies the text size of a pattern.
– Angle: Specifies the pattern angle.
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5 Select the composition method for copy protection. 

Select "Copy Protect" to specify the desired results when copying, or simply select "Stamp Repeat". 
In addition, you can select the embedding conditions.

– Pattern: Specifies the embedding method of a pattern.
– Pattern Overwrite: Specifies the order for printing a pattern on the original document.
– Background Pattern: Specifies the pattern background.
– Text/Background Color: Specifies the pattern color. The density and color contrast can be specified 

by clicking the [Adjust Color] button.

6 Click the [OK] button.
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Printing the date and page numbers

You can print the date and page numbers on a document.

1 Click the Stamp/Composition tab.

2 Select the "Date/Time" or the "Page Number" check box. 
The "Date/Time" and "Page Number" check boxes can be selected at the same time.

3 Click the [Edit] button under "Page Number".

The Edit Date/Time/Page Number dialog box appears.

4 Specify the format and print position for the date, time, and page number.

– Format: Displays the format for the date and time to be printed. By clicking the [Edit] button, you 
can specify the display type or the time format.

– Pages to Print: Specifies the pages to print the date and time.
– Text Color: Specifies the text color to print.
– Print Position: Specifies the print position.
– Starting Page: Specifies the page to start printing the page number.
– Starting Page Number: Specifies the start number for printing the page number.
– Cover Mode: If cover pages are attached, specifies whether to print the page number on the front 

cover page or the back cover page.

5 Click the [OK] button.
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6.7 Specifying the quality tab settings

Adjusting the color and quality

1 Click the Quality tab.

2 Specify settings for the following:

Setting Description

Select Color Specifies the color for printing.
Full Color: Prints in color.
Grayscale: Prints in grayscale.
2 Color: Prints the two colors selected from the drop-down list.

Quality Adjustment Adjusts the image quality.
Simple: Adjusts the entire document.
Detail: Adjusts the text, photos, and charts of each object in a document.

Color Settings Specifies the contents of the original document. Prints with a quality suitable for 
the original document.
Document: Prints with a quality suitable for documents with many characters.
Photo: Prints with a quality suitable for photos.
DTP: Prints with a quality suitable for documents produced using DTP.
Web: Prints with a quality suitable for Web page printing.
CAD: Prints with a quality suitable for CAD data printing.

Resolution Displays the resolution. (The resolution cannot be changed on this machine.)

Pattern Selects the print pattern.

Image Compression Specifies the compression ratio for an image.

Glossy Mode Prints using a gloss finish.
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Font Settings

You can replace the TrueType fonts used in Windows with the printer fonts of this machine.

1 Click the Quality tab.

2 Click the [Font Settings] button.

3 Specify settings for the following:

– Download Font Format: Selects the TrueType font downloading method.
– Use Printer Fonts: Replaces the TrueType fonts with the printer fonts.

4 To use the printer fonts, change the fonts in "TrueType Font Substitution Table" as necessary.
From the list shown in the dialog box above, select the TrueType font that you want to replace, and then 
select the printer font from the "Printer Font to Use" drop-down list.

2
Note 
Using the printer fonts will shorten the printing time, however, there may be a difference in the screen 
display and the print results.

By selecting the TrueType font download method from the "Download Font Format" drop-down list, 
you can select the TrueType font type to download when downloading the TrueType fonts and not using 
the printer fonts. When using TrueType fonts, select the font type to be downloaded to the printer.
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6.8 Specifying the Other tab settings (d-Color MF450)

2
Note 
The “Excel Job Control” setting and the “Remove White Background” setting cannot be used with 
Windows XP Professional x64 or Windows Server 2003 x64.

Setting Description

Excel Job Control Controls jobs so that they are not separated when printing in Microsoft Excel.

Remove White Background Removes the white background when creating an overlay file with Microsoft 
PowerPoint. If this check box is cleared, the back-ground is not removed and the 
overlay file is created according to the original document data.

Driver Version Info Displays the version information of the printer driver.
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6.9 Specifying the configure tab settings

2
Note 
The information that is displayed differs depending on the options that are installed.

Selecting an option

The functions of this machine can be used from the printer driver if the installed options and the user 
authentication and account track functions are specified.

2
Reminder 
If the installed options and the user authentication and account track functions are not specified on the 
Configure tab, the option functions cannot be used from the printer driver. When installing options or 
using the authentication function, be sure to make the proper settings.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the Configure tab.

4 Select the options to be specified under "Device Option".

5 Select the status of the option that is installed from the "Setting" drop-down list.

2
Note 
Click the [Acquire Device Information] button to communicate with this machine and read the status of 
the settings specified on this machine. You cannot use this function if you are not connected to or able 
to communicate with this machine. The connection can be specified by clicking the [Acquire Settings] 
button.

d-Color MF450:
When the Mail Bin Kit is installed, you can assign output tray 1 and output tray 2 as mail bins. 
To assign the output destination of the mail bins, select “Bin Setting” from “Administrator Setting” – 
“System Setting” – “Output Setting” on the control panel.
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Specifying the paper tray

You can register the paper size, paper orientation, and paper type for the paper that is loaded in a paper tray.

2
Reminder 
If the paper loaded in this machine and the paper specified from the printer driver are different, printing 
cannot be performed correctly. Be sure to make the proper settings.

1 Click the Configure tab.

2 Click the [Paper Tray Settings] button.

The Paper Tray Settings dialog box appears.

3 Select the desired tray in "Paper Tray Information", and then specify the paper size, paper orientation, 
and paper type.

4 Click the [OK] button.

2
Note 
The paper type for a paper tray can also be specified from the Basic tab. For details, refer to "Specifying 
the basic tab settings" on page 6-7.

Specify "Duplex Side 2" to print on the back side of a page.

Starting up a software tool

You can start up tools such as Web Connection that can be used by this machine.

1 Click the Configure tab.

2 From the "Software Tools" drop-down list, select the function.

3 Click the [Start] button.
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6.10 Specifying the settings tab settings

Specifying the default settings

You can change the default settings for displaying the confirmation messages or the dialog box for entering 
the authentication settings.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the Settings tab.

4 Specify settings for the following:

– d-Color MF450: EMF Spool: When using an original system environment, select this check box if a 
metafile (EMF) spool is required.

– Display Constraint Message: Specifies whether to display a message when functions that cannot 
be specified at the same time were enabled from the printer driver.

– Display paper set in Print Server Properties: Specifies whether to use the paper that was added in 
[Server Properties] of the printer folder. 

– Verify Authentication settings before printing: Specifies whether to verify the authentication settings 
for this machine before printing. A message appears if the results verified are not compatible.

– Popup Authentication Dialog when printing: Displays the User Authentication/Account Track dialog 
box when a print job is specified to enter a user name or a department name.
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Registering custom paper sizes

You can register the custom paper sizes that you use often. The paper registered is shown in the paper size 
list and can be selected like the other paper sizes.

1 Click the Settings tab.

2 Click the [Save Custom Size] button.

The Save Custom Size dialog box appears.

3 Click the [Add] button.

The new paper size is added to "List of Custom Size".

4 Specify the paper name and size.

5 Click the [OK] button.

2
Note 
Up to 10 custom paper sizes can be registered.

Up to 16 characters can be entered in the "Paper Name" text box.

From the Save Custom Size dialog box, the selected custom paper size can be deleted by clicking the 
[Delete] button. To edit a custom paper size, select the custom paper size and change the paper name 
and paper size.
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6.11 Saving the driver settings
You can save the setting values of the changed driver and recall them as necessary.

Saving the driver settings

1 Change the driver settings from the Basic tab and the Layout tab.

2 Click the [Add] button next to the "Favorite Setting" drop-down list.

3 Specify settings for the following:

– Name: Enters the specified registration name.
– Icon: Specifies the icon. The settings can be registered even if the icon is not specified. 
– Sharing: Specifies whether to register the specified file as public or private.
– Comment: Enters the detailed description of the specified file, if necessary.

4 Click the [OK] button.

The specified settings are registered in the "Favorite Setting" drop-down list.
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2
Note 
Up to 30 shared settings and up to 20 private settings can be registered.

Up to 30 characters can be entered in the "Name" text box. Up to 255 characters can be entered in the 
"Comment" text box.

Only the administrator can select a setting under "Sharing".

The settings that were specified can also be saved (exported) to a file. For details, refer to "Importing 
and exporting the driver settings" on page 6-38.

Recalling the settings

You can select the settings to recall from the "Favorite Setting" drop-down list on the Printing Preferences 
dialog box.

The setting values are recalled, and the settings for the printer driver are changed.

Editing the settings

You can edit the recalled function items such as the specified names and comments. 

1 In the Printing Preferences dialog box, click the [Edit] button next to the "Favorite Setting" drop-down 
list.

2 From the list, select the specified name that you want to change, and then change the setting.
To delete a setting, click the [Delete] button.
To switch the order displayed, click the [Up] button or the [Down] button.

3 Click the [Option] button, select the check box of the function that you want to recall, and then click the 
[OK] button.
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4 Click the [OK] button.

2
Note 
The specified settings of the driver functions cannot be changed.

Importing and exporting the driver settings

You can also save (export) or read (import) the settings that were specified to a file. This comes in handy when 
you want to use the same settings on another computer.

1 In the Printing Preferences dialog box, click the [Edit] button next to the "Favorite Setting" drop-down 
list.

2 From the list, select the specified name that you want to export, and then click the [Export] button.

The dialog box to save the specified file appears.

3 Specify the location to save the file and enter the file name.

4 Click the [Save] button.

The specified file is created. The file extension is ".KSF".

2
Note 
To read the specified file that was saved in the "Favorite Setting" drop-down list, click the [Import] 
button and specify the file.
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7 Setting up the PostScript driver (Windows)

7.1 Settings

Common settings

The following describes the common settings and buttons that are displayed on all tabs.

2
Note 
To enable any installed options, you must specify the Device Option settings. For details, refer to 
"Specifying the configure tab settings" on page 7-33.

Button Function

OK Click this button to close the dialog box and apply any settings that have been 
changed.

Cancel Click this button to cancel any settings that have been changed and close the dia-
log box.

Help Click this button to display the help for each item on the currently displayed dialog 
box.

Add (Favorite Setting) Click this button to save the current settings and to view them at a later time.

Edit (Favorite Setting) Click this button to change the saved settings.

Default Click this button to return the settings to their defaults, which were selected when 
the driver was installed.

View When the [Paper View] button is clicked, a preview of the page layout as specified 
in the current settings is displayed and a preview image of the print job can be 
checked.
When the [Printer View] button is clicked, a printer figure is displayed showing any 
options, such as the paper tray, that are installed on this machine.

PrinterPaper
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Basic tab

Layout tab

Finish tab

Item Function

Original Orientation Specifies the orientation of the original document.

Original Size Specifies the size of the original document.

Paper Size Specifies the output paper size. Automatically enlarges or reduces when the 
Original Size setting is changed.

Zoom Specifies the enlargement and reduction ratio.

Paper Tray Selects the paper tray for printing.

Paper Type Selects the paper type for printing.

Output Method For non-conventional printing, selects special output methods such as "Secure 
Print" or "Save in User Box".

[User Settings] Specifies the ID and password, or the file name and box number when perform-
ing "Secure Print" or "Save in User Box".

[Authentication/Account Track] Specifies the user name and password when performing user authentication, 
and the department name and password when performing account track on this 
machine.

Copies Specifies the number of copies to print.

Collate Specifies whether to print multiple copies in sets.

Offset When printing multiple copies, shifts the output position of each set.

Paper Settings for Each Tray Specifies the paper type for each paper tray.

Item Function

Combination Prints multiple pages on one page. Details can be specified by clicking 
the [Combination Details] button.

Rotate 180 Prints the image rotated 180°.

Chapter Specifies the page to be printed on the front side.

Print Type Specifies duplex printing and booklet printing.

Binding Direction Specifies the binding position.

Binding Margin Specifies the binding margin. Click the [Binding Margin Settings] button 
to specify the margin values.

Image Shift Prints by shifting the entire print image. Click the [Image Shift Settings] 
button to specify the image shift values.

Item Function

Staple Specifies stapling.

Saddle Stitch Specifies to saddle stitch a printed document.

Punch Specifies hole punching.

Fold Specifies folding.

Output Tray Specifies the tray where to output the printed pages.

Paper Arrangement Specifies the method for adjusting the binding position.
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Cover mode tab

Stamp/Composition tab

Quality tab

Other tab (d-Color MF450)

Advanced tab

Item Function

Front Cover Attaches a front cover page.

Front Cover Tray Selects the paper tray for the front cover.

Back Cover Attaches a back cover page.

Back Cover Tray Selects the paper tray for the back cover.

Per Page Setting Inserts paper between pages and switches the paper and tray for each 
page.

Transparency Interleave Outputs and inserts interleaves when printing overhead projector trans-
parencies.

Interleave Tray Selects the input tray for the transparency interleaves.

Item Function

Watermark Prints a watermark (text stamp) on the page being printed. Watermarks 
can be added, changed, or deleted by clicking the [Edit] button.

Create Overlay File Prints an original document on top of an overlay that was created sepa-
rately.

Copy Protect Prints a special pattern to prevent copying.

Date/Time Prints the date and time.

Page Number Prints the page number.

Item Function

Select Color Specifies the color for printing.

Quality Adjustment Adjusts the image quality. You can select "Simple" to adjust entire doc-
uments or "Detailed" to adjust the text, photos, and charts in the docu-
ment.

Color Settings Prints with a quality suitable for the selected original document.

Glossy Mode Prints with a gloss.

Font Settings Download Font 
Format

Selects whether the fonts are downloaded to the printer as bitmap or out-
line.

Use Printer Fonts Selects whether to use TrueType fonts or the printer fonts when printing.

Item Function

Excel Job Control Controls jobs so that they are not separated when printing in Microsoft Excel.

Driver Version Info Displays the version information of the printer driver.

Item Function

Advanced Printing Features Specifies whether to enable detailed print functions (booklet).

PostScript Output Option Specifies the PostScript file output format.

Send PostScript Error Handler Specifies whether to print an error report when a PostScript error occurs.

Mirrored Output Reverses horizontally, then prints.

PostScript Pass through Allows applications to print directly without using a GDI.
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Device settings tab

2
Note 
To display the Device Settings tab in Windows 2000/XP/Server 2003, right-click the icon of the installed 
printer, and then click "Properties".

Configure tab

2
Note 
To display the Configure tab in Windows 2000/XP/Server 2003, right-click the icon of the installed 
printer, and then click "Properties".

You cannot use the [Acquire Device Information] function if you are not connected to or able to 
communicate with this machine.

Item Function

Font Substitution Table Specifies the replacement of TrueType fonts with printer fonts.

Available PostScript Memory Specifies the usable PostScript memory size.

Output Protocol Specifies the protocol for transmitting to the printer.

Send CTRL-D Before Each Job Specifies whether to reset printer before printing.

Send CTRL-D After Each Job Specifies whether to reset printer after printing.

Convert Gray Text to PostScript Gray Specifies whether to convert gray text in a document to PostScript gray.

Convert Gray Graphics to PostScript Gray Specifies whether to convert gray graphics in a document to PostScript 
gray.

Add Euro Currency Symbol to PostScript 
Fonts

Specifies whether to convert the Euro currency symbol in a document to 
PostScript fonts.

Job Timeout Printer stops printing when a print job is not completed within the spec-
ified time.

Wait Timeout Printer stops printing when the printer does not receive data within the 
specified time from when the job was sent.

Minimum Font Size to Downloaded as 
Outline

Specifies the minimum font size (pixels) when downloading TrueType 
fonts as outline fonts. Fonts smaller than the minimum specified size are 
downloaded as bitmap fonts.

Maximum Font Size to Download as Bit-
map

Specifies the maximum font size (pixels) when downloading TrueType 
fonts as bitmap fonts. Fonts larger than the maximum specified size are 
downloaded as outline fonts.

Item Function

Device Option Specifies the status of the options that are installed on this machine and 
the status of the user authentication and account track functions. Specify 
the status of each item from the "Setting" drop-down list.

Paper Tray Information Shows the paper type specified for each tray. Click the [Paper Tray Set-
tings] button to specify the settings for each paper tray.

Acquire Device Information Communicates with this machine to read the status of the installed op-
tions.

Acquire Settings Specifies the status of the connection that executes getting the option in-
formation.

Software Tools Starts up software tools such as Web Connection.
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Settings tab

2
Note 
To display the Settings tab in Windows 2000/XP/Server 2003, right-click the icon of the installed printer, 
and then click "Properties".

Item Function

Display Constraint Message Displays a message when functions that cannot be specified at the same 
time were enabled from the printer driver.

Display paper set in Print Server Proper-
ties.

Uses the paper that was added in [Server Properties] of the printer folder.

Verify Authentication settings before 
printing

Verifies the authentication settings for this machine before printing and 
displays a message if the settings are not compatible.

Popup Authentication Dialog when print-
ing

Displays the User Authentication/Account Track dialog box when a print 
job is specified to enter the user name and department name.
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7.2 Specifying the basic tab settings

Printing to suit the paper size

You can enlarge or reduce documents created when printing to match the output paper size.

1 Click the Basic tab.

2 From the "Original Size" and "Paper Size" drop-down lists, select the desired settings.

– You can also specify any enlargement or reduction ratio in the "Zoom" box.

2
Note 
To print on paper sizes other than the standard sizes, be sure to set the custom paper sizes in Custom 
Size Settings first.

When "W" is selected for each standard paper size from the printer driver, the data can be centered 
and printed.

For example, if A4 size data is created and you want to center and print on A3 size paper, select "A4W" 
as the paper size and "Tray 1" or "Bypass Tray" as the paper tray from the printer driver.

To print, load A3 size paper in the tray ("Tray 1" or "Bypass Tray") of this machine that was specified 
from the printer driver, and then specify the settings described below from [Basic (Paper)] – [Change 
Tray Settings] – [Wide Paper] in the control panel.
"A4W".
Enter the A3 paper size (420.0 e 297.0) in [Change Size].
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Specifying a custom size

When printing on paper of a custom size, you can specify the paper size values by following the procedure 
described below.

1 From the "Original Size" or the "Paper Size" drop-down list, select "Custom Size".

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

– Width: Specifies the width of the custom paper size according to the selected measurement unit.
– Length: Specifies the length of the custom paper size according to the selected measurement unit.
– Unit: Selects the measurement unit that specifies the size.

3 Click the [OK] button.

2
Note 
d-Color MF450: If using banner paper, specify the size of the banner paper in Custom Size. For details, 
refer to "Printing on banner paper (d-Color MF450)" on page 11-50.

Selecting the paper tray

You can specify the paper you want to use for printing by selecting the paper tray that contains the loaded 
paper.

1 Click the Basic tab.

2 From the "Paper Tray" drop-down list, select the desired paper tray.

2
Note 
If "Auto" is specified as the paper tray, you can select the paper type. If the paper tray setting is 
changed to a setting other than "Auto", the paper type is fixed to its preregistered setting. Specify a 
paper type by clicking the [Paper Settings for Each Tray] button. For details, refer to "Specifying the 
paper type for a paper tray" on page 7-10.
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Specifying the paper type for a paper tray

You can specify the paper type for a paper tray.

1 Click the Basic tab.

2 Click the [Paper Settings for Each Tray] button.

The Paper Settings for Each Tray dialog box appears.

3 From "Paper Type Settings", select the desired paper tray, and then select the paper type to be 
specified from the "Paper Type" drop-down list.

4 Click the [OK] button.

2
Note 
The current specified settings can be checked in "Device Status".

Click the [Restore Device Status] button to communicate with this machine and read the status of the 
settings specified on this machine. You cannot use this function if you are not connected to or able to 
communicate with this machine.

The paper type for a paper tray can also be specified from the Configure tab, and the paper size and 
paper orientation can be specified as well. For details, refer to "Specifying the configure tab settings" 
on page 7-33.

Specify "Duplex Side 2" to print on the back side of a page.



d-Color MF550/MF450 7-11

Setting up the PostScript driver (Windows) 7
Selecting the output method

Not only can you print directly, but you can select "Secure Print", which requires a password to print, or "Save 
in User Box", which saves data in the boxes that were created on the HDD.

1 Click the Basic tab.

2 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Saves the document to be printed in "Secure Print User Box" of this machine. When 

printing, you are required to enter the ID and password in this machine’s control panel. Select when 
printing highly confidential documents.

– Save in User Box: Saves the document to be printed in a box on this machine.
– Save in User Box and Print: Saves the document in a box and prints at the same time.
– Proof Print: After a part of the document has been printed, this machine stops printing temporarily. 

Select to avoid misprinting a large volume of print jobs.

Secure Print

If "Secure Print" was selected, enter the ID and password in the dialog box that appeared.

2
Note 
The ID and password that are required for "Secure Print" can be preregistered by clicking the [User 
Settings] button under "Output Method". If the ID and password are already registered, the dialog box 
to enter the ID and password does not appear when "Secure Print" is selected.

To print, specify "Secure Print Document Box" from the Box mode in this machine’s control panel, and 
then enter the ID and password. For details, refer to "Print job management" on page 11-36. For details 
on the box functions of this machine, refer to the User manual – Box Operations.

When password rules are enabled on this machine, the passwords that can be used for secured printing 
are limited and the jobs are deleted when a password that does not comply with the password rule is 
entered. For the password rules, refer to the User manual – Copy Operations.
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Save in User Box

When "Save in User Box" or "Save in User Box and Print" is selected, specify the file name to be saved and 
the box number for the save location in the dialog box that appears for entering the file name and box number.

2
Note 
The file name and box number that are required for "Save in User Box" can be preregistered by clicking 
the [User Settings] button under "Output Method". If the file name and box number are already 
registered, the dialog box to enter the file name and box number does not appear when "Save in User 
Box" is selected.

Be sure to create the box of the save location in advance with the box function of this machine. For 
details on the box functions of this machine, refer to the User manual – Box Operations.

When password rules are enabled on this machine, specify the box that was created on this machine.

Proof Print

When a print job is sent, this machine stops printing temporarily after part of the document has been printed. 
The remaining print job is stored in this machine as a print job. When printing multiple copies, you can print 
the remaining part of the print job after checking the print results.

2
Note 
To print the document, release the held document from the Job mode in this machine’s control panel. 
For details, refer to "Print job management" on page 11-36.
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Specifying the user authentication settings

If the user authentication settings have been specified on this machine, you must enter a user name and 
password.

2
Reminder 
If a job is printed using a user name or password that is not a registered account on this machine, or if 
a job is printed without selecting a user under "User Authentication", the operation is not authenticated 
by this machine and the job is canceled.

If the user authentication settings are specified on this machine and the authentication operation 
restriction function is in mode 2, the applicable user is locked and cannot be accessed if the 
authentication information is not entered correctly.

If the user authentication settings are not specified on the Configure tab, user authentication cannot be 
performed. If using the user authentication function, be sure to specify the settings on the Configure 
tab. For details, refer to "Specifying the configure tab settings" on page 7-33.

1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Select "Recipient User", and then enter the user name and password.

4 Click the [OK] button.

2
Note 
If this machine has been set to permit public users, the machine can be used without a user name and 
password.

If performing user authentication on a server, the server settings must be specified. Click the [Server 
Setting] button to select the server.

Click the [Verify] button to communicate with this machine and to check whether authentication can be 
performed with the user that was entered. You cannot use this function if you are not connected to or 
able to communicate with this machine.

If printing is not allowed, printing cannot be performed even when used by a registered user. For details 
on the user authentication function, consult the administrator of this machine.

If performing user authentication with an optional authentication unit (biometric type), enter the user 
name and password in step 3. For details, refer to the operation manual of the authentication unit 
(biometric type).
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Specifying the account track settings

If the account track settings have been specified on this machine, you must enter a department name and 
password.

2
Reminder 
If a job is printed using a department name or password that is not a registered account on this 
machine, or if a job is printed without "Account Track" selected, the operation is not authenticated by 
this machine and the job is canceled.

When the account track settings are specified on this machine, the authentication operation restriction 
function is in mode 2, and the authentication information is not entered correctly, the applicable 
account is locked and cannot be accessed.

If the account track settings are not specified on the Configure tab, account track cannot be performed. 
If using the account track function, be sure to specify the settings on the Configure tab. For details, refer 
to "Specifying the configure tab settings" on page 7-33.

1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Enter the department name and password.

4 Click the [OK] button.

2
Note 
Click the [Verify] button to communicate with this machine and to check whether authentication can be 
performed with the user that was entered. You cannot use this function if you are not connected to or 
able to communicate with this machine.

If printing is not allowed, printing cannot be performed even when used by a registered account. For 
details on the account track function, consult the administrator of this machine.
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7.3 Specifying the layout tab settings

Printing multiple pages on one page (N in 1)

You can specify to print multiple pages of text on one page with N in 1 printing.

1 Click the Layout tab.

2 Select the "Combination" check box, and then specify the setting from the drop-down list.

– To change the "Border" settings, click the [Combination Details] button, and then change the 
settings in the dialog box that appears.

2
Reminder 
When printing a job that contains pages of different sizes and orientations, images may be missing or 
overlapping when the document is printed.
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Chapter

You can specify the page you want to print on the front side when duplex printing or booklet printing.

Even if a specified page comes up to be printed on the back side in duplex printing or booklet printing, the 
specified page is moved and printed on the front side.

1 Click the Layout tab.

2 Select the "Chapter" check box.

3 Enter the page number of the page you want to print on the front side.

2
Note 
When entering multiple page numbers, separate the page numbers with commas such as "2, 4, 6" or 
enter a page range using a hyphen such as "6-10".

The "Chapter" check box can only be selected when the duplex printing or the booklet printing setting 
is enabled.

Specifying duplex/booklet printing

You can print a document onto both sides of a page or in a booklet format (two facing pages). This comes in 
handy when you want to bind multiple-page documents.

1 Click the Layout tab.

2 From the "Print Type" drop-down list, select "2-Sided" or "Booklet".

2
Note 
The binding position can be specified from the "Binding Direction" drop-down list.

Setting the binding margin

Binding margins are added to the document before it is printed.

1 Click the Layout tab.

2 From the "Binding Direction" drop-down list, select the binding position.

3 Select the "Binding Margin" check box.

4 To set the width of the binding margin, click the [Binding Margin Settings] button, and then specify the 
desired settings in the Binding Margin Settings dialog box that appears.

– Shift Mode: To add a binding margin, select how the image is to be shifted.
– Front Side/Back Side: Sets the binding margin values. By clearing the "Same value for front and 

back sides" check box, you can specify separate values for the front and back sides.
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– Unit: Selects the measurement unit that specifies the size.

Shifting images

The entire print image of a document is shifted and then printed. You can use this function when you want to 
adjust the print position.

1 Click the Layout tab.

2 Select the "Image Shift" check box.

3 To set the image shift settings, click the [Image Shift Settings] button, and then specify the desired 
settings in the Image Shift Settings dialog box that appears.

– Unit: Selects the measurement unit that specifies the size.
– Front Side/Back Side: Specifies the shift direction and sets the values. By clearing the "Same value 

for Front and Back sides" check box, you can set separate values for the front and back sides.
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7.4 Specifying the finish tab settings

Stapling

Multiple-page documents can be stapled.

2
Reminder 
The staple function is available only when the optional finisher is installed.

1 Click the Finish tab.

2 Select the "Staple" check box.

3 From the drop-down list, specify the number of staples and the stapling position.

2
Note 
Specify the staple position noting the binding position specified in "Binding Direction".

Specifying the saddle stitch setting

You can specify to saddle stitch a printed document. By specifying the saddle stitch setting, printed 
documents can be folded in half and stapled.

2
Reminder 
The saddle stitch function is available only when optional finisher FS-608 is installed.

1 Click the Finish tab.

2 Select the "Saddle Stitch" check box.

2
Note 
d-Color MF550: The saddle stitch function cannot be specified when the staple, punch, or fold function 
is specified.

d-Color MF450: The saddle stitch function is available only when optional saddle stitcher is installed.
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Hole punching

Holes can be punched into the printed document.

2
Reminder 
The hole punch function is available only when the punch kit is installed on the optional finisher.

1 Click the Finish tab.

2 Select the "Punch" check box.

3 From the drop-down list, specify the number of punched holes.

2
Note 
The hole-punch position changes according to the binding position specified from "Binding Direction".

Folding

You can specify to fold a printed document.

2
Reminder 
d-Color MF550: The fold function is available only when optional finisher FS-608 is installed.

d-Color MF450: The fold function is available only when optional saddle stitcher is installed.

1 Click the Finish tab.

2 Select the "Fold" check box.

3 From the drop-down list, specify the folding condition.

2
Note 
The fold function cannot be specified when the staple, punch, or saddle stitch function is specified.

Specifying the output tray

You can specify the tray to which the printed document is output.

1 Click the Finish tab.

2 From the "Output Tray" drop-down list, specify the output tray.

Specifying the procedure for adjusting the binding position

You can specify the procedure for adjusting the binding position for duplex printing.

If "Prioritize Arranging Papers" is selected, all pages can be processed to a suitable quality by this machine 
because the binding position is adjusted after all the print data is received. If "Prioritize Productivity" is 
selected, the printing process is performed efficiently because the binding position is adjusted while the data 
is printed simultaneously as it is being received.

If you want to increase the print efficiency, select "Prioritize Productivity". If the desired binding position and 
width cannot be achieved, select "Prioritize Arranging Papers".

1 Click the Finish tab.

2 From the "Paper Arrangement" drop-down list, specify the processing method.
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7.5 Specifying the cover mode tab settings

Printing documents with a front cover/back cover

1 Click the Cover Mode tab.

2 Select the "Front Cover" and "Back Cover" check boxes.

3 From the "Front Cover" and "Back Cover" drop-down lists, select the desired print settings.
To print on the front cover and back cover, select "Print". To only add a blank page, select "Blank".

4 Select the paper tray that contains the loaded paper for the front cover and back cover.

Printing multiple pages

You can specify the print type and paper tray for each page. This comes in handy when you want to change 
the paper tray during a print job when printing multiple pages.

1 Click the Cover Mode tab.

2 Select the "Per Page Setting" check box.

3 From the "Per Page Setting" drop-down list, select the desired list name.

4 Click the [Edit List] button.

The Per Page Settings – Edit List dialog box for specifying the print settings appears.



d-Color MF550/MF450 7-21

Setting up the PostScript driver (Windows) 7
5 Click the [Add] button.

A new row for specifying the print settings is added to "Settings List".

6 Select the row that was added to the list, and then specify the print settings in "Add/Edit".

– Page Number: Enters the page number. When entering multiple page numbers, separate the page 
numbers with commas such as "2, 4, 6" or enter a page range using a hyphen such as "6-10".

– Print Type: Specifies Print Insert, Insert Blank Sheet, Print (1-Sided), and Print (2-Sided).
– Paper Tray: Specifies the paper tray.
– Staple: Specifies the number of staples and the stapling position.

7 Click the [OK] button.

2
Note 
To change existing print settings, select the desired row and change the settings. To delete existing 
print settings, select the desired row, and then click the [Delete] button.

Click the [Up] button or the [Down] button to change the page number starting with the smallest page 
number.

The list name can be changed by clicking the [Edit List Name] button.

Printing with transparency interleaves

If "Transparency" is selected as the paper type, you can select the "Transparency Interleave" check box to 
enable the transparency interleave setting. By selecting the "Transparency Interleave" check box, overhead 
projector transparencies can be inserted between the printed pages.

1 Click the Cover Mode tab.

2 Select the "Transparency Interleave" check box.

3 From the "Transparency Interleave" drop-down list, specify the printing conditions.

4 From the "Transparency Interleave" drop-down list, select the paper tray that contains the paper to be 
used.
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7.6 Specifying the stamp/composition tab settings

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 From the list, select the watermark that you want to print.

Editing a watermark

You can change the fonts and position of the watermark and you can register a new one.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 Click the [Edit] button under "Watermark".

The Edit Watermark dialog box appears.

4 To create a watermark, click the [Add] button.
To change a watermark, select the watermark from the "Current Watermark" list.
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5 Specify settings for the following:

– Watermark Name: Enters the name of the watermark.
– Watermark Text: Enters the text to be printed as a watermark.
– [Add]: Click to create a new watermark.
– [Delete]: Click to delete the selected watermark.
– Position: Specifies the vertical and horizontal positions. The watermark position can also be 

specified by using the horizontal and vertical sliders in the dialog box.
– Text Angle: Specifies the watermark print angle.
– Font Name: Specifies the font.
– Size: Specifies the size.
– Style: Specifies the font style.
– Frame: Specifies the frame style.
– Text Color: Specifies the watermark text color.
– Sharing: Specifies whether to register the watermark as public or private.
– Transparent: Prints the watermark as a transparent image.
– 1st Page Only: Prints the watermark on the first page only.
– Repeat: Prints several watermarks on a single page.

6 Click the [OK] button.

2
Note 
Up to 30 watermarks can be registered with the shared setting, and up to 20 watermarks can be 
registered with the private setting.

Only the administrator can select a setting under "Sharing".

Printing different original documents together (overlay)

An original document can be printed on top of the overlay data that was created separately. This function 
comes in handy when creating fax cover letters or form letters.

2
Note 
You must create and preregister the overlay file to be printed. For details, refer to "Editing an overlay 
file" on page 7-25.

1 Create the print data using any application.

2 From the [File] menu, select "Print".

3 Select this machine in "Printer Name", and then click the [Properties] button or the [Preferences] button.



7 Setting up the PostScript driver (Windows)

7-24 d-Color MF550/MF450

4 Click the Stamp/Composition tab.

5 Select the "Print in Overlay" check box.

6 From the list, select the overlay that you want to print.

7 Click the [Edit] button under "Print in Overlay".

The Edit Print In Overlay dialog box appears.

8 Specify the overlay printing method.

– Pages to Print: Specifies the pages to print.
– Overwrite: Specifies the sequence for printing the overlay on top of the original document.

9 Click the [OK] button.

The Stamp/Composition tab appears again.
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10 Click the [OK] button.

The Print dialog box appears again.

11 Click the [Print] button.

The printing of the overlay is performed.

Editing an overlay file

To use an overlay, an overlay file must be created and added to the overlay file list. You can create and save 
a new overlay file by selecting the "Create Overlay File" check box, specifying the document that you want 
to create as an overlay file, then clicking the [Print] button on the Print dialog box. To add an existing overlay 
file that was created to the list, specify the file.

Creating an overlay file

1 Create the overlay file data using any application.

2 From the [File] menu, select "Print".

3 Select this machine in "Printer Name", and then click the [Properties] button or the [Preferences] button.

4 Click the Stamp/Composition tab.

5 Select the "Create Overlay File" check box.

6 Click the [OK] button.

The Print dialog box appears again.

7 Click the [Print] button.

The dialog box to save the overlay file appears.
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8 Specify the storage location for the overlay file, enter the file name in the "File Name" box, and then 
enter the overlay name or a comment in the "Overlay Name" text box.

9 Click the [Save] button.

Instead of executing a print, the overlay file is saved and is added to the list to be used for the next 
operation. The file extension is ".KFO".

Registering an overlay file

1 Click the Stamp/Composition tab.

2 Click the [Edit] button under "Print in Overlay".

The Edit Print In Overlay dialog box appears.

3 Click the [Browse Files] button to open the overlay file.

The overlay file is added to the "Select Overlay File" list.
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2
Note 
By clicking the [Delete] button in the Edit Print In Overlay dialog box, the selected overlay file can be 
deleted from the overlay file list. The file itself is not deleted.

Printing with copy protection

You can print a special pattern on an entire page while printing.

When copying a printed page, the characters embedded in the pattern appear to prevent an illegal copy.

1 Click the Stamp/Composition tab.

2 Select the "Copy Protect" check box.

3 Click the [Edit] button under "Copy Protect".

The Edit Copy Protect dialog box appears.

4 Specify the copy protection type and the position.
Multiple print items can be specified.

– Characters: Embeds the selected character string in a pattern. A preregistered character string 
(common stamp) or a character string registered on this machine (registered stamp) can be 
specified.

– Date/Time: Embeds the selected date and time in a pattern. By clicking the [Edit] button under 
"Format", you can specify the display type or the time format.

– Serial Number: Embeds the serial number of this machine in a pattern.
– Distribution Control Number: Embeds the number of copies in a pattern when printing multiple 

copies. By clicking the [Edit] button under "Start Number", you can specify the start number or the 
display type.

– Job Number: Embeds the print job number in a pattern for documents that are automatically 
paginated.

– Text Size: Specifies the text size of a pattern.
– Angle: Specifies the pattern angle.
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5 Select the composition method for copy protection. 
Select "Copy Protect" to specify the desired results when copying, or simply select "Stamp Repeat". 
In addition, you can select the embedding conditions.

– Pattern: Specifies the embedding method of a pattern.
– Pattern Overwrite: Specifies the order for printing a pattern on the original document.
– Background Pattern: Specifies the pattern background.
– Text/Background Color: Specifies the pattern color. The density and color contrast can be specified 

by clicking the [Adjust Color] button.

6 Click the [OK] button.
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Printing the date and page numbers

You can print the date and page numbers on a document.

1 Click the Stamp/Composition tab.

2 Select the "Date/Time" or the "Page Number" check box. 
The "Date/Time" and "Page Number" check boxes can be selected at the same time.

3 Click the [Edit] button under "Page Number".

The Edit Date/Time/Page Number dialog box appears.

4 Specify the format and print position for the date, time, and page number.

– Format: Displays the format for the date and time to be printed. By clicking the [Edit] button, you 
can specify the display type or the time format.

– Pages to Print: Specifies the pages to print the date and time.
– Text Color: Specifies the text color to print.
– Print Position: Specifies the print position.
– Starting Page: Specifies the page to start printing the page number.
– Starting Page Number: Specifies the start number for printing the page number.
– Cover Mode: If cover pages are attached, specifies whether to print the page number on the front 

cover page or the back cover page.

5 Click the [OK] button.
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7.7 Specifying the quality tab settings

Adjusting the color and quality

1 Click the Quality tab.

2 Specify settings for the following:

Setting Description

Select Color Specifies the color for printing.
Full Color: Prints in color.
Grayscale: Prints in grayscale.

Quality Adjustment Adjusts the image quality. Simple: Adjusts the entire document. Detailed: 
Adjusts the text, photos, and charts of each object in a document.

Color Settings Specifies the contents of the original document. Prints with a quality suit-
able for the original document. Document: Prints with a quality suitable 
for documents with many characters. Photo: Prints with a quality suitable 
for photos. DTP: Prints with a quality suitable for documents produced 
using DTP. Web: Prints with a quality suitable for Web page printing. 
CAD: Prints with a quality suitable for CAD data printing.

Resolution Displays the resolution. (The resolution cannot be changed on this ma-
chine.)

Glossy Mode Prints using a gloss finish.
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Font Settings

You can replace the TrueType fonts used in Windows with the printer fonts of this machine.

1 Click the Quality tab.

2 Click the [Font Settings] button.

3 Specify settings for the following:

– Download Font Format: Selects the TrueType font downloading method.
– Use Printer Fonts: Replaces the TrueType fonts with the printer fonts.

2
Note 
Using the printer fonts will shorten the printing time, however, there may be a difference in the screen 
display and the print results.

By selecting the TrueType font download method from the "Download Font Format" drop-down list, 
you can select the TrueType font type to download when downloading the TrueType fonts and not using 
the printer fonts. When using TrueType fonts, select the font type to be downloaded to the printer.

Specify the font replacement list from the Device Settings tab.
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7.8 Specifying the Other tab settings (d-Color MF450)

2
Note 
The “Excel Job Control ”setting cannot be used with Windows XP Professional x64 or Windows Server 
2003 x64.

Setting Description

Excel Job Control Controls jobs so that they are not separated when printing in Microsoft Excel.

Driver Version Info Displays the version information of the printer driver.
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7.9 Specifying the configure tab settings

2
Note 
The information that is displayed differs depending on the options that are installed.

Selecting an option

The functions of this machine can be used from the printer driver if the installed options and the user 
authentication and account track functions are specified.

2
Reminder 
If the installed options and the user authentication and account track functions are not specified on the 
Configure tab, the option functions cannot be used from the printer driver. When installing options or 
using the authentication function, be sure to make the proper settings.

1 For Windows 2000, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the Configure tab.

4 Select the options to be specified under "Device Option".

5 Select the status of the option that is installed from the "Setting" drop-down list.
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2
Note 
Click the [Acquire Device Information] button to communicate with this machine and read the status of 
the settings specified on this machine. You cannot use this function if you are not connected to or able 
to communicate with this machine. The connection can be specified by clicking the [Acquire Settings] 
button.

d-Color MF450: When the Mail Bin Kit is installed, you can assign output tray 1 and output tray 2 as 
mail bins. 
To assign the output destination of the mail bins, select “Bin Setting” from “Administrator Setting” – 
“System Setting” – “Output Setting” on the control panel.
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Specifying the paper tray

You can register the paper size, paper orientation, and paper type for the paper that is loaded in a paper tray.

2
Reminder 
If the paper loaded in this machine and the paper specified from the printer driver are different, printing 
cannot be performed correctly. Be sure to make the proper settings.

1 Click the Configure tab.

2 Click the [Paper Tray Settings] button.

The Paper Tray Settings dialog box appears.

3 Select the desired tray in "Paper Tray Information", and then specify the paper size, paper orientation, 
and paper type.

4 Click the [OK] button.

2
Note 
The paper type for a paper tray can also be specified from the Basic tab. For details, refer to "Specifying 
the basic tab settings" on page 7-8.

Specify "Duplex Side 2" to print on the back side of a page.

Starting up a software tool

You can start up tools such as Web Connection that can be used by this machine.

1 Click the Configure tab.

2 From the "Software Tools" drop-down list, select the function.

3 Click the [Start] button.
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7.10 Specifying the settings tab settings

Specifying the default settings

You can change the default settings for displaying the confirmation messages or the dialog box for entering 
the authentication settings.

1 For Windows 2000, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the icon of the installed printer, and then click "Properties".

3 Click the Settings tab.

4 Specify settings for the following:

– Display Constraint Message: Specifies whether to display a message when functions that cannot 
be specified at the same time were enabled from the printer driver.

– Display paper set in Print Server Properties: Specifies whether to use the paper that was added in 
[Server Properties] of the printer folder. 

– Verify Authentication settings before printing: Specifies whether to verify the authentication settings 
for this machine before printing. A message appears if the results verified are not compatible.

– Popup Authentication Dialog when printing: Displays the User Authentication/Account Track dialog 
box when a print job is specified to enter a user name or a department name.

2
Note 
If custom paper sizes are used regularly, add the paper size to [Server Properties] of the printer folder. 
If the "Display paper set in Print Server Properties" check box is selected, the paper size can be 
selected from the paper size list.
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7.11 Saving the driver settings
You can save the setting values of the changed driver and recall them as necessary.

Saving the driver settings

1 Change the driver settings from the Basic tab and the Layout tab.

2 Click the [Add] button next to the "Favorite Setting" drop-down list.

3 Specify settings for the following:

– Name: Enters the specified registration name.
– Icon: Specifies the icon. The settings can be registered even if the icon is not specified. 
– Sharing: Specifies whether to register the specified file as public or private.
– Comment: Enters the detailed description of the specified file, if necessary.

4 Click the [OK] button.

The specified settings are registered in the "Favorite Setting" drop-down list.
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2
Note 
Up to 30 shared settings and up to 20 private settings can be registered.

Up to 30 characters can be entered in the "Name" text box. Up to 255 characters can be entered in the 
"Comment" text box.

Only the administrator can select a setting under "Sharing".

The settings that were specified can also be saved (exported) to a file. For details, refer to "Importing 
and exporting the driver settings" on page 7-40.

Recalling the settings

You can select the settings to recall from the "Favorite Setting" drop-down list on the Printing Preferences 
dialog box.

The setting values are recalled, and the settings for the printer driver are changed.

Editing the settings

You can edit the recalled function items such as the specified names and comments. 

1 In the Printing Preferences dialog box, click the [Edit] button next to the "Favorite Setting" drop-down 
list.

2 From the list, select the specified name that you want to change, and then change the setting. To delete 
a setting, click the [Delete] button.
To switch the order displayed, click the [Up] button or the [Down] button.
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3 Click the [Option] button, select the check box of the function that you want to recall, and then click the 

[OK] button.

4 Click the [OK] button.

2
Note 
The specified settings of the driver functions cannot be changed.
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Importing and exporting the driver settings

You can also save (export) or read (import) the settings that were specified to a file. This comes in handy when 
you want to use the same settings on another computer.

1 In the Printing Preferences dialog box, click the [Edit] button next to the "Favorite Setting" drop-down 
list.

2 From the list, select the specified name that you want to export, and then click the [Export] button.

The dialog box to save the specified file appears.

3 Specify the location to save the file and enter the file name.

4 Click the [Save] button.

The specified file is created. The file extension is ".KSF".

2
Note 
To read the specified file that was saved in the "Favorite Setting" drop-down list, click the [Import] 
button and specify the file.



8 Setting up the PPD driver 
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8 Setting up the PPD driver (Mac OS 9.2)

8.1 Settings
The functions of this machine can be specified on the Page Setup and Print dialog boxes displayed from an 
application.

The settings can only be applied while using the application. When the application is exited, the settings 
return to their defaults.

Page setup dialog box

Page Setup items

2
Note 
Depending on the application, "Page Setup" may be displayed as "Paper Setup". In addition, you may 
have to select "Paper Setup" – "Options" from the "File" menu.

The dialog boxes differ depending on the application.

Menu Item Function

Page Attributes Paper Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.

PostScript
Options

Flip Horizontal Prints the image flipped horizontally.

Flip Vertical Prints the image flipped vertically.

Invert Image Prints a negative image.

Substitute Fonts Replaces some fonts with printer fonts.

Smooth Text Smooths text data.

Smooth Graphics Smooths graphic data.

Precision Bitmap Alignment Corrects jagged graphic images.

Unlimited Downloadable Fonts Does not limit downloading screen fonts.

Custom Page Siz-
es

Paper Size Specifies any paper size.

Margins Specifies the paper margins.

Custom Page Size Name Enters the registered name for the specified paper size 
and margin after the [OK] button is clicked.

Units Selects the specified unit.
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Print dialog box

Print items

Menu Item Function

Page Attributes Copies Specifies the number of copies to print.

Collated Prints multiple copies in sets.

Pages Specifies the print range to print.

Paper Source Selects the paper tray.

Color Matching Print Color Specifies the color for printing.

Intent Selects the matching method.

Printer Profile Specifies the color adjustment profile of the output de-
vice.

Background Print-
ing

Print in Specifies background printing.

Print Time Specifies the priority level and print time.

Save as File Format Specifies the PostScript file output format.

PostScript Level Specifies the PostScript level.

Data Format Specifies the format to save a document.

Font Inclusion Specifies whether to include the font data on a file.

Font Settings Font Documentation Adds information to the font key.

Font Downloading Specifies the conditions to download fonts.

Layout Pages per sheet Specifies the number of pages to print on one page.

Layout direction Specifies the page order for printing multiple pages on 
one page.

Border Specifies the borders around pages.

Job Logging If there is a PostScript error Specifies the PostScript error report conditions.

Job Documentation Specifies the conditions for the operation record to be 
saved.

Job Documentation Folder Specifies the folder to which the operation record is to be 
saved.

Cover Page Print Cover Page Attaches a cover.

Cover Page Paper Source Selects the paper tray for the cover.
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2
Note 
The dialog boxes differ depending on the application.

Finishing Options 
1

Offset Specifies offset.

Output Tray Selects the output tray.

Binding Direction Specifies the binding position.

Print Type Performs duplex printing.

Combination Performs booklet printing.

Staple Performs stapling.

Punch Performs hole punching.

Finishing Options 
2

Fold Performs folding.

Front Cover Attaches a front cover page.

Front Cover Tray Selects the paper tray for the front cover.

Back Cover Attaches a back cover page.

Back Cover Tray Selects the paper tray for the back cover.

Transparency Interleave Inserts interleaves between overhead projector transpar-
encies.

Interleave Tray Selects the paper tray for the transparency interleaves.

Finishing Options 
3

Output Method Stops printing temporarily after part of the document has 
been printed so that the proof print can be checked.

Resolution Specifies the print resolution.

Select Color Specifies whether to print in color or grayscale.

Glossy Mode Prints using a gloss finish.

Color Settings Prints with a quality suitable for the original document.

Color Matching (Text) Adjusts the color quality of the text in a document.

Pure Black (Text) Specifies whether to enable grayscale of the text in a doc-
ument.

Finishing Options 
4

Screen (Text) Specifies screening of the text in a document.

Color Matching (Photo) Adjusts the color quality of photos in a document.

Pure Black (Photo) Specifies whether to enable grayscale of photos in a doc-
ument.

Screen (Photo) Specifies screening of photos in a document.

Smoothing (Photo) Specifies smoothing of photos in a document.

Color Settings (Graphic) Adjusts the color quality of a chart and graph in a docu-
ment to the text or photo settings.

Smoothing (Graphic) Adjusts the smoothing process of a chart and graph in a 
document to the text or photo settings.

Menu Item Function
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8.2 Page setup

Page attributes (basic settings)

1 Select "Page Setup" or "Paper Setup" from the [File] menu.

2 Select "Page Attributes".

3 Specify settings for the following:

– Paper: Specifies the paper size.
– Orientation: Specifies the orientation.
– Scale: Specifies the enlargement and reduction ratio.

2
Note 
The folding function can be selected from the screen that is displayed when "Layout" is selected in the 
Print dialog box.
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Custom page sizes

1 Select "Page Setup" or "Paper Setup" from the [File] menu.

2 Select "Custom Page Sizes".

3 Click the [New] button.

4 Specify settings for the following:

– Paper Size: Specifies the paper size.
– Margins: Specifies the paper margins.
– Custom Page Size Name: Enter the registered name for the specified paper size and margins, and 

then click the [OK] button.
– Units: Selects the specified unit.

5 Click the [OK] button.

This saves the custom page size, which can be selected from the "Paper" drop-down list when "Page 
Attributes" is selected.

PostScript options

1 Select "Page Setup" or "Paper Setup" from the [File] menu.

2 Select "PostScript Options".

3 Specify settings for the following:

– Visual Effects: Provides "Flip Horizontal", "Flip Vertical", and "Invert Image" (negative image).
– Substitute Fonts: Replaces some fonts with printer fonts.
– Smooth Text: Smooths text data.
– Smooth Graphics: Smooths graphic data.
– Precision Bitmap Alignment: Corrects jagged graphic images.
– Unlimited Downloadable Fonts: Does not limit downloading screen fonts.
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8.3 Printing

General (basic settings)

1 From the [File] menu, select "Print".

2 Select "General".

3 Specify settings for the following:

– Copies: Specifies the number of copies to print.
– Collated: Prints multiple copies in sets.
– Pages: Specifies the print range to print.
– Paper Source: Selects the paper tray.
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Layout (printing multiple pages on one page)

You can specify to print multiple pages on one page.

1 From the [File] menu, select "Print".

2 Select "Layout".

3 Specify settings for the following:

– Pages per sheet: Specifies the number of pages to print on one page.
– Layout direction: Specifies the page order for printing multiple pages on one page.
– Border: Specifies the borders around pages.

Printer specific options (Finishing options 1 to 4)

You can specify printer-specific options. You can specify these options when using the staple or hole punch 
functions of this machine.

1 From the [File] menu, select "Print".

2 Select "Finishing Options 1 to 4".

3 Specify settings for the following:

– Offset: Specifies offset.
– Output Tray: Selects the output tray.
– Binding Direction: Specifies the binding position.
– Print Type: Performs duplex printing.
– Combination: Performs booklet printing.
– Staple: Performs stapling.
– Punch: Performs hole punching.
– Fold: Performs folding.
– Front Cover: Attaches a front cover page.
– Front Cover Tray: Selects the paper tray for the front cover.
– Back Cover: Attaches a back cover page.
– Back Cover Tray: Selects the paper tray for the back cover.
– Transparency Interleave: Inserts interleaves between overhead projector transparencies.
– Interleave Tray: Selects the paper tray for the transparency interleaves.
– Output Method: Stops printing temporarily after part of the document has been printed so that the 

proof print can be checked.
– Resolution: Specifies the resolution.
– Select Color: Specifies whether to print in color or grayscale.
– Glossy Mode: Prints using a gloss finish.
– Color Settings: Prints with a quality suitable for the original document.
– Color Matching (Text): Adjusts the color quality of the text in a document.
– Pure Black (Text): Specifies whether to enable grayscale of the text in a document.
– Screen (Text): Specifies screening of the text in a document.
– Color Matching (Photo): Adjusts the color quality of photos in a document.
– Pure Black (Photo): Specifies whether to enable grayscale of photos in a document.
– Screen (Photo): Specifies screening of photos in a document.



8 Setting up the PPD driver (Mac OS 9.2)

8-10 d-Color MF550/MF450

– Smoothing (Photo): Specifies screening of photos in a document.
– Color Settings (Graphic): Adjusts the color quality of a chart and graph in a document to the text or 

photo settings.
– Smoothing (Graphic): Adjusts the smoothing process of a chart and graph in a document to the text 

or photo settings.

2
Reminder 
The staple function is available only when the optional finisher is installed.

The hole punch function is available only when the punch kit is installed on the optional finisher.

d-Color MF550: The folding function is available only when optional finisher FS-608 is installed.

d-Color MF450: The folding function is available only when optional saddle stitcher is installed.
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8.4 Setting options
You can specify the options installed on this machine so that they can be used from the printer driver.

2
Reminder 
If the installed options on this machine are not set from "Installable Options", the option function cannot 
be used with the printer driver. When installing options, be sure to make the proper settings.

1 On the Apple menu, click "Chooser".

2 Select the printer name.

3 Click the [Create] button.

4 Click the [Configure] button.

The setting screen for adding options appears.

5 Select the option that is installed on this machine.

6 Click the [OK] button.

The Chooser window appears again.

7 Close the Chooser window.

2
Note 
The option settings are displayed automatically the first time the printer driver is selected. For details, 
refer to "Selecting a printer" on page 3-9.
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9 Setting up the PPD driver (Mac OS X)

9.1 Settings
The functions of this machine can be specified on the Page Setup and Print dialog boxes recalled from the 
application.

The settings can only be applied while using the application. When the application is quit, the settings return 
to their default settings.

Page setup dialog box

Page Setup items

2
Note 
Depending on the application, "Page Setup" may be displayed as "Paper Setup". In addition, you may 
have to select "Paper Setup" – "Options" from the "File" menu.

The dialog boxes differ depending on the application.

The items indicated by *2 are displayed only in Mac OS 10.2 and Mac OS 10.3.

Menu Item Function

Page Attributes Paper Size Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.

Custom Paper 
Size*2

Paper Size (Page size) Specifies any paper size.

Printer Margins Specifies the paper margins.
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Print dialog box

Print items

Menu Item Function

Copies & Pages Copies Specifies the number of copies to print.

Collated Prints multiple copies in sets.

Pages Specifies the print range to print.

Layout Pages per Sheet Specifies the number of pages to print on one page.

Layout Direction Specifies the document page order.

Border Specifies the borders around pages.

Output Options*2 Save as File Saves data to a file.

Format Specifies the format for saving data to a file.

Scheduler*1 Print Document Specifies the print time.

Priority Specifies the priority level.

Paper Handling*1 Reverse Page Order 
(Page Order)

Prints pages in the reverse order.

Print Selects the pages for printing.

Destination paper size*3 Specifies the output paper size.

ColorSync*1 Color Conversion Specifies the color conversion method.

Quartz Filter Specifies the color for printing.

Cover Page*1 Print Cover Page Specifies whether to attach a cover page.

Cover Page Type Selects to print "Confidential" or other comments on the cover 
page.

Billing Info Enters the user information used for billing.

Error Handling PostScript Errors Specifies whether to print an error report when a PostScript error 
occurs.

Tray Switching Switches the paper source tray. (This function cannot be select-
ed on this machine.)

Output Method Collate Prints multiple copies in sets.

Offset Specifies offset.

Output Method Specifies output methods, such as "Secure Print" and "Save in 
User Box".

User Authentication Select to perform user authentication and specify the user name 
and password.

Account Track Select to perform account track and specify the department 
name and password.
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2
Note 
The dialog boxes differ depending on the application.

The items indicated by *1 are displayed only in Mac OS 10.3 and Mac OS 10.4. 
The items indicated by *2 are displayed only in Mac OS 10.3. 
The items indicated by *3 are displayed only in Mac OS 10.4.

Layout/Finish Print Type Specifies duplex printing and booklet printing.

Binding Direction Specifies the binding position.

Poster Mode Prints one sheet of an original document divided on multiple pag-
es.

Overlap width line Prints an overlap width line on split pages.

Rotate 180 Prints the image rotated 180°.

Image Shift Prints by shifting the entire print image.

Chapter Specifies the page to be printed on the front side.

Staple Specifies stapling.

Punch Specifies hole punching.

Saddle Stitch/Fold Specifies to fold and saddle stitch a printed document.

Paper Arrangement Specifies the method for adjusting the binding position.

Paper Tray/Output 
Tray

Paper Tray Selects the paper tray for printing.

Paper Type Selects the paper type for printing.

Paper Settings for Each 
Tray

Specifies the paper type for each paper tray.

Output Tray Specifies the tray where to output the printed pages.

Cover Mode/Trans-
parency Interleave

Front Cover Attaches a front cover page.

Back Cover Attaches a back cover page.

Transparency Interleave Outputs and inserts interleaves when printing overhead projector 
transparencies.

Per Page Setting Per Page Setting Inserts paper between pages and switches the paper and tray for 
each page.

Stamp/Composition Copy Protect Prints a special pattern to prevent copying.

Date/Time Prints the date and time.

Page Number Prints the page number.

Quality Select Color Specifies the color for printing.

Glossy Mode Prints with a gloss.

Color Settings Prints with a quality suitable for the selected original document.

Quality Adjustment Adjusts the image quality. You can select "Simple" to adjust en-
tire documents or "Detailed" to adjust the text, photos, and 
charts in the document.

Menu Item Function
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Common settings in the print dialog box

The following describes the common settings that are displayed by the specific operations (Output Method, 
Layout/Finish, Paper Tray/Output Tray, Cover Mode/Transparency Interleave, and Per Page Setting) for this 
machine.

2
Note 
Click the [Acquire Device Information] button on the Printer Information dialog box to communicate with 
this machine and read the status of the settings specified on this machine. You cannot use this function 
if you are not connected to or able to communicate with this machine.

Item Function

Paper View A preview of the page layout as specified in the current settings is displayed and 
a preview image of the print job can be checked.

Detailed Information Shows the current settings with text.

Printer Information Displays the status of the installed options.

Default Click this button to return the settings to their defaults, which were selected when 
the driver was installed.
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9.2 Page setup

Page attributes (basic settings)

1 Select "Page Setup" or "Paper Setup" from the [File] menu.

2 Select "Page Attributes".

3 Specify settings for the following:

– Paper Size: Specifies the paper size.
– Orientation: Specifies the orientation.
– Scale: Specifies the enlargement and reduction ratio.

2
Note 
To print on paper sizes other than the standard sizes, be sure to set the custom paper sizes in Custom 
Page Sizes first.

When "W" is selected for each standard paper size from the printer driver, the data can be centered 
and printed.

For example, if A4 size data is created and you want to center and print on A3 size paper, select "A4W" 
as the paper size and "Tray 1" or "Bypass Tray" as the paper tray from the printer driver.

To print, load A3 size paper in the tray ("Tray 1" or "Bypass Tray") of this machine that is specified from 
the printer driver, and then specify the settings described below from [Basic (Paper)] – [Change Tray 
Settings] – [Wide Paper] in the control panel.
Select "A4W".
Enter the A3 paper size (420.0 e 297.0) in [Change Size].
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Custom page sizes

1 Select "Page Setup" or "Paper Setup" from the [File] menu.

2 For Mac OS 10.4, select "Manage Custom Sizes" from the "Paper Size" drop-down list.
For Mac OS 10.2 and Mac OS 10.3, select "Custom Paper Size" from "Settings".

3 Click the [New] (Mac OS 10.2/10.3) or the [+] (Mac OS 10.4) button.

4 Enter the paper size name.

5 Specify settings for the following:

– Page Size (Paper Size): Specifies any paper size.
– Printer Margins: Specifies the paper margins.

6 For Mac OS X 10.4, continue with step 7.
For Mac OS 10.2 and Mac OS 10.3, click the [Save] button.

7 Click the [OK] button.

This saves the custom paper size, which can be selected from the "Paper Size" drop-down list that is 
displayed when "Page Attributes" is selected.
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9.3 Printing

General settings

1 From the [File] menu, select "Print".

2 Select "Copies & Pages".

3 Specify settings for the following:

– Copies: Specifies the number of copies to print.
– Collated: Prints multiple copies in sets.
– Pages: Specifies the print range to print.
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9.4 Output method

Collate: Prints multiple copies in sets.

Offset: Specifies offset.

Output Method: Specifies the output method. For details, refer to "Selecting the output method" on 
page 9-10.

User Authentication: Performs user authentication. For details, refer to "Specifying the user authentication 
settings" on page 9-12.

Account Track: Performs account track. For details, refer to "Specifying the account track settings" on 
page 9-13.

Detail Settings: Displays the functions for which the setting details have been specified.

Selecting the output method

Not only can you print directly, but you can select "Secure Print", which requires a password to print, or "Save 
in User Box", which saves data in the boxes that were created on the HDD.

From the "Output Method" drop-down list, select the output method.

Print: Prints immediately.

Secure Print: Saves the document to be printed in "Secure Print User Box" of this machine. When printing, 
you are required to enter the ID and password in this machine’s control panel. Select when printing highly 
confidential documents.

Save in User Box: Saves the document to be printed in a box on this machine.

Save in User Box and Print: Saves the document in a box and prints at the same time.

Proof Print: After a part of the document has been printed, this machine stops printing temporarily. Select to 
avoid misprinting a large volume of print jobs.
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Secure Print

If "Secure Print" was selected, enter the ID and password in the dialog box that appeared.

2
Note 
By selecting the "Save Settings" check box, the specified settings are saved. In addition, if the "Do not 
show this window when setting" check box is selected, the dialog box does not appear when the 
function is specified.

The dialog box can be displayed by clicking the [Detail Settings] button. For details, refer to "Selecting 
the output method" on page 9-10.

To print, specify "Secure Print Document Box" from the Box mode in this machine’s control panel, and 
then enter the ID and password. For details, refer to "Print job management" on page 11-36. For details 
on the box functions of this machine, refer to the User manual – Box Operations.

When password rules are enabled on this machine, the passwords that can be used for secured printing 
are limited and the jobs are deleted when a password that does not comply with the password rule is 
entered. For the password rules, refer to the User manual – Copy Operations.

Save in User Box

When "Save in User Box" or "Save in User Box and Print" is selected, specify the file name to be saved and 
the box number for the save location in the dialog box that appears for entering the file name and box number.
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2
Note 
By selecting the "Save Settings" check box, the specified settings are saved. In addition, if the "Do not 
show this window when setting" check box is selected, the dialog box does not appear when the 
function is specified.

The dialog box can be displayed by clicking the [Detail Settings] button. For details, refer to "Checking 
the output method setting details" on page 9-14.

Be sure to create the box of the save location in advance with the box function of this machine. For 
details on the box functions of this machine, refer to the User manual – Box Operations.

When password rules are enabled on this machine, specify the box that was created on this machine.

Proof Print

When a print job is sent, this machine stops printing temporarily after part of the document has been printed. 
The remaining print job is stored in this machine as a print job. When printing multiple copies, you can print 
the remaining part of the print job after checking the print results.

2
Note 
To print the document, release the held document from the Job mode in this machine’s control panel. 
For details, refer to "Print job management" on page 11-36.

Specifying the user authentication settings

If the user authentication settings have been specified on this machine, you must enter a user name and 
password.

2
Reminder 
If a job is printed using a user name or password that is not a registered account on this machine, or if 
a job is printed without selecting a user under "User Authentication", the operation is not authenticated 
by this machine and the job is canceled.

If the user authentication settings are specified on this machine and the authentication operation 
restriction function is in mode 2, the applicable user is locked and cannot be accessed if the 
authentication information is not entered correctly.

1 Select the "User Authentication" check box.

The User Authentication dialog box appears.

2 Select "Recipient User", and then enter the user name and password.
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3 Click the [OK] button.

2
Note 
If this machine has been set to permit public users, the machine can be used without a user name and 
password.

If performing user authentication on a server, the server settings must be specified. Click the [User 
Authentication Server Setting] button to select the server.

By selecting the "Save Settings" check box, the specified settings are saved. In addition, if the "Do not 
show this window when setting" check box is selected, the dialog box does not appear when the 
function is specified.

The dialog box can be displayed by clicking the [Detail Settings] button. For details, refer to "Checking 
the output method setting details" on page 9-14.

If printing is not allowed, printing cannot be performed even when used by a registered user. For details 
on the user authentication function, consult the administrator of this machine.

If performing user authentication with an optional authentication unit (biometric type), enter the user 
name and password in step 2. For details, refer to the operation manual of the authentication unit 
(biometric type).

Specifying the account track settings

If the account track settings have been specified on this machine, you must enter a department name and 
password.

2
Reminder 
If a job is printed using a department name or password that is not a registered account on this 
machine, or if a job is printed without "Account Track" selected, the operation is not authenticated by 
this machine and the job is canceled.

When the account track settings are specified on this machine, the authentication operation restriction 
function is in mode 2, and the authentication information is not entered correctly, the applicable 
account is locked and cannot be accessed.

1 Select the "Account Track" check box.

The Account Track dialog box appears.

2 Enter the department name and password.

3 Click the [OK] button.
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2
Note 
By selecting the "Save Settings" check box, the specified settings are saved. In addition, if the "Do not 
show this window when setting" check box is selected, the dialog box does not appear when the 
function is specified.

The dialog box can be displayed by clicking the [Detail Settings] button. For details, refer to "Checking 
the output method setting details" on page 9-14.

If printing is not allowed, printing cannot be performed even when used by a registered account. For 
details on the account track function, consult the administrator of this machine.

Checking the output method setting details

By clicking the [Detail Settings] button, the "Output Method" functions for which detailed settings have been 
specified are shown.

The settings can be shown by clicking the [Expand All] button.

By selecting a function and clicking the [Settings] button, the dialog box for specifying the detailed settings 
for the selected function appears.

Secure Print: Displays the Secure Print dialog box for entering an ID and password. This is the same dialog 
box that appears when "Secure Print" is specified from the "Output Method" drop-down list.

Save in User Box: Displays the Save in User Box dialog box for entering a file name and box number. This is 
the same dialog box that appears when "Save in User Box" or "Save in User Box and Print" is specified from 
the "Output Method" drop-down list.

User Authentication: Displays the User Authentication dialog box for entering a user name and password. 
This is the same dialog box that appears when the "User Authentication" check box is selected.

Account Track: Displays the Account Track dialog box for entering a department name and password. This 
is the same dialog box that appears when the "Account Track" check box is selected.
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Administrator Settings: Displays the Administrator Settings dialog box in which you can select when the User 
Authentication dialog box or the Account Track dialog box is displayed.

Popup Authentication Dialog when printing: Displays the User Authentication dialog box or the Account Track 
dialog box when a print job is specified to enter a user name or a department name.
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9.5 Layout/Finish
You can switch between the Layout dialog box and the Finish dialog box.

Print Type: Specifies duplex printing and booklet printing.

Binding Direction: Specifies the binding position.

Poster Mode: Prints one page of an original document divided on multiple pages.

Overlap width line: Prints an overlap width line on split pages. This setting can be specified when "Poster 
Mode" is specified.

Rotated 180: Prints the image rotated 180°.

Image Shift: Prints by shifting the entire print image. For details, refer to "Shifting images" on page 9-17.

Chapter: Specifies the page to be printed on the front side. For details, refer to "Chapter" on page 9-18.

Staple: Specifies stapling. Select the "Staple" check box, and then specify the number of staples and the 
stapling position from the drop-down list.

Punch: Specifies hole punching. Select the "Punch" check box, and then specify the number of punched 
holes from the drop-down list.
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Saddle Stitch/Fold: Specifies to saddle stitch or fold a printed document.

Paper Arrangement: Specifies the method for adjusting the binding position. If "Prioritize Arranging Papers" 
is selected, all pages can be processed to a suitable quality by this machine because the binding position is 
adjusted after all the print data is received. If "Prioritize Productivity" is selected, the printing process is 
performed efficiently because the binding position is adjusted while the data is printed simultaneously as it 
is being received.

Detail Settings: Displays the functions for which the setting details have been specified.

2
Reminder 
When printing a job that contains pages of different sizes and orientations with the "Poster Mode" 
setting specified, images may be missing or overlapping when the document is printed.

The staple function is available only when the optional finisher is installed.

The hole punch function is available only when the punch kit is installed on the optional finisher.

d-Color MF550: The saddle stitch function and the fold function are available only when optional finisher 
FS-608 is installed.

d-Color MF450: The saddle stitch function and the fold function are available only when optional saddle 
stitcher is installed.

2
Note 
The staple and hole-punch position changes according to the binding position specified from "Binding 
Direction".

The fold function cannot be specified when the staple, punch, or saddle stitch function is specified.

Shifting images

The entire print image of a document is shifted and then printed. You can use this function when you want to 
adjust the print position.

1 Select the "Image Shift" check box.

2 Select the shift direction and set the values. 
By clearing the "Same value for Front and Back sides" check box, you can set separate values for the 
front and back sides.
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2
Note 
By selecting the "Save Settings" check box, the specified settings are saved. In addition, if the "Do not 
show this window when setting" check box is selected, the dialog box does not appear when the 
function is specified.

The dialog box can be displayed by clicking the [Detail Settings] button. For details, refer to "Checking 
the layout/finish setting details" on page 9-19.

Chapter

You can specify the page you want to print on the front side when duplex printing or booklet printing.

Even if a specified page comes up to be printed on the back side in duplex printing or booklet printing, the 
specified page is moved and printed on the front side.

1 Select the "Chapter" check box.

The dialog box for setting the detailed settings appears.

2 Enter the page number of the page you want to print on the front side.

2
Note 
When entering multiple page numbers, separate the page numbers with commas such as "2, 4, 6" or 
enter a page range using a hyphen such as "6-10".

The "Chapter" check box can only be selected when the duplex printing or the booklet printing setting 
is enabled.

By selecting the "Save Settings" check box, the specified settings are saved. In addition, if the "Do not 
show this window when setting" check box is selected, the dialog box does not appear when the 
function is specified.

The dialog box can be displayed by clicking the [Detail Settings] button. For details, refer to "Checking 
the layout/finish setting details" on page 9-19.
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Checking the layout/finish setting details

By clicking the [Detail Settings] button, the "Layout/Finish" functions for which detailed settings have been 
specified are shown.

The settings can be shown by clicking the [Expand All] button.

By selecting a function and clicking the [Settings] button, the dialog box for specifying the detailed settings 
for the selected function appears.

Image Shift: Displays the Image Shift dialog box. This is the same dialog box that appears when the "Image 
Shift" check box is selected.

Chapter: Displays the Chapter dialog box. This is the same dialog box that appears when the "Chapter" 
check box is selected.
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9.6 Paper tray/Output tray

Paper Tray: Selects the paper tray for printing.

Paper Type: Selects the paper type for printing. This setting can be specified when the paper tray setting is 
set to "Auto".

Paper Settings for Each Tray: Specifies the paper type for each paper tray. For details, refer to "Specifying 
the paper type for a paper tray" on page 9-21.

Output Tray: Specifies the tray where to output the printed pages.

2
Note 
If "Auto" is specified as the paper tray, you can select the paper type. If the paper tray setting is 
changed to a setting other than "Auto", the paper type is fixed to its preregistered setting. Specify a 
paper type by clicking the [Paper Settings for Each Tray] button.
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Specifying the paper type for a paper tray

You can specify the paper type for a paper tray.

1 Click the [Paper Settings for Each Tray] button.

The dialog box for setting the detailed settings appears.

2 Select the desired paper tray, and then select the paper type to be specified from the "Paper Type" 
drop-down list.

2
Note 
Click the [Restore Device Status] button to communicate with this machine and read the status of the 
settings specified on this machine. You cannot use this function if you are not connected to or able to 
communicate with this machine.

By selecting the "Save Settings" check box, the specified settings are saved.

Specify "Duplex Side 2" to print on the back side of a page.
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9.7 Cover mode/Transparency interleave
You can switch between the Cover Mode dialog box and the Transparency Interleave dialog box.

Front Cover: Attaches a front cover page. Select this check box, and then select the print conditions from the 
upper drop-down list, and the paper tray that contains the loaded paper to be used from the lower drop-down 
list.

Back Cover: Attaches a back cover page. Select this check box, and then select the print conditions from the 
upper drop-down list, and the paper tray that contains the loaded paper to be used from the lower drop-down 
list.

Transparency Interleave: Outputs and inserts interleaves when printing overhead projector transparencies. 
Select this check box, and then select the paper tray that contains the loaded paper to be used from the lower 
drop-down list.

2
Note 
To print on the front cover and back cover, select "Print". To only add a blank page, select "Blank".

The "Transparency Interleave" setting can be specified if "Transparency" is selected as the paper type.
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9.8 Per page setting
You can specify the print type and paper tray for each page. This comes in handy when you want to change 
the paper tray during a print job when printing multiple pages. The settings are added to the per page setting 
list and can be used as necessary.

Per Page Setting: Enables the per page setting function.

List: Displays the list of the settings that have been added to Per Page Setting.

Add: Adds settings to Per Page Setting. For details, refer to "Adding and editing the settings in per page 
setting" on page 9-24.

Edit: Edits the settings in Per Page Setting. For details, refer to "Adding and editing the settings in per page 
setting" on page 9-24.

Delete: Deletes the settings in Per Page Setting.

+/,: Changes the order of the per page setting list.
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Adding and editing the settings in per page setting

1 Select the "Per Page Setting" check box.

2 Click the [Add] button to add a new setting to the list. 
To edit the list, select the desired name in the list, and then click the [Edit] button.

The Per Page Settings dialog box for specifying the print settings appears.

3 Click the [Add] button to add the setting to the list.

A new row for specifying the settings is added to the settings list.

4 Select the row that was added to the list, and then specify the print settings in "Add/Edit".

– Page Number: Enters the page number. When entering multiple page numbers, separate the page 
numbers with commas such as "2, 4, 6" or enter a page range using a hyphen such as "6-10".

– Print Type: Specifies Print Insert, Insert Blank Sheet, Print (1-Sided), and Print (2-Sided).
– Paper Tray: Specifies the paper tray.
– Staple: Specifies the number of staples and the stapling position.

5 Click the [OK] button.

2
Note 
To change existing print settings, select the desired row and change the settings. To delete existing 
print settings, select the desired row, and then click the [Delete] button.

Click the [+] button or the [,] button to change the page number starting with the smallest page 
number.

The name of the list can be changed in the "List Name:" text box.
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9.9 Stamp/Composition

Copy Protect: Prints a special pattern to prevent copying.

Date/Time: Prints the date and time.

Page Number: Prints the page number.
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Printing with copy protection

You can print a special pattern on an entire page while printing.

When copying a printed page, the characters embedded in the pattern appear to prevent an illegal copy.

1 Select the "Copy Protect" check box.

The Copy Protect dialog box appears.

2 Specify the copy protection type and the position.
Multiple print items can be specified.

– Characters: Embeds the selected character string in a pattern. A preregistered character string 
(common stamp) or a character string registered on this machine (registered stamp) can be 
specified.

– Date/Time: Embeds the selected date and time in a pattern.
– Serial Number: Embeds the serial number of this machine in a pattern.
– Distribution Control Number: Embeds the number of copies in a pattern when printing multiple 

copies. The start number or the number of digits that are displayed can be specified.
– Job Number: Embeds the print job number in a pattern for documents that are automatically 

paginated.
– Text Size: Specifies the text size of a pattern.
– Angle: Specifies the pattern angle.
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3 Select the composition method for copy protection. 

Select "Copy Protect" to specify the desired results when copying, or simply select "Repeatable 
Stamp". In addition, you can select the embedding conditions.

– Pattern: Specifies the embedding method of a pattern.
– Pattern Overwrite: Specifies the order for printing a pattern on the original document.
– Background Pattern: Specifies the pattern background.
– Adjust Color: Specifies the color of the pattern.

4 Click the [OK] button.

2
Note 
If the "Do not show this window when setting" check box is selected, the dialog box does not appear 
when this function is specified. The dialog box can be displayed by clicking the [Settings] button.
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Printing the date and time

You can print the date and time on a document.

1 Select the "Date/Time" check box.

The Date/Time dialog box appears.

2 Specify the format and print position for the date and time.

– Format: Displays the format for the date and time to be printed.
– Pages to Print: Specifies the pages to print the date and time.
– Text Color: Specifies the text color to print.
– Print Position: Specifies the print position.

3 Click the [OK] button.

2
Note 
If the "Do not show this window when setting" check box is selected, the dialog box does not appear 
when this function is specified. The dialog box can be displayed by clicking the [Settings] button.
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Printing the page numbers

You can print the date and page numbers on a document.

1 Select the "Page Number" check box.

The Page Number dialog box appears.

2 Specify the format and print position for the printing the page number.

– Starting Page: Specifies the page to start printing the page number.
– Starting Page Number: Specifies the start number for printing the page number.
– Cover Mode: If cover pages are attached, specifies whether to print the page number on the front 

cover page or the back cover page.
– Text Color: Specifies the text color to print.
– Print Position: Specifies the print position.

3 Click the [OK] button.

2
Note 
If the "Do not show this window when setting" check box is selected, the dialog box does not appear 
when this function is specified. The dialog box can be displayed by clicking the [Settings] button.
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9.10 Quality

Select Color: Specifies whether to print in color or grayscale.

Glossy Mode: Prints with a gloss.

Color Settings: Prints with a quality suitable for the selected original document.
Document: Prints with a quality suitable for documents with many characters.
Photo: Prints with a quality suitable for photos.
DTP: Prints with a quality suitable for documents produced using DTP.
Web: Prints with a quality suitable for Web page printing.
CAD: Prints with a quality suitable for CAD data printing.

Quality Adjustment: Adjusts the image quality. The text, photos, and charts of each object in a document can 
be adjusted.
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9.11 Setting options
You can specify the options installed on this machine so that they can be used from the printer driver.

2
Reminder 
If the installed options on this machine are not set from "Installable Options", the option function cannot 
be used with the printer driver.

When installing options, be sure to make the proper settings.

1 Open Printer Setup Utility or Print Center, located in "Applications" – "Utilities" of "Hard Disk" and 
select this machine.

2 From the [Printer] menu, select "Show Info".

The Printer Info dialog box appears.

3 Select "Installable Options".

4 Select the options that are installed on this machine.

5 Click the [Apply Changes] button, and then click  to close the Printer Info dialog box.

2
Note 
The information that is displayed differs depending on the options that are installed.
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9.12 Saving the driver settings
For Mac OS X drivers, you can save the setting values of the changed driver and recall them as necessary.

Saving the driver settings

1 Change the driver settings in "Copies & Pages" and "Layout".

2 From "Presets", click "Save as".

3 Enter the preset name in the "Save Preset As" text box.

4 Click the [OK] button. The settings are added to the preset settings.

Recalling the settings

Select "Presets" from the Print dialog box to recall the settings.

The setting values are recalled, and the settings for the printer driver are changed.

Changing the settings

1 Select "Presets" from the Print dialog box to change the settings.

2 Change the driver settings in "Copies & Pages" and "Layout".

3 From "Presets", click "Save".
To delete, click "Delete". To change the name, click "Rename".

The preset settings are changed.
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10 Setting up the fax driver (Windows)

10.1 Sending a fax

Fax operations

2
Reminder 
To use the fax function, you must install the optional fax kit onto this machine. In addition, you must 
enable the fax kit on the Configure tab after installation. For details, refer to "Specifying the configure 
tab settings" on page 10-21.

2
Note 
For details on the fax function of this machine, refer to the User manual – Fax Operations (Option).

1 Create the data you want to send using any application.

2 From the [File] menu, select "Print".

3 From "Printer Name", select "GENERIC 45C-1 FAX" ("GENERIC 45C-2 FAX" on d-Color MF450).

4 Click the [Preferences] button or the [Properties] button to change the fax driver settings as necessary.

– By clicking the [Preferences] button or the [Properties] button in the Print dialog box, you can specify 
the settings of each model in the FAX Printing Preferences dialog box that appears. For details, refer 
to "Settings" on page 10-10.

5 Click the [Print] button.

The FAX Transmission Popup dialog box appears.

6 Enter the recipient’s name and fax number in the "Name" and "FAX Number" text boxes.

7 Click the [Add Recipients] button.

– To add multiple recipients, repeat steps 6 and 7. Up to 100 recipients can be added.
– To delete a recipient from the list, click the [Delete From List] button.
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8 If necessary, click the [Fax Mode Setting Details] button to specify the fax mode setting details, or select 
the "FAX Cover Sheet" check box to create a fax cover sheet.

– For details, refer to "Specifying the transmission settings" on page 10-6, or "Creating a fax cover 
sheet" on page 10-7.

9 Click the [OK] button.

The fax data is sent via this machine.

2
Note 
Up to 80 characters can be entered in the "Name" text box.

Up to 38 characters (numbers 0 through 9, hyphens (-), #, *, P, and T) can be entered in the "FAX 
Number" text box. To send a fax overseas, be sure to enter the country code first.

Change the transmission mode as necessary.
ECM: Specifies the ECM (Error Correction Mode). If the "V.34 Mode" check box is selected, the "ECM" 
check box cannot be cleared.
International Transmission Mode: Slows the speed when sending faxes overseas. Select this check box 
if errors occur when sending faxes overseas.
V.34 Mode: Specifies the Super G3 fax mode. For normal fax operations, leave this check box selected. 
Clear it only if it is not possible to transmit in the recipient’s mode.

The fax numbers that are registered in the phone book can be specified by clicking the [Add From 
Phone Book] button. For details, refer to "Selecting a recipient from the phone book" on page 10-5.

The names and fax numbers that were entered can be added to the phone book’s "Simple Entry" folder 
by clicking the [Register To Phone Book] button.
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Selecting a recipient from the phone book

2
Note 
To use the phone book, the names and fax numbers of the recipients must be added to the phone book 
first. For details, refer to "Adding a recipient to the phone book" on page 10-22.

1 When sending a fax, click the [Add From Phone Book] button in the FAX Transmission Popup dialog 
box.

– To open the FAX Transmission Popup dialog box, follow steps 1 to 5 under "Fax operations". For 
details, refer to "Fax operations" on page 10-3.

2 Select "Personal List" or "Group" from the list on the left side of the dialog box to display the desired 
recipient in "Personal Information".

– Click the [Find] button to specify the conditions to search for a recipient.

3 Select the name of the recipient you want to send a fax to, and then click the [Add Recipients] button.

– Multiple recipients can be added in the same way. Up to 100 recipients can be added.
– To delete a recipient, click the [Delete] button.



10 Setting up the fax driver (Windows)

10-6 d-Color MF550/MF450

– If recipients have been added to a group, all the members of the group can be added to "Recipient 
List" (group transmission) by selecting a group name, then clicking the [Add Recipients] button. 

4 Click the [OK] button.

The names that were specified are added to "Recipient List" and the FAX Transmission Popup dialog 
box appears again.

Specifying the transmission settings

When sending a fax, you can specify the transmission settings in the Fax Mode Details dialog box that 
appears when the [Fax Mode Setting Details] button is clicked in the FAX Transmission Popup dialog box.

Print Recipient File: Prints the document after a fax was sent.

Timer Send: Sets the transmission time. By clicking the [Reflect Current Time] button, the current time set on 
the computer is displayed in the "Send Time" boxes.

SUB Address: Specifies the sub address for sending confidential faxes using F-codes. 

Sender ID: Specifies the sender ID for sending confidential faxes using F-codes. 

2
Note 
When using Timer Send, check that the time set on the computer is synchronized with the time on this 
machine. If the transmission time is earlier than the current time of this machine, the fax is sent the next 
day.

If sending confidential faxes using F-codes to another fax model, enter the sub address and sender ID 
in the "SUB Address" and the "Sender ID" text boxes. Up to 20 characters (numbers 0 through 9) can 
be entered in the "Sub Address" text box. Up to 20 characters (numbers 0 through 9, #, and *) can be 
entered in the "Sender ID" text box. For the details on the sub address and the sender ID, refer to the 
User manual – Fax Operations (Option).
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Creating a fax cover sheet

When sending a fax, you can attach a cover sheet to the fax message by selecting the "FAX Cover Sheet" 
check box in the FAX Transmission Popup dialog box. You can edit the cover sheets from the FAX Cover 
Sheet Settings dialog box that appears by clicking the [Settings] button in the Fax Transmission Popup dialog 
box.

In the FAX Cover Sheet Settings dialog box, you can change the settings on the Basic, Recipient, Sender, or 
Image tab by switching between each screen.

1 Select the "FAX Cover Sheet" check box in the FAX Transmission Popup dialog box.

2 Click the [Settings] button.

The FAX Cover Sheet Settings dialog box appears.

3 Select the size of the cover sheet from the "Cover Size" drop-down list.

4 On the Basic tab, specify the format of the cover sheet and subject of the fax.

– Style: Selects the format design of the cover sheet. 
– Subject: Enters the subject of the fax to be sent. Up to 64 characters can be entered in the "Subject" 

text box.
– Date: Specifies the date. Select a format or enter any format. If entering a format, up to 20 

characters can be entered in the "Input Arbitrarily" text box.
– Pages: Specifies the number of pages to be sent.
– Comment: Enters the text to be displayed in the comment box. Up to 640 characters can be entered 

in the "Comment" text box, and returns are converted into two characters.
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5 Specify the recipient information on the Recipient tab. 

– Standard: Specifies standard text.
– Details: Specifies the details described under "Recipient Setting Details".
– Load with Joint Name: Lists the recipient with joint names. The items listed are the items shown 

under "Recipient List" on the FAX Transmission Popup dialog box.
– Change Each Recipient: Changes the description for each recipient. The items listed are the items 

shown under "Recipient List" on the FAX Transmission Popup dialog box.
– Load Set Information: Lists the information that was entered in the "Company", "Department", 

"Name", and "FAX Number" text boxes.
– Read: Reads the information of the first recipient to the information box.
– Up to 40 separate cover sheets can be created if "Change Each Recipient" is selected.
– Even if "Change Each Recipient" is selected, the first recipient is displayed as a sample in "Preview".
– If "Load with Joint Name" and "Change Each Recipient" are selected, the names that were added 

are entered, but titles cannot be added.
– If a recipient is not specified on the FAX Transmission Popup dialog box, "Load Set Information" 

cannot be selected. In addition, it cannot be selected on the fax tab in the FAX Printing Preferences 
dialog box as well.

6 Specify the sender information on the Sender tab. 

Select the check box of the information to be listed, and then enter the information.
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7 To place graphics such as a company logo or map on a cover sheet, specify the image file on the Image 

tab.
Select the "Zoom" check box to specify the size, and set the position with the values in the "X" and "Y" 
boxes.

8 Check the specified settings. 
Click the [Check] button to check an enlarged preview image.

– Click the [Add] button to save the cover sheet settings. The settings can then be recalled from the 
"Cover Sheet Settings" drop-down list the next time a cover sheet is used.

9 Click the [OK] button.
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10.2 Settings

Common settings

The following describes the common settings and buttons that are displayed on all tabs.

2
Reminder 
To enable any installed options, you must specify the Device Option settings. For details, refer to 
"Specifying the configure tab settings" on page 10-21.

Button Function

OK Click this button to close the dialog box and apply any settings that have been 
changed.

Cancel Click this button to cancel any settings that have been changed and close the dia-
log box.

Help Click this button to display the help for each item on the currently displayed dialog 
box.

Add (Favorite Setting) Click this button to save the current settings and to view them at a later time.

Edit (Favorite Setting) Click this button to change the saved settings.

Default Click this button to return the settings to their defaults, which were selected when 
the driver was installed.

View A preview of the page layout as specified in the current settings is displayed and a 
preview image of the print job can be checked.
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Faxtab

Basic tab

Layout tab

Stamp/Composition tab

Configure tab

2
Note 
To display the Configure tab in Windows 2000/XP/NT 4.0/Server 2003, right-click the"GENERIC 45C-
1 FAX" ("GENERIC 45C-2 FAX" on d-Color MF450) icon, and then click "Properties".

You cannot use the [Acquire Device Information] function if you are not connected to or able to 
communicate with this machine.

Item Function

Resolution Specifies the fax resolution.

Print Recipient File Prints the document after the fax was sent.

Timer Send Sets the transmission time. By clicking the [Reflect Current Time] button, the cur-
rent time set on the computer is displayed in the "Send Time" boxes.

SUB Address Specifies the sub address for sending confidential faxes using F-codes. 

Sender ID Specifies the sender ID for sending confidential faxes using F-codes. 

Cover Sheet Specifies the fax cover sheet.

Phone Book Entry Edits the phone book.

Item Function

Original Orientation Specifies the orientation of the original document.

Original Size Specifies the size of the original document.

Paper Size Specifies the output paper size of the recipient. Automatically enlarges or reduces 
when the Original Size setting is changed.

Zoom Specifies the enlargement and reduction ratio.

[Authentication/Account Track] Specifies the user name and password when performing user authentication, and 
the department name and password when performing account track on this ma-
chine.

Item Function

Combination Prints multiple pages on one page, or prints one sheet of an original document di-
vided on multiple pages. Details can be specified by clicking the [Combination De-
tails] button.

Skip Blank Pages Does not print blank pages in the data.

Item Function

Watermark Prints a watermark (text stamp) on the page being printed. Watermarks can be add-
ed, changed, or deleted by clicking the [Edit] button.

Item Function

Device Option Specifies the status of the options that are installed on this machine and the status 
of the user authentication and account track functions. Specify the status of each 
item from the "Setting" drop-down list.

Acquire Device Information Communicates with this machine to read the status of the installed options.

Acquire Settings Specifies the status of the connection that executes getting the option information.
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Settings tab

2
Note 
To display the Settings tab in Windows 2000/XP/NT 4.0/Server 2003, right-click the "GENERIC 45C-1 
FAX" ("GENERIC 45C-2 FAX" on d-Color MF450) icon, and then click "Properties".

Item Function

Display Constraint Message Displays a message when functions that cannot be specified at the same time were 
enabled from the printer driver.

Display paper set in Print Serv-
er Properties

Uses the paper that was added in [Server Properties] of the printer folder.

Verify Authentication settings 
before printing

Verifies the authentication settings for this machine before printing and displays a 
message if the settings are not compatible.

Popup Authentication Dialog 
when printing

Displays the User Authentication/Account Track dialog box when a print job is 
specified to enter the user name and department name.
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10.3 Specifying the fax tab settings

Resolution: Specifies the fax resolution. If the resolution is increased, the transmission time may take longer.

Print Recipient File: Prints the document after a fax was sent. When sending a fax, this function can be 
specified when specifying the transmission settings. For details, refer to "Specifying the transmission 
settings" on page 10-6.

Timer Send: Sets the transmission time. By clicking the [Reflect Current Time] button, the current time set on 
the computer is displayed in the "Send Time" boxes. When sending a fax, this function can be specified when 
specifying the transmission settings. For details, refer to "Specifying the transmission settings" on page 10-6.

SUB Address: Specifies the sub address for sending confidential faxes using F-codes. When sending a fax, 
this function can be specified when specifying the transmission settings. For details, refer to "Specifying the 
transmission settings" on page 10-6.

Sender ID: Specifies the sender ID for sending confidential faxes using F-codes. When sending a fax, this 
function can be specified when specifying the transmission settings. For details, refer to "Specifying the 
transmission settings" on page 10-6.

Cover Sheet: Specifies the fax cover sheet. This function can be specified when sending a fax. For details, 
refer to "Creating a fax cover sheet" on page 10-7.

Phone Book Entry: Edits the phone book. For details, refer to "Adding a recipient to the phone book" on 
page 10-22.

2
Note 
When using Timer Send, check that the time set on the computer is synchronized with the time on this 
machine. If the transmission time is earlier than the current time of this machine, the fax is sent the next 
day.

If sending confidential faxes using F-codes to another fax model, enter the sub address and sender ID 
in the "SUB Address" and the "Sender ID" text boxes. Up to 20 characters (numbers 0 through 9) can 
be entered in the "Sub Address" text box. Up to 20 characters (numbers 0 through 9, #, and *) can be 
entered in the "Sender ID" text box. For the details on the sub address and the sender ID, refer to the 
User manual – Fax Operations (Option).
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10.4 Specifying the basic tab settings

Original Orientation: Specifies the orientation of the original document.

Original Size: Specifies the paper size of the original document.

Paper Size: Specifies the output paper size of the recipient. Automatically enlarges or reduces when the 
Original Size setting is changed.

Zoom: Specifies the enlargement and reduction ratio.

[Authentication/Account Track]: Specifies the user name and password when performing user authentication, 
and the department name and password when performing account track on this machine.

Specifying a custom size

If sending an original document of a custom size, or if the recipient is using a custom paper size, you can 
specify the paper size by following the procedure described below.

1 From the "Original Size" or the "Paper Size" drop-down list, select "Custom Size".

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

– Width: Specifies the width of the custom paper size according to the selected measurement unit.
– Length: Specifies the length of the custom paper size according to the selected measurement unit.
– Unit: Selects the measurement unit that specifies the size.

3 Click the [OK] button.
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Specifying the user authentication settings

If the user authentication settings have been specified on this machine, you must enter a user name and 
password.

2
Reminder 
If a fax is sent using a user name or password that is not a registered account on this machine, or if a 
fax is sent without selecting a user under "User Authentication", the operation is not authenticated by 
this machine and the job is canceled.

If the user authentication settings are specified on this machine and the authentication operation 
restriction function is in mode 2, the applicable user is locked and cannot be accessed if the 
authentication information is not entered correctly.

If the user authentication settings are not specified on the Configure tab, user authentication cannot be 
performed. If using the user authentication function, be sure to specify the settings on the Configure 
tab. For details, refer to "Specifying the configure tab settings" on page 6-32.

1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Select "Recipient User", and then enter the user name and password.

4 Click the [OK] button.

2
Note 
If this machine has been set to permit public users, the machine can be used without a user name and 
password.

If performing user authentication on a server, the server settings must be specified. Click the [Server 
Setting] button to select the server.

Click the [Verify] button to communicate with this machine and to check whether authentication can be 
performed with the user that was entered. You cannot use this function if you are not connected to or 
able to communicate with this machine.

If the usage is not allowed, transmission cannot be performed even when used by a registered user. 
For details on the user authentication function, consult the administrator of this machine.

If performing user authentication with an optional authentication unit (biometric type), enter the user 
name and password in step 3. For details, refer to the operation manual of the authentication unit 
(biometric type).
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Specifying the account track settings

If the account track settings have been specified on this machine, you must enter a department name and 
password.

2
Reminder 
If a fax is sent using a department name or password that is not a registered account on this machine, 
or if a fax is sent without "Account Track" selected, the operation is not authenticated by this machine 
and the job is canceled.

When the account track settings are specified on this machine, the authentication operation restriction 
function is in mode 2, and the authentication information is not entered correctly, the applicable 
account is locked and cannot be accessed.

If the account track settings are not specified on the Configure tab, account track cannot be performed. 
If using the account track function, be sure to specify the settings on the Configure tab. For details, refer 
to "Specifying the configure tab settings" on page 6-32.

1 Click the Basic tab.

2 Click the [Authentication/Account Track] button.

3 Enter the department name and password.

4 Click the [OK] button.

2
Note 
Click the [Verify] button to communicate with this machine and to check whether authentication can be 
performed with the user that was entered. You cannot use this function if you are not connected to or 
able to communicate with this machine.

If usage is not allowed, transmission cannot be performed even when used by a registered account. 
For details on the account track function, consult the administrator of this machine.
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10.5 Specifying the layout tab settings

Combination: Prints multiple pages on one page, or prints one sheet of an original document divided on 
multiple pages. Details can be specified by clicking the [Combination Details] button.

Skip Blank Pages: Does not print blank pages in the data.

Printing multiple pages on one page (N in 1, Poster Mode)

You can specify whether to print multiple pages of text on one page with N in 1 printing, or print one sheet 
of an original document divided on multiple pages with Poster Mode printing.

N in 1 printing comes in handy when you want to reduce the number of output pages.

Poster Mode printing comes in handy when the recipient’s fax machine does not support large paper sizes.

1 Click the Layout tab.

2 Select the "Combination" check box, and then specify the setting from the drop-down list.

To change the "Border" and "Overlap width line" settings, click the [Combination Details] button, and 
then change the settings in the dialog box that appears.
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2
Reminder 
When printing a job that contains pages of different sizes and orientations, images may be missing or 
overlapping when the document is printed.
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10.6 Specifying the stamp/composition tab settings

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 From the list, select the watermark that you want to print.

Editing a watermark

You can change the fonts and position of the watermark and you can register a new one.

1 Click the Stamp/Composition tab.

2 Select the "Watermark" check box.

3 Click the [Edit] button under "Watermark".

The Edit Watermark dialog box appears.

4 To create a watermark, click the [Add] button.
To change a watermark, select the watermark from the "Current Watermark" list.
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5 Specify settings for the following:

– Watermark Name: Enters the name of the watermark.
– Watermark Text: Enters the text that is to be printed as a watermark.
– [Add]: Click to create a new watermark.
– [Delete]: Click to delete the selected watermark.
– Position: Specifies the vertical and horizontal positions. The watermark position can also be 

specified by using the horizontal and vertical sliders in the dialog box.
– Angle: Specifies the watermark print angle.
– Font Name: Specifies the font.
– Size: Specifies the size.
– Style: Specifies the font style.
– Frame: Specifies the frame style.
– Density: Specifies the density of the text.
– Sharing: Specifies whether to register the watermark as public or private.
– Transparent: Prints the watermark as a transparent image.
– 1st Page Only: Prints the watermark on the first page only.
– Repeat: Prints several watermarks on a single page.

6 Click the [OK] button.

2
Note 
Up to 30 watermarks can be registered with the shared setting, and up to 20 watermarks can be 
registered with the private setting.

Only the administrator can select a setting under "Sharing".
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10.7 Specifying the configure tab settings

Selecting an option

You can specify whether an option is enabled so that the functions of this machine are available from the fax 
driver.

2
Reminder 
If the installed options are not set using the Configure tab, the option function cannot be used with the 
fax driver. When installing options, be sure to make the proper settings.

1 For Windows 2000/NT 4.0, click the [Start] button, point to "Settings", and then click "Printers".
For Windows XP/Server 2003, click the [Start] button, and then click "Printers and Faxes".

– If "Printers and Faxes" does not appear in the Start menu, open the Control Panel from the Start 
menu, select "Printers and Other Hardware", and then select "Printers and Faxes".

2 Right-click the "GENERIC 45C-1 FAX" ("GENERIC_45C-2 FAX" on d-Color MF450) icon, and then click 
"Properties".

3 Click the Configure tab.

4 Select the options to be specified under "Device Option".

5 Select the status of the option that is installed from the "Setting" drop-down list.

2
Note 
Click the [Acquire Device Information] button to communicate with this machine and read the status of 
the settings specified on this machine. You cannot use this function if you are not connected to or able 
to communicate with this machine. The connection can be specified by clicking the [Acquire Settings] 
button.
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10.8 Using a phone book

Adding a recipient to the phone book

When sending a fax, you can recall the fax numbers that are used frequently by adding them to a phone book. 
A phone book can be added from the fax tab in the FAX Printing Preferences dialog box.

1 From the fax tab in the FAX Printing Preferences dialog box, click the [Phone Book Entry] button.

The Phone Book Entry dialog box appears.

2 From the left side of the dialog box, select "Personal List", and then click the [Add New] button.

The Personal Information\\Personal List dialog box appears.

3 Enter the appropriate information in the "Name", "Fax Number", "Company", and "Department" text 
boxes.

– If entering a name for a fax cover sheet, titles cannot be added. To add a title to a fax cover sheet, 
add the title in the "Name" text box.

– Up to 80 characters can be entered in the "Name", "Company", and "Department" text boxes.
– Up to 38 characters (numbers 0 through 9, hyphens (-), spaces, #, *, E, P, and T) can be entered in 

the "Fax Number" text box. To send a fax overseas, be sure to enter the country code first.
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– Change the transmission mode as necessary.

ECM: Specifies the ECM (Error Correction Mode). If the "V.34 Mode" check box is selected, the 
"ECM" check box cannot be cleared.
International Transmission Mode: Slows the speed when sending faxes overseas. Select this check 
box if errors occur when sending faxes overseas.
V.34 Mode: Specifies the Super G3 fax mode. For normal fax operations, leave this check box 
selected. Clear it only if it is not possible to transmit in the recipient’s mode.

4 To add a recipient to a group, select the check box of the group to be added.

– If adding a recipient to a group, you can specify the recipient in a group (group transmission). To 
send faxes to specific members, it comes in handy to add them to a group.

– Multiple groups can be selected and added.
– The group name can be changed.

5 Click the [OK] button.

The information of the recipient is registered and it is added to "Personal Information".
If a group was specified, the group that was added also appears in "Group".

6 Click the [OK] button.
If a name was added, the editing of the phone book is complete.
The first time you register a phone book, a dialog box to confirm whether you want to save the phone 
book appears.

7 Click the [Yes] button.

The Save As dialog box appears.

8 Specify the storage location, enter the file name, and then click the [Save] button.

The phone book is saved as a file.
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2
Note 
The Save As dialog box appears when a phone book is registered for the first time. The Save As dialog 
box does not appear from the second time the phone book is changed and thereafter since the phone 
book file is automatically overwritten.

The saved phone book file automatically appears the next time you open the phone book. To open a 
different phone book, select "Open" from the "File" menu in the Phone Book Entry dialog box. If multiple 
phone books have been saved, you can use the phone books by switching between them.

A new phone book can be created by clicking "New" from the "File" menu in the Phone Book Entry 
dialog box. You can save a file under a different name by clicking "Save As" from the "File" menu.

The file extension for the phone book files is ".csv".

Editing a phone book

You can easily change the personal information that was registered, change the group names, edit, or 
organize the phone books.

To change the personal information

% Select the name you want to change from "Personal List" on the left side of the dialog box, and then 
click the [Edit] button on the right. The same Personal Information\\Personal List dialog box that 
appeared when you registered the phone book appears, allowing you to change the information.
– You can select the name that you want to change from "Personal List" on the left side of the dialog 

box, and you can delete a recipient by clicking the [Delete] button on the right. If a recipient is 
deleted, it is also deleted from the registered group.

2
Note 
When sending a fax, the names and fax numbers that were entered manually and registered by clicking 
the [Register To Phone Book] button, appear in the "Simple Entry" folder of the phone book.
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To change a registered recipient to a group

%  From "Personal List" on the left side of the dialog box, select the name you want to change, and then 
select or clear the check box of the group under the "Select Group" drop-down list.

2
Note 
A recipient can even be added to a group by dragging the recipient’s name from "Personal List" on the 
left side of the dialog box to the desired group. However, the name cannot be dragged out of the group.

Up to 100 recipients can be added to a group.

To change a group name

% Select the group that you want to change from "Group" on the left side of the dialog box, and then 
specify "Change Group Name" from the "Edit" menu.

To create a folder

% Select "Personal List" on the left side of the dialog box, and then specify "Add Folder" from the "Edit" 
menu. 
You can move names from "Personal List" by dragging them to a folder.

2
Note 
Names can also be moved to the desired folder by right-clicking a name and selecting "Copy" or "Cut", 
then selecting "Paste" on the target folder.

Up to 40 characters can be entered for the folder name.

A folder can be up to three layers deep.

To edit a folder, select the desired folder, and then click the [Edit] button.

To delete a folder, select the desired folder, and then click the [Delete] button.

To search the personal information

% Click the [Find] button on the left side of the dialog box to display the Find dialog box where the search 
conditions can be specified.
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10.9 Saving the driver settings
You can save the setting values of the changed driver and recall them as necessary.

Saving the driver settings

1 Change the driver settings from the Basic tab and the Layout tab.

2 Click the [Add] button next to the "Favorite Setting" drop-down list.

3 Specify settings for the following:

– Name: Enters the specified registration name.
– Icon: Specifies the icon. The settings can be registered even if the icon is not specified. 
– Sharing: Specifies whether to register the specified file as public or private.
– Comment: Enters the detailed description of the specified file, if necessary.

4 Click the [OK] button.

The specified settings are registered in the "Favorite Setting" drop-down list.
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2
Note 
Up to 30 shared settings and up to 20 private settings can be registered.

Up to 30 characters can be entered in the "Name" text box. Up to 255 characters can be entered in the 
"Comment" text box.

Only the administrator can select a setting under "Sharing".

The settings that were specified can also be saved (exported) to a file. For details, refer to "Importing 
and exporting the driver settings" on page 10-28.

Recalling the settings

Select the settings to recall from the "Favorite Setting" drop-down list on the FAX Printing Preferences dialog 
box.

The setting values are recalled, and the settings for the fax printer driver are changed.

Editing the settings

You can edit the recalled function items such as the specified names and comments. 

1 In the FAX Printing Preferences dialog box, click the [Edit] button next to the "Favorite Setting" drop-
down list.

2 From the list, select the specified name that you want to change, and then change the setting.
To delete a setting, click the [Delete] button.
To switch the order displayed, click the [Up] button or the [Down] button.

3 Click the [Option] button, select the check box of the function that you want to recall, and then click the 
[OK] button.
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4 Click the [OK] button.

2
Note 
The specified settings of the driver functions cannot be changed.

Importing and exporting the driver settings

You can also save (export) or read (import) the settings that were specified to a file. This comes in handy when 
you want to use the same settings on another computer.

1 In the FAX Printing Preferences dialog box, click the [Edit] button next to the "Favorite Setting" drop-
down list.

2 From the list, select the specified name that you want to export, and then click the [Export] button.

The dialog box to save the specified file appears.

3 Specify the location to save the file and enter the file name.

4 Click the [Save] button.

The specified file is created. The file extension is ".KSF".

2
Note 
To read the specified file that was saved in the "Favorite Setting" drop-down list, click the [Import] 
button and specify the file.
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11 Various settings

11.1 Print settings in utility mode
You can change the settings of the printer functions in this machine’s control panel.

Default settings

To display the user settings screen

1 Press the [Utility/Counter] key.

2 Touch [2 User Settings].

The User Settings screen appears.
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2
Note 
An item can also be selected by pressing the key in the keypad for the number beside the desired 
button. 
For [2 User Settings], press the [2] key in the keypad.

To quit specifying the Utility mode settings, press the [Utility/Counter] key. Otherwise, cancel the Utility 
mode by touching [Close] in each screen until the screen for the Copy, Fax/Scan, or Box mode appears.

To return to the Utility screen, touch [Close] until the desired screen appears. You can also touch the 
menus in the left panel to return to the Utility screen.

PDL setting

You can specify the PDL (Page Description Language) setting. (Default setting: Auto)
- Auto: Automatically switches between PCL and PS.
- PCL: Only uses PCL.
- PS: Only uses PS.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [1 Basic Settings].
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3 Touch [PDL Setting].

4 Touch the button for the desired setting.
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Number of copies

You can specify the default number of copies when no setting has been specified from the printer driver. 
(Default setting: 1)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [1 Basic Setting].

3 Touch [Number of Copies].

4 Press the [C] (clear) key to erase the value, and then use the keypad to type in the default number of 
copies (between 1 and 999 sets).

– If a value outside of the allowable range is specified, the message "Input Error" appears. Type in a 
value within the allowable range.

5 Touch [OK].

The default number of copies is set.
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Original direction

You can specify the default image orientation. (Default setting: Portrait)
- Portrait: Prints the image vertically on the page.
- Landscape: Prints the image horizontally on the page.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [1 Basic Setting].

3 Touch [Original Direction].

4 Touch the button for the desired setting.
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Spool setting

You can specify whether or not a spool is used. (Default setting: ON)
- ON: When the next job is received while processing a job, the print data is stored in the HDD.
- OFF: The print data is not stored in the HDD.

2
Reminder 
Be sure not to change the setting to "OFF". Printing may not be possible.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [1 Basic Setting].

3 Touch [Spool Print Jobs in HDD before RIP].

4 Touch the button for the desired setting.
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Paper size change

You can specify whether similar paper sizes 8-1/2 e 11 and A4, and 11 e 17 and A3 are substituted for each 
other when there is no paper of the size specified with the printer driver. (Default setting: OFF)

2
Reminder 
The image may be defected since printing is forced.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [1 Basic Setting].

3 Touch [A4/A3 <=> LTR/LGR Auto Switch].

4 Touch the button for the desired setting.
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Banner sheet setting

You can specify whether to print banner pages (cover pages) with the sender of the print job and title. (Default 
setting: OFF)
- ON: Prints banner pages.
- OFF: Does not print banner pages.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [1 Basic Setting].

3 Touch  or , and then touch [Banner Sheet Setting].

4 Touch the button for the desired setting.
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Binding direction adjustment

You can specify whether to adjust the binding position for duplex printing. (Default setting: Finishing Priority)

If you want to increase the print efficiency, select "Productivity Priority". If the desired binding position and 
width cannot be achieved, select "Finishing Priority".
- Finishing Priority: Adjusts the binding position to the most suitable position after all of the print data is 

received by this machine.
- Productivity Priority: Printing is performed efficiently because the data is printed simultaneously as it is 

being received.
- Control Adjustment: Follows the settings specified in the printer driver without adjusting the binding 

position.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [1 Basic Setting].

3 Touch  or , and then touch [Binding Direction Adjustment].

4 Touch the button for the desired setting.
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Paper tray

You can specify the input tray to use when none has been specified from the printer driver. (Default setting: 
Auto)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [2 Paper Setting].

3 Touch [Paper Tray].

4 Touch the button of the desired paper tray.

– To select the paper tray automatically, touch [Auto].

5 Touch [OK].
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Paper size

You can specify the paper size to use when no setting has been specified from the printer driver. (Default 
setting: 8-1/2 e 11)

2
Note 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [2 Paper Setting].

3 Touch [Paper Size].

4 Touch the button for the desired setting.

– To select other paper sizes, touch  or  to switch the pages.

5 Touch [OK].
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2-sided print

You can specify the default duplex printing setting. (Default setting: OFF)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [2 Paper Setting].

3 Touch [2-Sided Print].

4 Touch the button for the desired setting.
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Binding position

You can specify the default binding position for duplex printing. (Default setting: Left Bind)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [2 Paper Setting].

3 Touch [Binding Position].

4 Touch the button for the desired setting.
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Staple

You can specify the staple settings. (Default setting: OFF)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [2 Paper Setting].

3 Touch [Staple].

4 Touch the button for the desired setting.

2
Reminder 
The staple function is available only when the optional finisher is installed.
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Punch

You can specify the hole punching settings. (Default setting: OFF)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [2 Paper Setting].

3 Touch  or , and then touch [Punch].

4 Touch the button for the desired setting.

2
Reminder 
The hole punch function is available only when the punch kit is installed on the optional finisher.
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Banner paper tray

You can specify the paper tray to be used for banner page printing. (Default setting: Auto)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [2 Paper Setting].

3 Touch  or , and then touch [Banner Paper Tray].

4 Touch the button for the desired setting.
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Font settings

You can specify the font to use when no setting has been specified from the printer driver. (Default setting: 
Courier)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [3 PCL Settings].

3 Touch [1 Font Settings].

4 Touch [Resident Font].

– If downloaded fonts are available, [Download Font] can also be selected.
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5 Touch the button for the desired setting.

– Touch  or  to switch the pages, and then touch the button for the desired setting.
– You can check the selected font number and font size units.

6 Touch [OK].
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Symbol set

You can specify the font symbol set to use when no setting has been specified from the printer driver. (Default 
setting: Depends on the location.)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [3 PCL Settings].

3 Touch [2 Symbol Set].

4 Touch the button for the desired setting.

– Touch  or  to switch the pages, and then touch the button for the desired setting.

5 Touch [OK].
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Font size

You can specify the font size to use when no setting has been specified from the printer driver. (Default 
settings: Scalable Font - 12.00 point; Bitmap Font - 10.00 pitch)
- Scalable Font: Specifies the font size in points.
- Bitmap Font: Specifies the width of the fixed-width font in pitches.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [3 PCL Settings].

3 Touch [3 Font Size].

4 Press the [C] (clear) key to erase the value, and then use the keypad to type in the default font size 
(Scalable Font: between 4.00 and 999.75 points; Bitmap Font: between 0.44 and 99.00 pitches).

– If a value outside of the allowable range is specified, the message "Input Error" appears. Type in a 
value within the allowable range.

5 Touch [OK].

The font size is set.
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Line/Page

You can specify the number of lines per page when printing text. (Default setting: Depends on the location.)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [3 PCL Settings].

3 Touch [4 Line/Page].

4 Press the [C] (clear) key to erase the value, and then use the keypad to type in the default number of 
lines (between 5 and 128).

– If a value outside of the allowable range is specified, the message "Input Error" appears. Type in a 
value within the allowable range.

5 Touch [OK].

The number of lines per page is set.
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CR/LF mapping

You can specify the data substitution method when printing text data. (Default setting: OFF)
- [Mode 1]: Substitutes CR for CR-LF.
- [Mode 2]: Substitutes LF for CR-LF.
- [Mode 3]: Substitutes to CR-LF.
- [OFF]: Does not perform substitution.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [3 PCL Settings].

3 Touch [5 CR/LF Mapping].

4 Select [Yes] or [No]. If [Yes] is selected, be sure to also touch the button for the desired setting.

5 Touch [OK].
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Print PS errors

You can specify whether to print the error message when an error occurs during PS rasterization. (Default 
setting: OFF)

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [4 PS Setting].

3 Touch [Print PS Errors].

4 Touch the button for the desired setting.
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Print reports

You can output the following four types of reports. The report output method here is explained in the PCL 
font list.
- Configuration Page: Outputs a list of this machine’s settings.
- Demo Page: Outputs a test page.
- PCL Font List: Outputs the PCL font list.
- PS Font List: Outputs the PS font list.

!
Detail 
For details on displaying the User Settings screen, refer to "To display the user settings screen" on 
page 11-3.

1 In the User Settings screen, touch [5 Printer Settings].

2 Touch [5 Print Reports].

3 Touch the button for the desired setting.
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4 Touch the button for the desired paper tray and touch [1-Sided] or [2-Sided].

5 To print a report, touch [Start] or press the [Start] key.
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11.2 Print settings in administrator mode

To display the administrator settings screen

1 Press the [Utility/Counter] key.

2 Touch [3 Administrator Settings].

3 Enter the password, and then touch [OK].

– In the Utility mode, an item can also be selected by pressing the key in the keypad for the number 
beside the desired button. For [3 Administrator Settings], press the [3] key in the keypad.

– For details on setting or changing the password, refer to the User manual – Copy Operations.
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The Administrator Settings screen appears.

2
Note 
To quit specifying the Utility mode settings, press the [Utility/Counter] key. Otherwise, cancel the Utility 
mode by touching [Close] in each screen until the screen for the Copy, Fax/Scan, or Box mode appears.

To return to the Utility screen, touch [Close] until the desired screen appears. You can also touch the 
menus in the left panel to return to the Utility screen.

Print/Fax output setting

You can specify whether to print data after it is received or to print it simultaneously as it is being received.

You can specify this function for the printer and for faxing. (Default settings: Printer - Page Print; Fax - Batch 
Print)

2
Reminder 
To display the Administrator Settings screen, refer to "To display the administrator settings screen" on 
page 11-28.

1 In the Administrator Settings screen, touch [1 System Settings].

2 In the Systems Settings screen, touch [2 Output Settings].

3 In the Output Settings screen, touch [1 Print/Fax Output Settings].

– If the "Administrator Security Level" parameter is set to "Level 2", users can also specify this setting. 
Touch [User Settings], [System Settings], [Output Settings], then [Print/Fax Output Settings] to 
display the Print/Fax Output Settings screen.

– For details on the user access levels, refer to the User manual – Copy Operations.
The Print/Fax Output Settings screen appears.
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4 Touch [Print] or [Fax].

The buttons for the available settings appear.

5 Touch the button for the desired setting.

The timing the data is printed is set.

2
Note 
If "Batch Print" is selected, printing starts when all the data is received and the print job is queued. If 
"Page Print" is selected, printing starts when the data for the first page is received and the print job is 
queued.

Output tray setting

You can specify the output tray to use when none has been specified from the printer driver. (Default setting: 
Printer - Tray 1)

!
Detail 
To display the Administrator Settings screen, refer to "To display the administrator settings screen" on 
page 11-28.

1 In the Administrator Settings screen, touch [1 System Settings].

2 In the System Settings screen, touch [2 Output Settings].

3 In the Output Settings screen, touch [2 Output Tray Settings].

The Output Tray Settings screen appears.

4 Touch the button for the desired setting.

The output tray is set.
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To delete secure print documents

All saved secure print documents can be deleted.

1 In the Administrator Settings screen, touch [1 System Settings].

2 In the Systems Settings screen, touch [0 User Box Settings].

3 In the User Box Settings screen, touch [2 Delete Secure Print Documents].

4 To delete the secure print documents, touch [Yes].

5 Touch [OK].
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To specify the "Secure Print Document Delete Time Setting" parameter

The length of time for deleting a secure document after it is saved can be specified.

1 In the Administrator Settings screen, touch [1 System Settings].

2 In the System Settings screen, touch [0 User Box Settings].

3 In the User Box Settings screen, touch [3 Auto Delete Secure Document].

4 Select [Yes] or [No]. If [Yes] is selected, be sure to also select the time until the secure document is 
deleted.

5 Touch [OK].
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Printing without specifying the authentication setting

You can specify whether to allow print jobs without a specified user name or password to be printed when 
this machine is performing User Authentication or Account Track. (Default setting: Restrict)
- Allow: Allows print jobs to be printed when a user name and password for User Authentication, or a 

department name and password for Account Track are not specified. The print job is counted as a 
public job.

- Restrict: Restricts print jobs to be printed when a user name and password for User Authentication, or 
a department name and password for Account Track are not specified.

2
Reminder 
If print jobs are allowed to be printed when authentication is not specified, printing is performed even 
if User Authentication or Account Track is not specified in the printer driver and this machine is 
performing User Authentication or Account Track. Select [Restrict] if you want control usage or for 
security reasons.

!
Detail 
To display the Administrator Settings screen, refer to "To display the administrator settings screen" on 
page 11-28.

Even if "Allow" or "Restrict" is specified, a job is not printed and it is canceled if the user name or 
password, or department name or password that is specified to the job is incorrect.

1 In the Administrator Settings screen, touch [4 User Authentication/Account Track].

2 In the User/Account screen, touch [Print without Authentication].

3 Touch the button for the desired setting.

The print without authentication setting is set.



11 Various settings

11-34 d-Color MF550/MF450

I/F timeout

You can set the time until a communication timeout occurs for the USB or network interface. (Default setting: 
60 sec.)

!
Detail 
To display the Administrator Settings screen, refer to "To display the administrator settings screen" on 
page 11-28.

1 In the Administrator Settings screen, touch [7 Printer Settings].

2 In the Printer Settings screen, touch the button of the desired interface setting.

3 Press the [C] (clear) key to erase the value, and then use the keypad to type in the default length of time 
(between 10 and 1000 seconds).

– If a value outside of the allowable range is specified, the message "Input Error" appears. Type in a 
value within the allowable range.

4 Touch [OK].

The time until a communication timeout occurs is set.
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Print data capture

You can specify whether to allow or prohibit data capturing of a print job. (Default setting: Allow)

!
Detail 
To display the Administrator Settings screen, refer to "To display the administrator settings screen" on 
page 11-28.

For details on capturing a print job, consult a service technician.

1 In the Administrator Settings screen, touch [Security Settings].

2 In the Security Settings screen, touch [4 Security Details].

3 In the Security Details screen, touch [Print Data Capture].

The buttons for the available settings appear.

4 Touch the button for the desired setting.

The capturing of a print job is either allowed or prohibited.

2
Note 
For details on capturing a print job, consult a service technician.
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11.3 Print job management

Specifying job operations

You can specify the job operations on this machine by setting a printer driver.

2
Note 
The three printer drivers that can be set on this machine are as follows:
Generic PCL Printer Driver for Windows
Generic PostScript Printer Driver for Windows
Generic PostScript PPD Printer Driver for Mac OS X

Specifying settings (for Windows)

1 Click the [Properties] button on the Print dialog box to open the printer driver setup dialog box.

2 Click the Basic tab.

3 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Enters the ID and password in the dialog box that appears and saves the print 

document in "Secure Print User Box" on this machine. When printing, you are required to enter the 
ID and password in this machine’s control panel. Select when printing highly confidential 
documents.

– Save in User Box: Enters the file name and box number in the dialog box that appears, and saves 
the document to be printed in a box on this machine.

– Save in User Box and Print: Saves the document in a box and prints at the same time.
– Proof Print: After a part of the document has been printed, this machine stops printing temporarily. 

Select to avoid misprinting a large volume of print jobs.

!
Detail 
For details, refer to "Selecting the output method" on page 6-10 and page 7-11.
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Specifying settings (for Mac OS X)

1 From the [File] menu, select "Print".

2 Select "Output Method".

3 From the "Output Method" drop-down list, select the output method.

– Print: Prints immediately.
– Secure Print: Enters the ID and password in the dialog box that appears and saves the print 

document in "Secure Print User Box" on this machine. When printing, you are required to enter the 
ID and password in this machine’s control panel. Select when printing highly confidential 
documents.

– Save in User Box: Enters the file name and box number in the dialog box that appears, and saves 
the document to be printed in a box on this machine.

– Save in User Box and Print: Saves the document in a box and prints at the same time.
– Proof Print: After a part of the document has been printed, this machine stops printing temporarily. 

Select to avoid misprinting a large volume of print jobs.

!
Detail 
For details, refer to "Output method" on page 9-10.
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Job storage

When "Output Method" in the printer driver is selected, a print document can be stored in this machine as a 
print job.

To print a stored job, you must recall the job using this machine’s control panel.

Recalling jobs (proof print)

!
Detail 
For details on using the keys in the control panel, refer to the User manual – Copy Operations.

For details on the box functions of this machine, refer to the User manual – Box Operations.

1 Touch [Job List] in this machine’s control panel, then [Job Details].

The print screen appears.

2 With [Current Jobs] displayed, touch [Release Held Job].

The Release Held Job screen appears.
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3 From the job list, select the job you want to print.

– To print the remaining jobs, skip to step 7.
– To check the print results again, continue to step 4.
– To change the printing conditions, skip to step 5.

4 To check the print results, select the job whose sample copy is to be printed from the job list, and then 
press the [Proof Copy] key in the control panel.

– Check the print results on the printed pages.

5 Touch [Change Setting].

– If the job to be removed from the Release Held Job list is not displayed, touch  or  until the 
desired job is displayed.

– If an incorrect job was selected, touch the button for the selected job again to deselect it.
The Change Settings screen appears.

6 Change the printing conditions on the Change Settings screen, and then touch [OK].

The Release Held Job screen appears again.

7 Touch [OK] or press the [Start] key in the control panel.

– To cancel printing the job, touch [Cancel].
The stored job is changed to an active job, then printed.

Recalling jobs (secure print)

"Secure Print" jobs are saved in "Secure Print User Box". To print a secured document, the ID and password 
that were specified in the printer driver are required.

!
Detail 
For details on using the keys in the control panel, refer to the User manual – Copy Operations.

For details on the box functions of this machine, refer to the User manual – Box Operations.

2
Note 
Secured documents are automatically deleted after a set length of time after they are registered. The 
default setting of this time is specified as 1 day, and the setting can be specified in the administrator 
mode. For details, refer to "To specify the "Secure Print Document Delete Time Setting" parameter" on 
page 11-32.

A secure document that was printed can be deleted manually in the Administrator mode. For details, 
refer to "To delete secure print documents" on page 11-31.

For details on specifying a setting for "Secure Document Access Method", refer to the User manual – 
Copy Operations.
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When "Secure Document Access Method" is set to "Mode 1"

1 Press the [Box] key in this machine’s control panel, and then touch [Use Document].

2 Select [System User Box], then [Secure Print User Box], and then touch [OK].

3 Type in the ID for the secure print document, and then touch [OK].
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4 Type in the password for the secure print document, and then touch [OK].

If the specified ID and password match, the secure print document list appears.

5 Select the document to be printed, and then touch [Print].

– The contents and a preview of the document can be checked by touching [Document Details].

6 If necessary, change the print conditions.

7 Touch [Start] or press the [Start] key in the control panel.

– To cancel printing the job, touch [Cancel].
The document is printed.
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When "Secure Document Access Method" is set to "Mode 2"

1 Press the [Box] key in this machine’s control panel, and then touch [Use Document].

2 Select [System User Box], and then touch [Secure Print User Box].

3 Type in the ID for the secure print document, and then touch [OK].

If the specified ID matches, the secure print document list appears.
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4 Select the document to be printed, and then touch [Enter Password].

– The contents and a preview of the document can be checked by touching [Document Details].

5 Type in the password for the secure print document, and then touch [OK].

If the specified password matches, the security print document list appears.

6 Select the document to be printed, and then touch [Print].

7 If necessary, change the print conditions.

– If "Prohibit Functions when Auth. Error" in Administrator mode is set to "Mode 2" and an incorrect 
document password is entered the specified number of times, the selected document is locked. 
Contact the administrator to cancel operation restrictions.

8 Touch [Start] or press the [Start] key in the control panel.

– To cancel printing the job, touch [Cancel].
The document is printed.
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Recalling jobs (save in user box)

"Save in User Box" and "Save in User Box and Print" jobs are saved in a box of the specified number.

To print a document saved in a box, open the specified box to remove the document. If a password is 
specified to a box, the box password is required.

!
Detail 
For details on using the keys in the control panel, refer to the User manual – Copy Operations.

For details on the box functions of this machine, refer to the User manual – Box Operations.

2
Note 
Box documents are automatically deleted after a set length of time after they are registered. The default 
setting of this time is specified as 1 day, and the setting can be specified when creating the box.

1 Press the [Box] key in this machine’s control panel, and then touch [Use Document].

2 Select the desired box number, and then touch [OK].
Boxes are classified as public, private, or group. Specify the desired box from the classification of the 
saved box.
The box number can be specified manually.

– If a password is specified to a box, continue to step 3.
– If a password is not specified to a box, skip to step 4.
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3 Type in the password for the box, and then touch [OK].

The specified box document list appears.

4 Select the document to be printed, and then touch [Print].

5 If necessary, change the print conditions.

6 Touch [Start] or press the [Start] key in the control panel.

– To cancel printing the job, touch [Cancel].
The document is printed.
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Printing with this machine when user authentication settings have been applied

When the user authentication function has been specified on this machine, a user name and password must 
be entered when printing.

2
Reminder 
If a print job is sent using a user name or password that is not a registered account on this machine or 
if a job is sent without specifying "User Authentication", the operation is not authenticated by this 
machine and the job is canceled.

When the user authentication settings are specified on this machine, the authentication operation 
restriction function is in mode 2, and the authentication information is not entered correctly, the 
applicable user is locked and cannot be accessed.

The three printer drivers that can be set on this machine are as follows:
Generic PCL Printer Driver for Windows
Generic PostScript Printer Driver for Windows
Generic PostScript PPD Printer Driver for Mac OS X

2
Note 
If printing is not allowed, printing cannot be performed even when used by a registered user.
For the user authentication details, consult the administrator of this machine.

If performing user authentication with an optional authentication unit (biometric type), enter the user 
name and password. For details, refer to the operation manual of the authentication unit (biometric 
type).

Specifying settings (for Windows)

1 Click the [Properties] button or the [Preferences] button on the Print dialog box to display the Printing 
Preferences dialog box.

2 Click the Basic tab.

3 Click the [Authentication/Account Track] button.

4 Select "Recipient User", and then enter the user name and password.

– If this machine has been set to permit public users, the machine can be used without a user name 
and password.

– A default password can be registered and used rather than entering a password for each job.
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5 After specifying the settings, click the [OK] button to begin printing.

– If the entered user name is a name registered on this machine, the job is printed and counted as a 
job for the specified user.

Specifying settings (for Mac OS X)

1 From the [File] menu, select "Print".

2 Select "Output Method".

3 Select the "User Authentication" check box.

4 Select "Recipient User", and then enter the user name and password.

– If this machine has been set to permit public users, the machine can be used without a user name 
and password.
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Printing with this machine when account track settings have been applied

When the account track settings have been specified on this machine, you must enter a password when 
printing a job.

2
Reminder 
If a print job is sent using a password that is not a registered account on this machine or if a job is sent 
without specifying "Account Track", the operation is not authenticated by this machine and the job is 
canceled.
When the account track settings are specified on this machine, the authentication operation restriction 
function is in mode 2, and the authentication information is not entered correctly, the applicable 
account is locked and cannot be accessed.

The three printer drivers that can be set on this machine are as follows:
Generic PCL Printer Driver for Windows
Generic PostScript Printer Driver for Windows
Generic PostScript PPD Printer Driver for Mac OS X

2
Note 
If printing is not allowed, printing cannot be performed even when used by a registered account.

For the account track details, consult the administrator of this machine.

Specifying settings (for Windows)

1 Click the [Properties] button or the [Preferences] button on the Print dialog box to display the Printing 
Preferences dialog box.

2 Click the Basic tab.

3 Click the [Authentication/Account Track] button.

4 Enter the department name and password.

– A default password can be registered and used rather than entering a password for each job.

5 After specifying the settings, click the [OK] button to begin printing.

If the entered department name is a name registered on this machine, the job is printed and counted 
as a job for the account.
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Specifying settings (for Mac OS X)

1 From the [File] menu, select "Print".

2 Select "Output Method".

3 Select the "Account Track" check box.

4 Enter the department name and password.

Job operations on Web Connection

From Web Connection, you can also check the status of the job being performed by this machine.

!
Detail 
For details, refer to the User manual – Web Connection Operations.
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11.4 Printing on banner paper (d-Color MF450)
Paper up to 1200 mm (47-1/4 inch) long can be loaded into the bypass tray and printed on using this machine 
with the appropriate setting specified from the control panel.

Loading banner paper and printing on it is referred to as "banner printing" throughout the manual.

Paper types

2
Note 
Feed only one sheet of paper at a time.

Printer drivers and supported operating systems

The following drivers are compatible with banner paper printing.

To specify printer driver settings

Specify the paper sizes to be printed as custom sizes.

1 Click the Basic tab.

2 From the "Original Size" or "Paper Size" drop-down list, select "Custom Size".

The Custom Size Settings dialog box appears.

3 Specify the width and length of the custom size according to the selected measurement units.

4 Specify "Paper Type".

– Specify other settings if necessary.

5 Click the [OK] button.

2
Note 
For the Generic PCL driver, the custom size settings can also be specified on the Settings tab of the 
printer driver, which can be displayed from the Printers window (for Windows XP/Server 2003, Printers 
and Faxes window).

Paper width Paper length Paper type

210 to 297 mm 
(8-1/4 to 11-3/4 inch)

457.3 to 1200 mm 
(18 to 47-1/4 inch)

Thick 3, Thick 3 + (Duplex Side2)
(210 g/m2 to 256 g/m2)

Page description lan-
guage

Printer driver Supported operating systems

PCL (PCL XL) Generic PCL Driver
(PCL Driver)

Windows NT 4.0, Windows 2000 Professional, Windows 
XP Home Edition, Windows XP Professional, and Win-
dows Server 2003

PostScript 3 Emulation Generic PostScript Driv-
er
(PS Driver)

Windows 2000 Professional, Windows XP Home Edition, 
Windows XP Professional, and Windows Server 2003
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To print

1 Press the [Utility/Counter] key in the control panel.

2 Touch [6 Banner Printing].

3 Touch [Allow], and then touch [OK].

4 Select a job to be printed from the computer, and then click "Print" on the "File" menu.

5 Specify the desired settings, and then click the [OK] button.

6 Open the bypass tray.

7 With the side to be printed on facing down, insert the paper as much as possible into the feed slot.

8 Slide the lateral guides to fit the size of paper being loaded.

– Load one sheet at a time.
– Print while supporting the loaded paper with your hands.
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9 When printing is finished, touch [Exit].

– To continue printing, repeat steps 7 through 8.

10 Touch [Yes], and then touch [OK].
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12 Troubleshooting

12.1 Unable to print
This chapter explains the troubleshooting procedures for possible malfunctions.

Perform the troubleshooting procedures described below if this machine does not print after you have sent 
a print job.

If the problem persists after all of these procedures have been performed, read the User manual – Copy 
Operations.

Symptom Probable cause Action

The message "No printers 
are connected." or "Print 
error" appears.

The printer driver selected for printing is 
not compatible with the printer controller.

Check the printer name selected.

The network cable, or USB cable is dis-
connected.

Check that the cable is connected prop-
erly.

An error has occurred in this machine. Check this machine’s control panel.

Available memory space is not sufficient. Perform a test print to check whether 
printing is possible.

The network cable, or USB cable is dis-
connected.

Check that the cable is connected prop-
erly.

An error has occurred in this machine. Check this machine’s control panel.

A postscript error appears. Available computer memory space is not 
sufficient.

Perform a test print to check whether 
printing is possible.

There is an error in the application soft-
ware settings.

Refer to the users manual of the applica-
tion software to check the settings.

The file printing settings are incorrect. Change the settings and try to print again.

The machine does not start 
printing although the print 
job was completed on the 
computer.

The printer driver selected for printing is 
not compatible with the printer controller.

Check the printer name selected.

The network cable, or USB cable is dis-
connected.

Check that the cable is connected prop-
erly.

An error has occurred in this machine. Check this machine’s control panel.

A print job is queued in this machine, de-
laying printing.

Check the job order on the Active Jobs 
list of the machine’s control panel.

"Save in User Box" was selected for the 
print job.

Check if the print job is stored on the Box 
screen of this machine’s control panel.

"Secure Print" was selected for the print 
job.

Check if the print job is held on the Se-
cure Print User Box screen of this ma-
chine’s control panel.

If the account track settings have been 
applied, an unregistered department 
name (or password) may have been en-
tered.

Enter the correct department name (or 
password).

If the authentication settings have been 
applied, an unregistered user name (or 
password) may have been entered.

Enter the correct user name (or pass-
word).

Available computer memory space is not 
sufficient.

Perform a test print to check whether 
printing is possible.

The connection of this machine to the 
network is not yet established (while con-
necting to a network).

Consult with the network administrator.

The enhanced security mode may be en-
abled on this machine.

Specify the authentication settings in the 
enhanced security mode. For details, 
consult with the network administrator.
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12.2 Unable to specify desired settings or unable to print as specified
Perform these troubleshooting procedures if you cannot specify the desired settings in the printer driver, or 
if the print results do not represent the settings that have been specified.

2
Note 
Some of the printer driver functions cannot be combined with other functions.

Symptom Probable cause Action

A printer driver setting can-
not be selected.

Some functions cannot be combined. Do not try to select settings that are not 
available.

The "Conflicts" message 
with "Unable to Select" or 
"Function Canceled" ap-
pears.

An incorrect combination of functions has 
been specified.

Check the settings and specify the func-
tions correctly.

Printing is not performed 
as specified.

Incorrect settings are specified. Check each setting in the printer driver.

A combination of functions, although 
possible in the printer driver, is not possi-
ble with this machine.

The paper size, orientation, and other set-
tings specified in the application have pri-
ority over those specified in the printer 
driver.

Enter the correct settings in the applica-
tion.

The watermark cannot be 
printed.

The watermark is not correctly set. Check the watermark settings.

The watermark density is set to a level 
that is too low.

Check the density settings.

Watermarks cannot be printed in graph-
ics applications.

No watermark can be printed in this case.

The staple function cannot 
be specified.

Stapling is not possible if "Paper Type" is 
set to "Thick" or "Transparency".

Check each setting in the printer driver.

The staple function requires optional fin-
isher.

Install the required optional finisher and 
enable it using the printer driver.

Stapling cannot be per-
formed.

If are a large number of pages to be print-
ed, stapling cannot be performed. 

Change the number of pages to be print-
ed.

Stapling is not possible if the document 
contains pages of different sizes.

Check the document.

The stapling position is not 
as expected.

The orientation setting is not correct. Check the stapling position in the printer 
driver setup dialog box.

The hole punch function 
cannot be specified.

Hole punching cannot be specified if 
"Booklet", "Transparency", "Thick2", 
"Thick3", or "Envelope" is selected.

Check each setting in the printer driver.

Optional finishers and punch kit are re-
quired.

Install the required optional finisher and 
enable it using the printer driver.

The pages are not 
punched.

Printed pages may be fed out without be-
ing punched if the paper is loaded into the 
paper source with an incorrect orienta-
tion.

Check the orientation setting.

The hole punch position is 
not as expected.

The orientation setting is not correct. Check the punch position in the printer 
driver setup dialog box.

The overlay is not printed 
properly.

Available computer memory space is not 
sufficient.

Simplify the overlay to reduce the data 
size.

The image is not printed 
properly.

Available computer memory space is not 
sufficient.

Simplify the image to reduce the data 
size.

Paper is not fed from the 
specified paper source.

Paper will not be fed from the specified 
paper source if that paper source is load-
ed with paper of a different size or orien-
tation.

Load the paper source with paper of the 
appropriate size and orientation.
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12.3 Error message

Message Cause and remedy

Cannot connect to the net-
work.

A connection to the network could not be established.
Check if the network cable is correctly connected. In addition, check that the Net-
work Setting parameters on the Administrator Setting screen have been correctly 
specified.
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13.1 Specifications

Item Specifications

Model Built-in printer controller

Power supply Common with the main body

RAM 1024 MB

Hard disk 60 GB

Interface Standard: Ethernet (10Base-T/100Base-TX/1000Base-T) 
USB 2.0

Frame type Ethernet 802.2
Ethernet 802.3
Ethernet II
Ethernet SNAP

Supported protocols TCP/IP
IPX/SPX
NetBEUI
AppleTalk (EtherTalk)

Print speed 45 pages/minute (color, 8-1/2 e 11 v paper, and simplex) 
45 pages/minute (color, 8-1/2 e 11 v paper, and duplex)

Fast print time 6.5 seconds or less (color and A4 paper) 
d-Color MF550: 4.3 seconds or less (monochrome and A4 paper)
d-Color MF450: 4.8 seconds or less (monochrome and A4 paper)

Printer language PCL5c 
PCL6 (XL 3.0) Emulation 
PostScript 3 Emulation (3015)

Operating environment conditions Temperature 10 to 30°C
Humidity 15 – 85% RH

Resolution Data processing 600 e 600 dpi (printing and fax operations) 
400 e 400 dpi (fax operations) 
200 e 200 dpi (fax operations)

Printing 1800 (equivalent) e 600 dpi 

Supported paper sizes Maximum Standard Size

Printer fonts PCL Latin 80 Fonts
Postscript 3 Emulation Latin 137 Fonts

Compatible computers IBM PC or compatible, and Macintosh (PowerPC or Intel Processor)

Supported op-
erating sys-
tems

Server Windows NT 4.0 (SP6a), Windows 2000 Server, or Windows Server 2003

Client d-Color MF550: Windows 98 Second Edition, Windows Me
d-Color MF550/MF450: Windows 2000, Windows XP, or Windows NT 4.0 
(SP6a) 
MacOS 9.2 or later or MacOS X 10.2, 10.3 or 10.4

Printer driver PCL6:
• Windows 2000, Windows XP (Home/Professional), or Windows Serv-

er 2003 Printer Driver
• Windows XP Professional x64, Windows Server 2003 x64 Printer 

Driver
• Windows NT 4.0 Printer Driver
PS3: 
• Windows 2000, Windows XP (Home/Professional), Windows Server 

2003 Printer Driver
• Windows XP Professional x64, Windows Server 2003 x64 Printer 

Driver
• MacOS 9.2 PPD File
• MacOS X 10.2 Printer Driver
• MacOS X 10.3 or MacOS X 10.4 Printer Driver
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Utility Web Connection 
Web browsers:
Microsoft Internet Explorer 6 or later recommended (JavaScript enabled, 
Cookies enabled)
Microsoft XML Parser MSXML3.X must be installed when using Internet 
Explorer 5.5.
Netscape Navigator 7.02 or later (JavaScript enabled, Cookies enabled)
Mozilla Firefox 1.0 or later (JavaScript enabled, Cookies enabled)
Adobe® Flash® (If "Flash" is selected in View Mode, version 7.0 or later 
plugin is required.)

MetaFrame operating environment This driver performs the confirmation of the operation only in the following 
environments.
Server operating systems: Windows 2000 Advanced Server/Windows 
2003 Enterprise Server
MetaFrame: Citrix® MetaFrame® Presentation Server 3.0/Citrix® Meta-
Frame® Presentation Server 4.0
Client operating systems: Windows 2000/Windows XP
ICA Client: 32 bit
* For operating in an environment other than those described above, con-
sult the dealer.

Item Specifications
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13.2 Configuration page



13 Appendix

13-6 d-Color MF550/MF450

13.3 Font list

PCL font list
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PS font list
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Demo page
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13.4 PPD driver (Linux and applications)

PPD driver types

The PPD driver contains the PPD information for Mac OS 9, Linux, and applications.
- For Linux: Install the driver when using with Linux. (The PPD driver for Linux and the PPD driver for 

OpenOffice are included.)
- For applications: Install the driver when using applications such as Adobe PageMaker that require the 

PPD driver.

About the PPD driver for Linux

Operating environment
- Supported operating systems: Red Hat Linux 9/SuSe Linux 8.2
- Supported PostScript level: 3.0
- CUPS: 1.1.17

To register the PPD driver for Linux

1 Copy the PPD file to the CUPS model directory. (/usr/share/cups/model when mainly Linux)

2 In CUPS Printing System, click the [Add Printer] button, and then specify PPD to add this machine.

2
Note 
For details on CUPS, click the [Help] button in the CUPS Web management page.

To set up the PPD driver for Linux

Specify the functions by clicking the [Configure Printer] button in CUPS Printing System.

To register the PPD driver for OpenOffice

1 In CUPS Printing System, click the [Add Printer] button, and then specify PPD to add this machine.

2 Open the OpenOffice Printer Administrator tool.

3 Click the [New Printer] button.

4 In the Choose a device type dialog box, select "Add a printer", and then click the [Next] button.

5 In the Choose a driver dialog box, click the [Import] button.

6 Select "GENERIC 45C-1 OpenOffice PPD" (“GENERIC 45C-2 OpenOffice PPD" on d-Color MF450), 
and then click the [OK] button.

7 From the "Please Select a Suitable driver." list, select "GENERIC 45C-1 OpenOffice PPD" (“GENERIC 
45C-2 OpenOffice PPD" on d-Color MF450), and then click the [Next] button.

8 In the Choose a command line dialog box, select the printer that was added to CUPS, and then click 
the [Next] button.

9 Click the [Finish] button.
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To print with OpenOffice

1 From the [File] menu in OpenOffice, select "Print".

2 Select "GENERIC 45C-1 OpenOfficePPD" (“GENERIC 45C-2 OpenOffice PPD" on d-Color MF450) in 
"Printer name".

3 Click the [Properties] button.

4 Select the desired setting from the "Page size" drop-down list, and then click the [OK] button.

– To specify settings other than the page size, click the [Configure Printer] button in CUPS Printing 
System.

5 To print, click the [OK] button in the OpenOffice print dialog box.

About the PPD driver for applications

PPD registration destination (example: Adobe PageMaker)
- Adobe PageMaker 6.0

Copy the PPD file to RSR\CPPD4, which is under the folder to which PageMaker is installed.
- Adobe PageMaker 6.5/7.0

Copy the PPD file to RSRC\<Language>\PPD4, which is under the folder to which PageMaker is 
installed.

To print

1 From the [File] menu, select "Print".

2 From the "PPD" box in the print dialog box, select this machine.

3 Specify "Paper" or "Features" for the printer.

4 To print, click the [Print] button.
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13.5 Glossary

Term Definition

10Base-T/100Base-
TX/1000Base-T

An Ethernet standard, which is a cable consisting of twisted copper wire pairs. The 
transmission speed of 10Base-T is 10 Mbps, of 100Base-TX is 100 Mbps, and of 
1000Base-T is 1000 Mbps.

Adobe® Flash® Software developed by Adobe Systems, Inc. (formarly developed by Macromedia, 
Inc.), and used to create data combining vector-graphic animation and sound, and 
the format of this data file. The bidirectional content can be manipulated using a key-
board and a mouse. The files can be kept relatively compact, and they can be ac-
cessed with the Web browser plug-in.

AppleTalk A generic name for the protocol suite developed by Apple Computer for computer 
networking.

bit Abbreviation for Binary Digit. The smallest unit of information (data quantity) on a 
computer or printer. Displays data using 0 or 1.

BMP Abbreviation for Bitmap. A file format for saving image data which uses the .bmp ex-
tension. Commonly used on Windows platforms. You can specify the color depth 
from monochrome (2 values) to full color (16,777,216 colors). Images are not usually 
compressed when saved.

Bonjour Macintosh network technology for automatically detecting devices connected to the 
network and for specifying settings. Previously called "Rendezvous", the name was 
changed to "Bonjour" starting with Mac OS X v10.4.

BOOTP Abbreviation for Bootstrap Protocol. A protocol in which a client computer on a 
TCP/IP network automatically specifies the network settings from the server. Cur-
rently, DHCP, which is an advanced protocol based on BOOTP, is mainly used.

Brightness Brightness of a display screen

Byte Unit of information (data quantity) on a computer or printer. Configured as 1 byte 
equals 8 bits.

Client A computer that uses the services provided by a server through a network.

CMYK Abbreviation for Cyan, Magenta, Yellow, and Black. The colors in the toner and ink 
used for color printing can all be represented by changing the mixing ratio of the four 
colors of CMYK.

Color matching Technology for decreasing the difference in color among different devices such as 
scanners, displays, and printers.

Default gateway A device, such as a computer or router, used as a "gateway" to access computers 
not on the same LAN.

DHCP Abbreviation for Dynamic Host Configuration Protocol. A protocol in which a client 
computer on a TCP/IP network automatically specifies the network settings from the 
server. With collective management of the IP address for DHCP clients on the DHCP 
server, you can avoid duplication of an address and you can build a network easily.

DNS Abbreviation for Domain Name System. A system that acquires the supported IP ad-
dresses from host names in a network environment. DNS allows the user to access 
other computers over a network by specifying host names, instead of difficult to 
memorize and understand IP addresses.

DPI (dpi) Abbreviation for Dots Per Inch. A resolution unit used by printers and scanners. In-
dicates how many dots per inch are represented in an image. The higher the value, 
the higher the resolution.

Driver Software that works as a bridge between a computer and a peripheral device.

Ethernet LAN transmission line standard

Frame type Type of communication format used in a NetWare environment.
Communication is not possible if the same frame type is not used.

FTP Abbreviation for File Transfer Protocol. A protocol for transferring files over the Inter-
net or an intranet on the TCP/IP network.

Gateway Hardware and software used as the point where a network is connected to a net-
work. A gateway also changes data formats, addresses, and protocols according to 
the connected network.

Grayscale Monochrome image expressive form using the gradation information from black to 
white

Hard disk Large capacity storage device for storing data. The data can be stored even if the 
power is turned off.

Host name Displayed name of a device over a network.
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HTTP Abbreviation for HyperText Transfer Protocol. A protocol used to send and receive 
data between a Web server and a client (Web browser). Documents containing im-
ages, recordings, and video clips can be exchanged with the expressive form infor-
mation.

Install To install hardware, operating systems, applications, printer drivers on to a compu-
ter

IPP Abbreviation for Internet Printing Protocol. A protocol that sends and receives print 
data and controls printers over the Internet on a TCP/IP network. Data can also be 
sent to printers in remote areas to print over the Internet.

IPX A protocol used with NetWare and works at the network layer of the OSI reference 
model

IPX/SPX Abbreviation for Internetwork Packet Exchange/Sequenced Packet Exchange. A 
protocol developed by Novel, Inc. that is commonly used under a NetWare environ-
ment.

IP address A code (address) that is used to identify individual network devices over the Internet. 
A maximum of three digits for four numbers are displayed such as 192.168.1.10. IP 
addresses are assigned to devices, including computers, which are connected to 
the Internet.

LAN Abbreviation for Local Area Network. A network which connects computers on the 
same floor, in the same building, or in neighboring buildings.

Local printer A printer connected to a parallel or USB port of a computer.

LPD Abbreviation for Line Printer Daemon. A printer protocol that uses TCP/IP and is 
platform-independent. Originally developed for BSD UNIX, it has become the stand-
ard printing protocol and can be used with any general computer.

LPR/LPD Abbreviation for Line Printer Request/Line Printer Daemon. A printing method over 
a network in a Windows NT system or UNIX system. Using TCP/IP, you can output 
print data from Windows or Unix to a printer over a network.

MAC address Abbreviation for Media Access Control address. With a special ID number for each 
Ethernet card, data can be sent and received between the cards. A number consists 
of 48 bits. The first 24 bits consist of a special number for each manufacture control-
ling and assigning IEEE. The last 24 bits consist of a number that the manufacturer 
assigns uniquely to the card.

Memory Storage device for storing data temporally. When the power is turned off the data 
may or may not be erased.

NDPS Abbreviation for Novell Distributed Print Services. Provides a highly efficient printing 
solution in an NDS environment. By using the NDPS as a printer server, you can out-
put from the desired printer, automatically download the printer driver of a newly in-
stalled printer, simplify and automate complicated management environments 
related to printer use, and integrate management related to the network printer.

NDS Abbreviation for Novell Directory Services. The servers and printers on a network 
and the shared resources of the user’s information, as well as the user’s access au-
thority over these items can be consolidated in the hierarchy structure.

NetBIOS Abbreviation for Network Basic Input Output System. A communication interface de-
veloped by IBM.

NetBEUI Abbreviation for NetBIOS Extended User Interface. A network protocol developed 
by IBM. By simply specifying the computer name, you can build a small-scale net-
work.

NetWare Network operating system developed by Novell. NetWare IPX/SPX is used as the 
communication protocol.

Nprinter/Rprinter Remote printer support module for using a printer server under a NetWare environ-
ment. Use NetWare 3.x with Rprinter, and NetWare 4.x with Nprinter.

OHP/OHT OHP (overhead projector) transparencies which are used for presentations.

OS Abbreviation for Operating System. Basic software for controlling the system of a 
computer.

Outline font A font using lines and curves to display an outline of a character. Large-size charac-
ters can be displayed on a screen or printed with no jagged edges.

PDF Abbreviation for Portable Document Format. An electronically formatted document 
which uses the .pdf extension. Based on the PostScript format, you can use the free 
Adobe Acrobat Reader software to view documents.

PDL Abbreviation for Page Description Language. The language for specifying the print 
image per page to a printer when printing using a page printer.

Term Definition
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PostScript A typical page-descriptive language developed by Adobe and is commonly used for 
high quality printing.

PPD Abbreviation for PostScript Printer Description. A file used to describe the resolution, 
usable paper size, and the PostScript printer model special information.

Peer-to-peer A network format that allows connected devices to communicate without using a 
dedicated server.

Plug-and-play Ability to automatically find and use the appropriate driver when a peripheral device 
is connected to a computer.

Preview A function that allows you to view an image before processing a print or scan job.

Printer buffer Memory domain temporarily used for data processing of a print job

Print Job Print request transmitted from a computer to a printing device.

Print queue A software system which queues the generated print job in the devices.

Profile Color attribute file
The dedicated file that contains the summarized correlation of the input and output 
of each primary color used so that the color input and output devices can reproduce 
the color.

Property Attribute information
When using a printer driver, various functions can be specified in the file properties.
In the file properties, you can check the attribute information of the file.

Protocol The rules that allow computers to communicate with other computers or peripheral 
devices

Proxy server A server that is installed to act as an intermediary connection between each client 
and different servers to effectively ensure security over the entire system for Internet 
connections.

PServer Print server module under a NetWare environment that monitors, changes, pauses, 
restarts, or cancels a print job.

Queue name • Name specified to each device that allows printing when network printing.
• Required logical printer name for LPD/LPR printing

Resolution Displays the ability to reproduce the details of images and print matter correctly.

RIP Abbreviation for Raster Image Processor. Process that develops picture images 
from described text data using the PostScript page description language. The proc-
essor is usually integrated in the printer.

RGB Abbreviation for Red, Green, and Blue. Represents all colors by changing the bright-
ness ratio of the RGB 3 colors using the primary colors used by the color represen-
tation in a monitor.

Samba UNIX server software that uses SMB (Server Message Block) so that UNIX system 
resources can be used from a Windows environment.

Screen font A font for displaying text and symbols on a CRT monitor.

Shared printer A printer setup that allows the printer to be used by multiple computers connected 
to a server over a network.

SLP Abbreviation for Service Location Protocol. A protocol capable of finding services 
over a TCP/IP network and automatically specifying a client.

SMB Abbreviation for Server Message Block. A protocol that shares files and printers over 
a network and which is mainly used by Microsoft Windows.

SMTP Abbreviation for Simple Mail Transfer Protocol. A protocol for sending and forward-
ing e-mail.

SNMP Abbreviation for Simple Network Management Protocol. A management protocol in 
a network environment using TCP/IP.

Spool Abbreviation for Simultaneous Peripheral Operation On-Line. For printer output, 
data is not sent directly to the printer, it is temporarily stored in another location, then 
sent to the printer collectively.

Subnet mask The unit used to divide a TCP/IP network into small networks (subnetworks). It is 
used to identify the bits in a network address that are higher than the IP address.

TCP/IP Abbreviation for Transmission Control Protocol/Internet Protocol. The de facto 
standard protocol used by the Internet that uses IP addresses to identify each net-
work device.

TrueType An outline font that was developed by Apple Computer and Microsoft. It is used as 
a standard by Macintosh and Microsoft Windows and can be used both on a display 
and in print.

Term Definition
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Touch & Print Function that allows you to print the job that was sent from the printer driver when 
performing user authentication by only positioning the finger on the authentication 
unit (biometric type) that is connected to this machine.
To use the Touch & Print function, an authentication unit (biometric type) must be 
installed on this machine, and the finger vein pattern for each user must be regis-
tered.

USB Abbreviation for Universal Serial Bus. A general interface standard for connecting a 
mouse, printer, and other devices to a computer.

Uninstall To delete software installed on a computer

Web browser Software such as Internet Explorer and Netscape Navigator for viewing Web pages.

WINS Abbreviation for Windows Internet Naming Service. A service for recalling named 
servers for the conversion of computer names and IP address in a Windows environ-
ment.

Term Definition
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A
Account track 5-10, 6-13, 7-14, 9-13, 10-16, 11-48
Add printer wizard 3-4
Administrator mode 11-28
AppleTalk 3-9, 4-29

B
Back cover 5-15, 6-19, 7-20, 8-9, 9-22
Banner paper tray 11-18
Banner sheet setting 11-10
Basic tab 6-7, 7-8, 10-14
Bindery 4-16
Bindery emulation 4-16, 4-19
Binding direction 6-15, 7-16, 8-9, 9-16, 11-11, 11-15
Binding margin 6-15, 7-16
Binding position 8-9
Bonjour 3-9, 4-30
Booklet 5-12, 6-15, 7-16, 9-16
Border 6-14, 7-15

C
Changing paper sizes 11-9
Chapter 5-12, 6-15, 7-16, 9-18
Collate 5-10, 8-8, 9-10
Color selection 6-29, 7-30, 8-9, 9-30
Color settings 6-29, 7-30, 8-9, 9-30
Combination 5-11, 6-14, 7-15, 8-9, 10-17
Computer faxing 2-6
Configuration page 11-26, 13-5
Configure tab 6-32, 7-33, 10-21
Connecting 2-7
Copies 8-8, 9-9, 11-6
Copies & Pages 9-9
Copy protection 5-16, 6-26, 7-27, 9-26
Cover mode 5-15, 9-22
Cover Mode tab 6-19, 7-20
CR/LF mapping 11-24
Custom page sizes 6-8, 6-35, 7-9, 8-7, 9-8, 10-14

D
Date 6-28, 7-29, 9-28
Deleting secure print documents 11-31
Demo page 11-26, 13-8
Driver settings 6-36, 7-37, 9-32, 10-26
Duplex 5-12, 6-15, 7-16, 8-9, 9-16
Duplex printing 11-14

E
Editing a watermark 6-21, 7-22, 10-19
Error message 12-5
Ethernet 2-8
Exporting 6-38, 7-40, 10-28

F
Fax cover sheet 10-7
Fax driver 3-3, 10-3
Fax tab 10-13
Finish 9-16
Finish tab 6-17, 7-18
Finishing 8-9
Folding 5-14, 6-18, 7-19, 8-9, 9-16
Font list 13-6
Font settings 6-30, 7-31, 11-19
Font size 11-22
Front cover 5-15, 6-19, 7-20, 8-9, 9-22

G
General settings 8-8, 9-9
Glossy mode 6-29, 7-30, 8-9, 9-30

H
Hole punching 5-13, 6-18, 7-19, 8-9, 9-16, 11-17

I
I/F timeout 11-34
Image compression 6-29
Importing 6-38, 7-40, 10-28
Installing 3-3, 3-8
Interfaces 2-8
IP address 4-5
IPP printing 4-12

L
Layout 8-9, 9-16
Layout tab 6-14, 7-15, 10-17
Line/Page 11-23
LPR printing 4-10

M
Mac OS 9.2 3-8, 3-9, 8-3
Mac OS X 3-8, 9-3
Macintosh 2-7, 3-8, 4-29
Manual conventions 1-11

N
N in 1 5-11, 6-14, 7-15, 10-17
NDPS 4-27
NDS 4-16, 4-22, 4-24
NetWare 4-3, 4-16
Network 4-3
Network connection 3-4, 4-4
Novell Distributed Print Service 4-27
Nprinter 4-16
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O
Offset 5-10, 8-9, 9-10
Operating environment 2-7
Operating system 2-7, 3-3
Options 6-32, 7-33, 8-11, 9-31, 10-21
Orientation 8-6, 9-7
Original direction 11-7
Original orientation 5-8
Original size 5-8, 6-7, 7-8
Output method 5-10, 6-10, 7-11, 8-9, 9-10
Output tray 6-18, 7-19, 8-9, 9-20, 11-30
Overlap width line 6-14, 9-16
Overlay 5-16, 6-22, 7-23
Overlay file 6-25, 7-25

P
Page attributes 8-6, 9-7
Page numbers 5-17, 6-28, 7-29, 9-28
Page setup 8-3, 8-6, 9-3, 9-7
Pages 8-8, 9-9
Paper 8-6
Paper arrangement 5-15, 6-18, 7-19, 9-16
Paper size 5-8, 6-7, 6-8, 7-8, 9-7, 11-13
Paper source 5-9, 8-8
Paper tray 5-9, 6-8, 6-33, 7-9, 7-35, 9-20, 11-12
Paper type 5-9, 9-20
Pattern 6-29
PCL driver 3-3, 6-3
PCL font list 11-26
PDL setting 11-4
Per page setting 5-15, 6-19, 7-20, 9-23
Phone book 10-5, 10-22
Plug and play 3-6
Port 9100 printing 4-11
Poster mode 5-11, 6-14, 10-17
PostScript 3-3
PostScript driver 3-3, 7-3
PostScript options 8-7
PPD driver 3-3, 8-3, 9-3
Print data capture 11-35
Print jobs 11-36
Print server mode 4-19, 4-22
Print settings 11-3
Print type 5-12, 6-15, 7-16, 8-9, 9-16
Print/fax output setting 11-29
Printer controller 2-3
Printer driver 3-3
Printer fonts 5-17
Printer specific options 8-9
Printing 2-5, 8-4, 8-8, 9-4, 9-9
Printing methods 5-3
Printing operations 5-3
Printing reports 11-26
Printing without specifying the authentication setting 
11-33
Proof print 6-10, 7-11, 9-10, 11-38

PS errors 11-25
PS font list 11-26
PServer 4-16

Q
Quality 9-30
Quality adjustment 5-17, 6-29, 7-30, 9-30
Quality tab 6-29, 7-30

R
Recalling jobs 11-38, 11-39, 11-44
Remote printer mode 4-16, 4-22
Rendezvous 3-9
Resolution 6-29, 7-30, 8-9

S
Saddle stitch 5-14, 6-17, 7-18, 9-16
Save in user box 6-10, 7-11, 9-10, 11-44
Scale 5-9, 8-6, 9-7
Secure print 6-10, 7-11, 9-10, 11-39
Secure print document delete time setting 11-32
Secure print user box 11-39
Sending a fax 10-3
Setting up the system 2-9
Settings tab 6-34, 7-36
Shifting images 5-13, 6-16, 7-17, 9-17
Skipping blank pages 5-11
SMB printing 4-8
Software tools 6-33, 7-35
Specifications 13-3
Spool setting 11-8
Stamp/Composition 9-25
Stamp/Composition tab 6-21, 7-22, 10-19
Stapling 5-13, 6-17, 7-18, 8-9, 9-16, 11-16
Starting up a software tool 6-33, 7-35
Substitute fonts 5-17
Supported operating systems 3-3
Symbol set 11-21

T
Test printing 5-4
Time 5-17, 6-28, 7-29, 9-28
Transmission settings 10-6
Transparency interleave 5-15, 6-20, 7-21, 8-9, 9-22
Troubleshooting 12-3

U
Unable to print 12-3
Unable to specify desired settings 12-4
Uninstalling 3-10
USB 2-8
USB connection 3-4
User authentication 5-10, 6-12, 7-13, 9-12, 10-15, 
11-46
User manuals 1-9
User settings 11-3
Utility mode 11-3
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V
Various settings 11-3

W
Watermark 5-16, 6-21, 7-22, 10-19
Web Connection 4-7, 11-49
Windows 2-7, 3-4

Z
Zoom 5-9, 6-7, 7-8
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